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Getting Started
Welcome to TotalCAD 1.0 for Windows, the world´s best value in desktop CAD software. CAD, or 
Computer Aided Design, is a powerful tool for creating geometrically precise drawings. TotalCAD 1.0 is 
designed for value, speed, and ease of use. It is the perfect tool to help you learn and use CAD.
The follow topics deal with how to get the information you need to learn and use TotalCAD:
Using the Help System
Tooltips
Running the Tutorial 
Tips of the Day 
Contacting Technical Support 



Using the Help System
This online help system provides a complete reference to TotalCAD´s features. To learn more about the 
features of the Windows help system, choose from the list of topics:
Context-Sensitive Help 
Using Windows Help



Context-Sensitive Help
If you need particular information about a tool, command, or dialog, you can go directly to the relevant 
help topic from the TotalCAD interface. Or, you can click on the Help tool, then click on the tool, menu 
item, or interface element about which you want information.

You can also place the mouse cursor over a tool, or highlight a menu item, then press the <F1> key.



Tooltips
Tooltips are a convenient way to identify a tool button. Just position the mouse cursor over a tool for a 
second, and small yellow box containing the name of the tool will appear.



Running the Tutorial
TotalCAD´s electronic tutorial provides step-by-step, hands-on instructions that teach you how to create 
drawings in TotalCAD. The tutorial stays on top of your TotalCAD window so that you can draw in 
TotalCAD while following the instructions. To start the Tutorial, choose Tutorial from the Help menu. The 
Tutorial Topics page will appear.
You can go to any tutorial topic by clicking on the topic. 
Once you are in a topic, click on the buttons at the top of the tutorial screen to navigate. At the bottom of 
many of the tutorial topics, you will find a "Show Me" button. Click on this button to see what your drawing
should look like at any time during the tutorial.



Tips of the Day
TotalCAD´s Tips of the Day are a collection of advice, techniques, and tricks that could make your work 
with TotalCAD easier, point out features that are not so obvious, or show you how to do things that you 
perhaps didn´t know you could do. Some of the tips are directed toward novice users, and others are 
directed to more experienced users.
The first time you start TotalCAD, you will see a Tip of the Day. You can stop the tips from appearing at 
startup by clearing the Show Tips at Startup check box. If you subsequently want to turn the tips back on, 
choose Tip of the Day from the Help menu and click the Show Tips at Startup check box.



Contacting Technical Support
If you can´t find the answer to a question in the manual or in this Help system, the IMSI Technical Support
staff is there to help you. You must be a registered TotalCAD user to get technical support. Technical 
support by e-mail and the World Wide Web is provided free of charge.
Before you call, have your computer turned on. If you have a question about how something in TotalCAD 
works, then you only need to have the first three of the following items available. If you are having a 
system-related problem, then please try to have all the following information available:

Your name, address, and phone number.
Product name and version number (choose Help|About).
Computer make and model.
A precise description of how to reproduce the problem, including any error messages.
The version of Windows that you are running.
Amount of RAM installed and type of memory manager.
Type and capacity of your hard disk.
Graphics adapter and monitor type.
Printer/plotter make and model.
List of any special peripherals installed.

To contact technical support by phone, dial (415) 257-3000, extension 3. You can also send your request 
by e-mail to support@imsisoft.com. You may also be able to find the answer you need by checking out 
the TotalCAD support pages on the World Wide Web, at http://www.imsisoft.com/techsupp/.



Quick Tour
This following will take you on a quick tour through TotalCAD´s basic features. It will cover the following 
topics:
Choosing a Template 
TotalCAD Desktop 
Setting up your Desktop 
Getting around the Interface 



Choosing a Template
When you start a new drawing, the Create from Template dialog appears. This is where you choose a 
standard template to use as the basis of your drawing. TotalCAD comes with a number of templates 
(stored in the Templates folder), with standard settings for different types of drawing disciplines and 
preferences.
Once you choose a template a Wizard may run (depending on which template you choose), which will 
help you complete the setup of your drawing. One very useful template is WzNormal.tct. This template 
begins with a Setup Wizard, which will prompt you to set up your drawing. It will ensure that hatches and 
double lines are correctly proportioned.
You can also create your own templates by simply saving a drawing as a template using the Save As 
dialog. A template contains all of the information stored in a drawing, including units and scale, grid setup 
and symbol libraries.

Note

See Also 



You can keep this dialog from appearing by removing the check mark from the Prompt for Template Name
option in the General Property Sheet of the Program Setup dialog.



Create from Template Dialog



Wizards
Some of TotalCAD's templates and scripts begin with wizards. Wizards are like dialogs that contain 
several pages of options that you complete sequentially. Choose settings on each page, then click the 
Next button. When you are finished with the last page, click the Finish button. For more information, see 
Setup Wizard.



Setup Wizard
The Setup Wizard appears when you start TotalCAD using the WzNormal template. 

The Setup Wizard contains three pages which will help you:

Choose your drawing units and number format
Set up your page and enter user and drawing information that will be saved with your drawing file.
Choose your drawing Scale.



Drawing Units and Number Format
The first page of the WzNormal template's Setup Wizard contains the following options for formatting your
drawing units and number format. As you choose different options, an example of the unit and number 
format settings will appear in the Samples box.
English and Metric. Choose one of these settings, depending on whether you want to work in the English 
(inches and feet), or Metric measuring system.
Format Category. Click in this pulldown list to choose a general category for the number format of your 
rulers and dimensions. You can choose Architectural, Decimal, Engineering, Fractional, or Scientific 
number format. The following table shows examples of the available number formats:

Format Example
Decimal 3.25
Scientific 1E+01 mm
Fractional 3 3/16
Architectural (Feet in Fractional) 1´-5 11/16"
Engineering (Feet in Decimal) 1"= 200´

World Units. Click in this pulldown list to choose a basic unit of measurement. The choices in this box will 
vary, depending on other options you have chosen.
Decimal Precision. Use this control to set the precision of decimal numbers (i.e. how many digits appear 
to the right of the decimal point.
Note that you can reset these options for your drawing using the Units and Scale property sheet.



Paper Setup and Drawing Info
The second page of the WzNormal template's Setup Wizard contains the following options for setting up 
your page and entering drawing information.
Paper Size Options. Use this control to either let TotalCAD choose a default paper size, or choose a 
custom paper size from the pulldown list.
Paper Orientation. Use this control to choose either a portrait (tall) or landscape (wide) paper orientation.
User/Drawing Information. Use these control to enter specific information about your drawing and the 
author of the drawing. 
Note that you can reset the options contained in this page of the wizard using the Page Setup and 
Summary Info dialogs.



Drawing Scale
The third page of the WzNormal Setup Wizard contains the following options for setting your drawing 
scale, that is, the ratio of the size of your drawing to the size of the real-world objects that your object is 
modelling. Check the Samples box to see how your choices will affect scale display.
Scale Type. The scale type will determined how your scale is displayed. If you are using metric units, only
the Absolute scale type will be available. If you are using English units, you can choose an Absolute, 
Architectural, or Engineering Scale type. Check the Samples box to see examples of each type as you 
change settings.
Scale. Use this box to choose an actual scale (the ratio shown in the type and format you have chosen).
Let TotalCAD choose a scale. Choose this option if you want TotalCAD to choose a scale based on the 
dimensions of the object you want to draw. Type the height and width of the object you are drawing into 
the Height and Width boxes.

Note that you can reset the options contained in this page of the wizard using the Units and Scale 
property sheet.



TotalCAD Desktop
Once you have started TotalCAD and chosen a template, you will see the TotalCAD desktop with a new, 
blank drawing. The following topics provide brief descriptions of the TotalCAD interface components on 
your screen.

Menu Bar
Toolbars 
Flyout Toolbar 
Rulers
World/Paper Button
Scroll Bars
Drawing Area
Paper
Edit Bar 
Local Menu
Coordinate Fields 
Status Bar



Menu Bar
The menu bar is where you access TotalCAD´s menu system. To choose a command from the menu, 
click on one of the menu items on the menu bar, then click again to choose a command from the menu 
that appears below. If you choose a submenu from the menu, a secondary menu appears, from which you
can choose a command.



Toolbars
Toolbars provide a convenient alternative to the menu system. The TotalCAD default screen displays four 
toolbars: the Standard and Insert toolbars at the top of the screen, and the Snaps and View toolbars on 
the left and right sides of your screen, respectively. Clicking on any of the buttons on the toolbars will give 
a TotalCAD command. You can access many more toolbars by choosing Toolbars from the View menu, 
displaying the Desktop Property Sheet.
The position of toolbars is configurable: just drag the toolbar by its edge the top of the screen to position it
horizontally, to the side of the screen to position it vertically, or position it as a floating palette over the 
drawing area.

See Also 



Desktop Property Sheet 



Flyout Toolbars
Flyout toolbars gives you convenient and intuitive access to all the drawing tools in a way that takes up 
minimal screen space. Tools that have flyouts have a small yellow triangle in their lower-right corner. To 
access a flyout tool from the Insert toolbar:

1. Make sure the Insert toolbar is visible on your screen. If it isn´t, use the View|Toolbars dialog box to 
display it.

2. Choose the type of tool you need. To do this, place the mouse cursor over a tool button and hold the 
left mouse button down. A flyout toolbar will appear under the mouse cursor.

3. Click to choose the specific tool that you want from the flyout.



Rulers
The Rulers gives you feedback about the size and position of objects in your drawing. The ruler can 
display either World Units or Paper Units. For example, you may be drawing a picture of a table that is 
five feet long, while the drawing that represents the table is five inches long. Feet, in other words, are the 
drawing´s World Units; inches are the drawings Paper Units.

See Also



Units and Scale Property Sheet



World/Paper Button
This button, in the upper-left corner of the ruler, lets you change the ruler between Paper Units and World 
Units. Click on the button, then observe how the ruler is changed.



Scroll bars
By clicking in the scroll bars, you can "scroll" to a different view of your drawing. Click on the arrow to 
scroll a small amount. Hold the mouse cursor over the "thumb" of the scroll bar (the rectangle in the 
middle of the bar) and drag it to move through your drawing. Click in the area between the thumb and the 
arrow to scroll a larger amount.



Drawing Area
The drawing area is the area in the middle of your screen in which your drawing objects appear. You can 
increase the size of your drawing area by turning off interface elements that you don´t use. You do this 
through the Desktop Property Sheet.



Paper
The Paper, the large white rectangle in the middle of the screen, shows you how your drawing will be 
layed out on the page when printed. You don´t have to draw on the Paper; you can draw anywhere in the 
drawing space. You can change the layout of the paper using the Page Setup dialog. You can display and
hide the paper using the Desktop Property Sheet.



Edit Bar
The Edit Bar allows you to draw by specifying exact quantities, such as lengths and angles. You might, for
example, use the Edit Bar to draw a line that is exactly two inches long, at a 45 degree angle; or a circle 
with a radius of exactly 1.75 feet.

The position of the Edit Bar is configurable. You can place it horizontally along the top of the screen, or 
position it over the drawing area as a floating palette. You can´t position it vertically. To reposition the Edit 
Bar, place the mouse cursor at any point just inside the edge of the Edit Bar and drag the it to a new 
location.
The Edit Bar contains one or more fields (depending on the active tool). To enter a value in a field, simply 
click in the field to activate it, then type the value into the field. You can also move between fields of the 
Edit Bar by pressing <Tab> or <Shift>+<Tab>. To accept the values in the Edit Bar, press <Enter>.
Many Edit Bar fields have lockdown boxes to their immediate left. Checking a lockdown box makes the 
value in the field insensitive to mouse movements in the drawing area. This means that you can fix 
settings in one or more fields, then activate the drawing area and move the mouse without changing the 
values in the locked fields.

See Also 



Finishing and Canceling, Defining Points and Specifying Measurements, Drawing with the Edit Bar 



Local Menu
To see the local menu, right-click in the drawing area. The local menu, like the Edit Bar, is context-
sensitive. The menu items available in the menu change, depending on the active drawing or editing tool, 
and sometimes even change depending on the position of the mouse cursor relative to an entity. You can 
use the local menu, among other things, to cancel the current operation, finish the current operation, set 
temporary snap modes, and undo the previous operation.

Tip 

See Also 



Because the Local Menu is context-sensitive, it´s not always obvious what functions it may contain in a 
given situation. While learning TotalCAD it´s a good idea to check the contents of the Local Menu when 
you are using different tools and editing techniques. You may be surprised by what you find!



Editing with the Mouse and Local Menu, Finishing and Canceling, Local Snap, Snap Modes 



Coordinate Fields
Unlike the Edit Bar and toolbars, the Coordinate Fields are fixed on the Status Bar and located on the 
lower-right corner of the screen. The Coordinate Fields provide a way of defining points by specifying their
exact coordinates. 
To define a point using the Coordinate Fields, type the coordinates into the fields and press <Enter>. 

Note 

See Also 



The types of coordinates that you enter will depend on the currently active coordinate system (absolute, 
relative, or polar).



Coordinate Systems, Defining Points with the Mouse 



Status Bar
The Status Bar is displayed across the bottom of your screen. On its left it displays a brief message that 
lets you know what action TotalCAD expects next. On the right side of the Edit Bar are the Coordinate 
Fields , as well as an indicator that tells you the zoom percentage, which is how far in or out of the 
drawing your view is zoomed. 100% zoom shows your drawing at its printed size.
You can display or hide the Status Bar using the View|Statusbar command.



Setting up your Desktop
The following topics discuss how to hide and display TotalCAD´s screen components, how to position 
toolbars and the Edit Bar, and how to save your desktop settings for the next time you run TotalCAD.

Choosing What You See On The Screen 
Positioning Toolbars 
Saving your Setup 



Choosing What You See On The Screen
You can customize your screen in TotalCAD using the commands of the View menu, as well as the 
Desktop property sheet. You can also move the toolbars and the Edit Bar to positions that you prefer, and 
save your screen setup for the next time you start TotalCAD.



Positioning Toolbars
You can move a toolbar or the Edit Bar by positioning the mouse cursor over the edge of the control and 
dragging it to a new position. Most toolbars can be positioned horizontally at the top of the screen, 
vertically along the side of the screen, or positioned over the drawing as floating palettes. The Edit Bar 
and toolbars that contain text fields cannot be placed vertically.



Saving your Setup
If you want to return to a customized setup the next time you run TotalCAD, you need to make sure that 
TotalCAD saves the Desktop settings when it exits. To do this:

1. Select Tools|Program Setup. The Program Setup dialog appears.
2. Check the Save Desktop on Exit box. 

Now when you exit TotalCAD, the desktop configuration of toolbars and other controls will be saved. If 
you don´t want to save your desktop settings, make sure that the Save Desktop on Exit box is not 
checked before you exit.



Getting around the Interface
When you are drawing and editing, you will need to move back and forth between TotalCAD´s various 
controls, sometimes in the middle of an operation. You may start an entity by defining a point with the 
mouse, then continue by defining a point in the Coordinate Fields, then set values in the Edit Bar, then 
return to the drawing area to complete the operation. You may even want to set up a construction line, 
zoom into an area of the screen, change the coordinate system, then return to the drawing area to 
continue an operation already in progress. In TotalCAD it´s possible to do all of this and more.
Changing Focus with the Mouse 
Changing Focus with the Keyboard 



Changing Focus with the Mouse
Keep in mind that only one control on the screen can have the focus at a given time. When you move 
from control to control, you change the focus from one control to another. Generally speaking, users 
change the focus from one control to another by clicking the control they want to change to. If you are in 
the drawing area, you can move to the Edit Bar by simply clicking in one of its fields, or move to the 
Coordinate Fields by clicking in one of its fields. Then you return to the drawing area by clicking there.



Changing Focus with the Keyboard
You can also move the focus between controls using the keyboard. Remember these keystrokes:

If you are in the drawing area or the coordinate fields, you can move the focus to the Edit Bar by 
pressing <Ctrl>+<E>.

If you are in the Edit Bar or the coordinate fields, you can move to the drawing area by pressing 
<Ctrl>+<D>.

If you are in the Edit Bar or the drawing area, you can return the focus to the coordinate fields by 
pressing <Ctrl>+<R>.
There are also a couple of alternative ways to get out of the drawing area.    You can also just start typing 
values that you want to go into the Edit Bar: This will change the focus to the Edit Bar, and values you 
type will be entered in the Edit Bar´s first field. This last approach can be very convenient, but it won´t 
work if you are using the Text tool.

Note 
See Also 



If you type values that are not appropriate for a particular Edit Bar field, the field may not accept the 
values, in which case it will warn you by beeping.



Defining Points and Specifying Measurements, Finishing and Canceling 



Microsoft Office Compatibility
TotalCAD is a Microsoft Office Compatible product, which means that its toolbars, menus, and accelerator
keys are similar to those used by Microsoft Office. If you are already using Microsoft Office, which 
includes Microsoft Excel, Word, Microsoft Access and PowerPoint, then many of the tasks you have 
learned to complete in Office can be completed in a similar manner in TotalCAD. IMSI and Microsoft hope
these similarities will make it easier for you to use our products together and with other Microsoft Office 
Compatible products.
Look for the Microsoft Office Compatible logo when purchasing software. For more information about the 
Microsoft Office Compatible program, and for a complete listing of Microsoft Office Compatible products, 
in the United States call Microsoft Customer Service at 1-800-426-9400. Customers outside the United 
states should contact their local Microsoft office.
Microsoft Office Features
Using TotalCAD with Microsoft Office 



Microsoft Office Features
TotalCAD´s toolbars, menu system, and accelerator keys have been revised for consistency with 
Microsoft Office. TotalCAD´s template Wizards and Tips of the Day will also be familiar to Microsoft Office 
Users.



Using TotalCAD with Microsoft Office
TotalCAD fully supports OLE 2.0, so you can include Microsoft Word, Excel, and Powerpoint objects in 
TotalCAD via the Insert Object and Paste Special commands. Simply double-click on OLE objects to edit 
them in their source application, or use the Edit|Object command. Links can be updated and modified 
using the Edit|Links command.
TotalCAD objects can similarly be included in other OLE 2 compliant applications.
For more information on integrating Microsoft Office products, see your Microsoft Office documentation.



File Management and Printing
TotalCAD 1.0 provides all standard Windows features for creating, opening, and saving files. Its open and 
save features support all standard CAD file types.
TotalCAD´s printing features make it easy to print your drawings on single pages or to "tile" them across 
multiple pages that can be joined into a single large printout.
Supported File Types
Printing



Supported File Types
TotalCAD supports a variety of file types, including the standard.DXF format. This means that you can 
open files created in other CAD programs using a standard file format, such as .DXF, then edit and save 
the files in TotalCAD format; or you can save TotalCAD files as .DXF, then edit and save them in another 
application. 
The following table describes the file types supported by TotalCAD 1.0:
File Type Extension Comment
TotalCAD 1.0 .TCW Default file type for 

TotalCAD 1.0.
TotalCAD 
Template

.TCT Use predefined or custom 
templates as basis for new 
drawings.

AutoCAD DXF .DXF Common CAD file 
exchange type.

Warning 
See Also



If you open a file created in another version of CAD, then save the file in TotalCAD 1.0, the file type will be
updated to TotalCAD 1.0. You can also save a TotalCAD 1.0 in the DXF format so you can open and edit 
the file in another CAD program.



Open Dialog, Save As Dialog 



Printing
TotalCAD 1.0 has a wide range of printing features, which make it easy to scale and center your drawing 
on the page, or to tile your drawing across multiple pages. TotalCAD also provides a full range of 
advanced printing options for experienced users.
Printer Paper and the Drawing Sheet 
Simple Printing 
Tiled Printing 



Printer Paper and the Drawing Sheet
Before dealing with TotalCAD´s printing capabilities, it will help if you understand a potentially confusing 
concept: printer paper versus the drawing sheet. Printer paper means the physical sheets of paper that go
through the printer. The drawing sheet is the total surface area on which your drawing will be printed. The 
drawing sheet can correspond to a single sheet of printer paper, or it can span multiple sheets of printer 
paper.
Both the printer paper and the drawing sheet have settable sizes, as well as landscape and portrait 
orientations. This provides a great deal of flexibility when you want to print a large drawing on multiple 
sheets. You could, for example, print a poster in landscape orientation three feet wide and two feet tall. 
You could print this virtual sheet out on 32 sheets of 8.5" x 11" paper oriented in portrait, or on 30 sheets 
of the same size paper oriented in landscape.



Simple Printing
TotalCAD´s many printing options may seem confusing at first glance, but in most cases you can print 
your drawing in just a few simple steps. Let´s assume that you have created a drawing in World scale, 
without paying any attention to how your drawing will be set up on the page. Assume as well that you 
want to print on a single sheet of paper. Follow these steps:

1. Choose File|Print. The Print dialog will appear.
2. In the Print Range control group, click the All option to print your entire drawing.
3. Check the Fit on 1 Page option.
4. Click the Print Setup button to bring up the Print Setup dialog. Choose your printer, paper size, and 

paper orientation, then click OK to return to the Print dialog.
5. Click the OK button to print your drawing.

Your drawing will be centered and printed on a single sheet of paper.



Tiled Printing
TotalCAD gives you two different approaches to printing a drawing on multiple tiled sheets of paper, using 
the Paper and Layout property pages of the Page Setup dialog. The two following topics describe these 
two options.
Tiled Printing by Setting Sheet Size 
Tiled Printing by Setting Rows and Columns 

Tip 
See Also 



When printing on multiple tiled sheets, it is usually best have the Print Crop Marks option on, unless you 
set your margins to zero. Crop marks will enable you to easily trim the edges of the paper so that the 
sheets can be pasted onto a backing for display.



Page Setup Dialog 



Tiled Printing by Setting Sheet Size
If you want to create a printout of a specific size tiled on multiple sheets, you can specify the size of the 
printout in the Paper property sheet. TotalCAD will determine the number and arrangement of the sheets 
of printer paper.

1. Choose File|Page Setup. The Paper property sheet will be visible in front.
2. In the Printer Paper control group, specify the size of the sheets of paper that you want to print on, 

and whether you want the sheets of printer paper to be oriented in landscape or portrait.
3. In the Sheet Size control group, specify the size of the area on which you want to print the drawing, 

and its orientation. You can do this in any units listed in the Tools|Drawing Setup|Units and Size 
property sheet. For example, if you want a printout 2 feet tall and 3 feet wide, you would type 2 ft x 3 ft
in the list box, and choose the Landscape option.

4. Click the Fit button to place your drawing on the tiled sheets.
5. Click the Print button to print your drawing immediately, or click OK and then choose File|Print if you 

want to go through the Print dialog.

Note 



You can also set the sheet size in either World or Page units by specifying values in the Height and Width 
fields on the Layout property sheet.



Tiled Printing by Setting Rows and Columns
In the Layout property sheet of the Page Setup dialog, you can specify the number of rows (the number of
sheets of printer paper from top to bottom) and columns (the number of sheets of printer paper from left to
right). You can then return to the Paper property sheet to fit your drawing onto the tiled printer paper. 
TotalCAD will automatically adjust the dimensions of the drawing sheet to accomodate changes in the 
number of rows and columns.



Editing Objects
The Edit menu contains commands and tools for selecting, editing, and copying objects. These features 
enable you to

Undo a previous operation, or redo what was previously undone.
Perform standard Windows clipboard operations: Cut, Copy, and Paste.
Clear (delete) objects using several options.
Select objects with the Select tool, or categorically by type, layer, or several other criteria.
Create multiple copies of entities along lines, around arcs, and in two-dimensional arrays.
Edit OLE objects using the source application and make changes to how OLE objects are linked 

to your TotalCAD drawing.
In addition to the features available from the Edit menu and toolbars, TotalCAD has two separate modes 
for mouse-based editing:

Select Edit, in which you scale, rotate, or move objects.
Node Edit, in which you reshape entities by editing special points called nodes.



Editing with the Mouse and Local Menu
TotalCAD offers powerful capabilities for editing directly with the mouse and Local menu (which you 
access by right-clicking in the drawing area). There are two distinct editing modes that you can use for 
this purpose: Select Edit, and Node Edit.



Select Edit
Select Edit is the editing mode an object is in when you first select it. In this mode, the selected objects 
are bounded by a selection rectangle that has handles on each corner and at the midpoint of each side. 
At the center of the selection rectangle is the reference point, which is connected to the rotation handle, 
located just outside of the selection rectangle.
Moving the Selection´s Reference Point 
Moving a Selection 
Scaling a Selection 
Copying While Moving or Scaling 
Rubber Stamp 
Rotating a Selection 



Moving the Selection´s Reference Point
You can move the reference point of a selection to any position in the drawing area. To do this, hold down 
the <Ctrl> key while clicking on the reference point. The cursor will change to a hand grasping the point. 
You can now move the reference point to any position by defining a point. You can do this with the mouse 
using any snap mode, or you can type the coordinates of the point into the Coordinate Fields and press 
<Enter>. 

Tips 



When you rotate an object, you do so in relation to its reference point. This means that you can rotate the 
object not only around its own center, but around any arbitrary point or object in the drawing space. For 
example, you can use Snap to Arc Center mode to move the reference point of the selection to the 
geometric center of a circle or arc, then "orbit" the selection around that point.

To restore the reference point to its original location at the center of the selection, you can deselect and 
then reselect the objects.



Moving a Selection
There are three ways to move a selection in Select Edit mode: "picking it up" by its reference point, 
dragging it by its reference point (OLE drag and drop), and "simple dragging" (that is, dragging by any 
point within the selection rectangle other than the reference point).

Picking the Reference Point 
OLE Drag and Drop 
Simple Dragging 



Picking the Reference Point
In most cases the most convenient and accurate way to move an object is to click on its reference point, 
then define a new location for the reference point. The object moves with the reference point:

1. Select the object or objects that you want to move.
2. If desired, move the selection´s reference point relative to the selection. For example, if in moving a 

rectangle you wish to precisely place its lower-left corner, rather than its center, first move the 
reference point to the lower-left corner of the rectangle. You can use snap modes for precise 
placement of the reference point.

3. Click on the selection´s reference point. The cursor changes to four-directional pointer (crossed 
arrows).

4. Define the point where you want to place the selection. You can do this by clicking the mouse, using 
any snap mode. Alternatively you can press <Tab> to leave the drawing area, then type the 
coordinates of the desired location in the Coordinate Fields and press <Enter>.

Tip 
See Also 



When you move a selection by picking its reference point, you can use Ortho mode when you place the 
selection. You can turn on Ortho mode in the menu, toolbar, or local menu before or during the placement 
of the selection; you can also toggle Ortho mode during placement by holding down the <Shift> key.

To copy while moving, hold down the <Ctrl> key immediately after you have clicked on the reference 
point.



Moving the Selection´s Reference Point 



OLE Drag and Drop
You are using OLE drag and drop whenever you drag an object by its reference point

1. If you´re going to use a snap mode, set it before starting the move. You may also want to move the 
reference point relative to the selection before beginning the move. 

2. Place the mouse cursor directly over the reference point. You will know it is there when the mouse 
cursor turns into a four-directional pointer.

3. Hold the mouse button down while "dragging" the object to the new location, then release the mouse.
The main advantage of OLE drag and drop is that it lets you copy the selection from one drawing into 
another, or even from a TotalCAD drawing into another application. 

Warning 
See Also 



The behavior of snap modes is slightly unusual when you are moving an object using OLE drag and drop.
If TotalCAD finds a snap point based on the location of the mouse at the point of release, then the 
reference point will snap to the snap point. If TotalCAD cannot    find a snap point, then the object will 
simply be dropped at the point of release.



Snap Modes 



Simple Dragging
If you place the mouse pointer anywhere inside a selection other than on the reference point, you can 
simply drag the selection to another location within the drawing. Simple dragging does not allow you to 
use snap modes or the Coordinate Fields for accurate placement, but it is convenient if you don´t need 
accurate placement.



Scaling a Selection
You can scale a selection either by dragging its handles, or by entering values for and X and Y scale in 
the Edit Bar. 
Drag the handles on the corners to freely resize the selection both horizontally and vertically. To scale the 
selection only horizontally or only vertically, drag the handles on the sides, top, or bottom of the selection 
rectangle. To scale the selection while keeping the same proportions of height and width, hold down the 
<Shift> key while dragging the handles.

To scale a selection using the Edit Bar, type values into the XScale and YScale Edit Bar fields, then press 
<Enter>. For example, if you want to double the width of the selection while increasing its height by 50 
percent, type 2 into the XScale field and type 1.5 into the YScale field, then press 



Copying While Moving or Scaling
The Make a Copy option in the Local menu lets you make a copy of the selection at the same time that 
you move or resize the object. To use this option:

1. Select the object or objects that you want to copy.
2. Right-click in the drawing area to open the Local menu, then choose Make a Copy, if it isn´t already 

checked. (This is a toggle, so if it already has a check mark next to it, choosing it will turn it off.)
3. Move or scale the selection by either picking the reference point or dragging by the reference point. 

When you move or scale the selection, the original will remain at its original location and size, while a 
copy is created at the new location and size.



Rubber Stamp
Turning on the Rubber Stamp option allows you to place multiple copies of selected objects in your 
drawing. To use this option:

1. Select the object or objects that you want to copy.
2. Right-click in the drawing area to open the Local menu, then choose Rubber Stamp, if it isn´t already 

checked. The cursor will change into a rubber stamp symbol.
3. Click anywhere in the drawing to place a copy of the selection.

You can continue clicking to place as many copies of the selection as you like. To turn Rubber Stamp off, 
right-click in the drawing are to open the Local menu and choose Cancel, or press <Esc>.

Note 



Rubber Stamp placement does not respond to snap modes.



Rotating a Selection
To rotate a selection either move its rotation handle, or type a value into the Edit Bar. To move the rotation
handle of the selection, click on the handle, then define a point by clicking the mouse, using any snap 
mode.
To rotate the selection using the Edit Bar, type a value for the degrees of rotation into the Edit Bar´s 
Rotation field, then press <Enter>. The value you enter in the Edit Bar is the number of degrees that the 
selection will be rotated in the positive direction of rotation. To rotate the object in the opposite direction, 
enter a negative value in the Rotation field.

Note 
Tip 
See Also 



The positive direction of rotation is counterclockwise by default. You can reverse the direction in the Angle
property sheet of the Drawing Setup dialog.



When you rotate a selection you can use Ortho mode to constrain the angle of rotation. You can turn on 
Ortho mode in the menu, toolbar, or local menu before or during the placement of the selection; you can 
also toggle Ortho mode during placement by holding down the <Shift> key.



Ortho 



Node Edit
In Node Edit mode you can reshape entities by directly manipulating particular points called nodes.

Add, delete, and move nodes on entities composed of line segments (including lines, double 
lines, polygons, and sketches).

Divide line segments into any number of subsegments of equal length.
Break polygons, making them into multilines.
Close multilines, making them into polygons.
Close the endpoints of double lines.
Reshape Bezier and spline curves by adding, deleting, and moving nodes on the line segments 

that form the curves´ frame.
Change the radius of circles and circular arcs.
Change the major and minor axes of ellipses and elliptical arcs.
Change the start and end angles of circles, ellipses, and arcs.
Close arcs, making them into circles.
Divide circles, arcs, and ellipses into arc segments of equal angular length.

To activate Node Edit mode, first select the entity that you wish to edit. Then click the right mouse button 
in the drawing area to display the Local menu. From the local menu, choose Node Edit. The appearance 
of the selection will change. Instead of a selection box with handles, you will see highlighted objects with 
nodes displayed as blue rectangles. The number and placement of the nodes depends on the type of 
object selected.
To deselect an entity in Node Edit mode, choose Cancel or Select Edit from the Local menu to return to 
Select Edit mode, then click anywhere in the drawing area outside the selection rectangle to deselect.

Node Edit with Lines and Polygons 
Node Edit with Curves and Sketched Lines 
Node Edit with Circles, Ellipses, and Arcs 
Node Edit of Dimensions 
Manipulating Text 

Note 



You can only edit one entity at a time in Node edit. You cannot use this mode to work with multiple 
selected entities or with groups. To edit the nodes of an entity that is in a group, first select the group, then
break it into its component entites using the Format|Explode command. Because groups can be nested, 
you may need to explode the selection more than once in order to isolate a single entity.



Node Edit with Lines and Polygons
There are several editing actions you can perform on entities composed of line segments. These actions 
include adding a node, deleting a node, moving a node, and dividing a line or double-line segment.

Adding a Node to a Line Segment 
Deleting a Node from a Line Segment 
Moving a Node 
Dividing a Line or Double Line Segment 
Breaking Polygons 
Closing Multilines 
Closing Endpoints of Double Lines 



Adding a Node to a Line Segment
To add a node to a single line segment or to an entity composed of line segments, such as a multiline or 
polygon:

1. Select the entity that you want to edit. Click the right mouse button in the drawing area to open the 
Local menu, then choose Node Edit.

2. Hold down the <Ctrl> key while placing the mouse cursor over a part of a line or double-line segment 
where there is no node. When you are in the correct position, the cursor will show a node being 
placed at the center of 
a cross.

3. Click to place the node on the line segment.

A node will appear on the line or double-line segment at the location of the mouse cursor. You can now 
drag the node to reshape the line segment into a multiline.

Note 



As an alternative to holding down the <Ctrl> key while clicking on the line segment, you can place the 
mouse cursor at the position where you want to add the node, then right-click and choose Add Node from 
the Local menu.



Deleting a Node from a Line Segment
To delete a node from a line segment:

1. Select the entity that you want to edit. Click the right mouse button in drawing area to open the Local 
menu, then choose Node Edit.

2. Hold down the <Ctrl> key while placing the mouse cursor over the node that you want to delete. 
When you are in the correct position, the cursor will change to an icon showing a node being thrown 
into a trash can.

3. Click to delete the node.

If you remove a node from a polygon, TotalCAD will keep the polygon closed by connecting the opposite 
endpoints of the line segments that were connected at the deleted node.

Note 
See Also 



You cannot delete a node that is necessary to define an entity as a line segment or polygon. This means 
that you cannot delete the endpoint of a single line segment, and you cannot delete any node of a 
triangle. If you delete the endpoint of a multiline, you will delete the entire line segment that terminates at 
that point. 



Closing Multilines, Breaking Polygons 



Moving a Node
You can reshape a single line segment or any entity composed of line segments, such as a multiline or 
polygon, by defining a point for the location of any node. To do this:

1. Select the entity that you want to edit.
2. Click the right mouse button to open the Local menu and choose Node Edit.
3. Click on the node that you want to move.
4. Define the point to which you want to move the node. You can do this either using the mouse and any

snap mode, or by typing the coordinates of the point in the Coordinate Fields and pressing <Enter>.

Note 



You can also simply drag the node to any position you want; dragging a node also gives you access to all 
snap modes.



Dividing a Line or Double Line Segment
The Segment Divide command from the Local menu lets you add nodes to a line segment, breaking the 
line segment into a multiline composed of segments of equal length. To do this:

1. Select the entity that you want to edit.
2. Click the right mouse button to open the Local menu and choose Node Edit.
3. Place the mouse cursor over the line segment that you want to divide.
4. Click the right mouse button to open the Local menu and choose Segment Divide. TotalCAD will 

display the Divide Segment By dialog.
5. Enter the number of parts    into which you want to divide the line into the dialog, then press <Enter>.



Breaking Polygons
Node Edit allows you to break a polygon at any node, turning it into a multiline. To break a polygon:

1. Select the polygon that you want to edit.
2. Click the right mouse button to open the Local menu and choose Node Edit.
3. Position the cursor over the node where you want to break the polygon.
4. Click the right mouse button to open the Local menu and choose Break.

The polygon is now an open multiline, and there are two nodes located at the point where you broke they 
polygon. You can open the polygon visually by moving these nodes apart.

Note 



You can also use this technique to break a closed Bezier or Spline curve.



Closing Multilines
Node Edit allows you to close a multiline, making it into a polygon. To close a multiline:

1. Select the multiline entity that you want to close.
2. Click the right mouse button to open the Local menu and choose Node Edit.
3. Position the cursor over either endpoint of the multiline.
4. Click the right mouse button to open the Local menu and choose Close.

TotalCAD will draw a line between the two endpoints of the multiline (assuming that these two nodes don
´t share the same location), forming a geometrically closed polygon. If the two endpoints of the multiline 
share the same location, TotalCAD will simply close the polygon geometrically, since it is unnecessary to 
draw a line between the two points.

Note 

Warning 



You can also close a Bezier or Spline curve using this technique.



If you simply snap the endpoints of a multiline together you have something that looks exactly like a 
polygon; however, TotalCAD still considers it a multiline. This means that you won´t be able to use a fill by
setting the entity´s brush color and pattern in its Properties sheet. In order to turn a multiline into a true 
polygon, you must close the multiline.



Closing Endpoints of Double Lines
Node Edit allows you to close the endpoints of double lines. To do this:

1. Select the double-line entity.
2. Click the right mouse button to open the Local menu and choose Node Edit.
3. Position the cursor over either endpoint of the double line.
4. Click the right mouse button to open the Local menu and choose Close Double End.

TotalCAD will close the double line with a flat end.



Editing Double Line Cutlines and Gaps
Cutlines and gaps occur at the intersections of double lines. For example, if you form a clean T 
intersection of two double lines at an angle other than 90 degrees, the end of one of the double lines will 
be "cut" at an angle; the other double line will have a "gap" to accomodate the first double line. Node Edit 
mode allows you to drop the cutlines in the first line, "evening" out the end of the line; it also allow you to 
fill in the gap in the second line.



Node Edit with Curves and Sketched Lines
Sketches (entities created with the Sketch tool) are actually multilines composed of miniscule line 
segments, so they can be edited in Node Edit mode as multilines that have a very large number of nodes.
Bezier and spline curves are both drawn in reference to a sequence of points (spline curves actually pass 
through the points, while Bezier curves gravitate toward the points). In Node Edit, each of the defining 
points of the curve is represented by a node.
In Node Edit mode, you can move or delete any of the nodes that define a curve, and you can add new 
nodes that you can move to reshape the curve. You can move and delete the nodes on a curve the same 
way that you move and delete nodes on a line segment, multiline, or polygon. 
You can also close a Bezier or Spline curve, or break a closed Bezier or Spline curve at any node, using 
the same technique that you would use to close a multiline or break a polygon.

Adding a Node to a Curve 
Dividing a Line Segment in the Frame of a Curve 

See Also 



Adding a Node to a Line Segment, Breaking Polygons, Closing Multilines, Deleting a Node from a Line 
Segment, Moving a Node 



Adding a Node to a Curve
To add a node to a Bezier or spline curve:

1. Select the curve that you want to edit. Click the right mouse button in drawing area to open the Local 
menu, and choose Node Edit.

2. Hold down the <Ctrl> key while placing the mouse cursor over a segment of the curve where there is 
no node. When you are in the correct position, the cursor will change to an icon showing a node being
placed at the center of a cross.

3. Click to place the node on the line segment.

A node will appear on the line segment at the location of the mouse cursor. You can now drag the node to 
reshape the curve.

Note 



As an alternative to holding down the <Ctrl> key while clicking on the line segment, you can place the 
mouse cursor at the position where you want to add the node, then right-click and choose Add Node from 
the Local menu.



Dividing a Line Segment in the Frame of a Curve
The Divide Line command from the Local menu lets you add nodes to a line segment on the frame of a 
curve, breaking the line segment into any number of subsegments of equal length. To do this:

1. Select the curve that you want to edit. Click the right mouse button to open the Local menu, then 
choose Node Edit.

2. If the frame of the curve is not visible, choose Format|Properties from the menu (or right-click and 
choose Properties from the Local menu) to display the Properties dialog. Bring the Curve property 
sheet to the front by clicking on its tab, then click the Show Frame check box. Press <Enter> to close 
the dialog. You will now see the line segments that form the frame of the curve.

3. Place the mouse cursor over the line segment that you want to divide on the frame of the curve that 
you want to divide.

4. Click the right mouse button to open the Local menu and choose Divide. TotalCAD will display the 
Divide Segment By dialog.

5. Enter the number of parts    into which you want to divide the line segment into the dialog, then press 
<Enter>.

You can move any of the nodes on the curve´s frame to reshape the curve.



Node Edit with Circles, Ellipses, and Arcs
In Node Edit mode you can change the radius of a circle or circular arc, the major and minor axes of an 
ellipse or elliptical arc, and the starting or ending angles of any arc, circle, or ellipse. You can also divide 
any circular or elliptical entity into any number of equal arcs.
To edit a circle, ellipse, or arc in Node Edit mode, first select the entity that you want to edit, then click the 
right mouse button in the drawing area to open the Local menu and choose Node Edit. The entity that you
selected will be highlighted with its nodes displayed. In the case of a circle or circular arc, you will see 
three nodes: two for manipulating its starting and ending angles, and one for manipulating its radius. In 
the case of an ellipse, you will see four nodes: two for manipulating its starting and ending angles, and 
two for manipulating its major and minor axes.

Changing the Radius of a Circle or Circular Arc 
Editing the Major and Minor Axes of Ellipses and Elliptical Arcs 
Changing the Starting and Ending Angle of an Arc 
Dividing an Arc 

Tip 



If you are confused by the notion of editing the starting and ending angles of a circle or ellipse, try thinking
of circles and ellipses as arcs that have their starting and ending angles at zero and 360 degrees.



Changing the Radius of a Circle or Circular Arc
To alter the radius of a circle or circular arc:

1. Select the circular entity that you want to edit. Click the right mouse button to open the Local menu, 
then choose Node Edit. You will see three nodes, one of which, a blue square, is the radius node: You
can manipulate this node to change the circle´s radius.

2. You can now either define a point for the radius node, or directly enter the radius of the circle in the 
Edit Bar. To define a point, click on the radius node, then define a point by clicking the mouse, using 
any snap mode; or type values for the point´s coordinates in the Coordinate Fields, then press 
<Enter>.
To specify the radius in the Edit Bar, press <Tab> to leave the drawing area, type a value for the 
radius into the Radius field of the Edit Bar, then press <Enter>.

You can also simply drag the radius point to another position, but in doing this you lose the precision of 
using snap modes, the Coordinate Fields, or the Edit Bar.



Editing the Major and Minor Axes of Ellipses and Elliptical Arcs
To scale an ellipse or elliptical arc:

1. Select the elliptical entity that you want to edit. Click the right mouse button to open the Local menu 
and choose Node Edit. You will see four nodes, two of which are blue rectangles on the perimeter of 
the ellipse: You can manipulate these nodes to scale the ellipse.

2. You can now either define points for the the two nodes, or directly enter val-ues for the lengths of the 
major and minor axes of the ellipse in the Edit Bar:

To define points for the nodes, first click on one of the nodes, then define a point either by clicking
the mouse using any snap mode, or by typing values for the point´s coordinates in the Coordinate Fields 
and pressing <Enter>. Repeat this procedure for the other node.

To specify the lengths of the axes in the Edit Bar, press <Tab> to leave the drawing area, type a 
value for the axes in the Major and Minor fields of the Edit Bar, then press <Enter>.
You can also simply drag the nodes to another position, using any snap mode.

Tip 



While changing the length of an ellipse´s axis, you can hold down the <Shift> key, constraining the 
proportions of the ellipse and changing the length of both axes simultaneously.



Changing the Starting and Ending Angle of an Arc
To alter the starting and ending angles of a circle, circular arc, ellipse, or elliptical arc:

1. Select the entity that you want to edit. Click the right mouse button to open the Local menu and 
choose Node Edit. You will see three nodes for circular entities and four nodes for elliptical entities. 
Two of the nodes are represent-ed as a yellow and a blue circle at the ends of dotted lines. You can 
manipulate these nodes to change the starting and ending angles of the entity.

2. You can now either move the nodes to specify starting and ending angles, or enter values for the 
starting and ending angles in the Edit Bar:
To move the nodes, first click on one of the nodes, then define a point by clicking the mouse, using 
any snap mode. Repeat this procedure for the other node.
To specify the starting and ending angles in the Edit Bar, press <Tab> to leave the drawing area, type 
a value for the axes in the Start Ang and End Ang fields of the Edit Bar, then press <Enter>.



Dividing an Arc
The Divide command from the Local menu lets you divide an arc or circle into subarcs of equal angular 
length. To do this:

1. Select the entity that you want to edit. Click the right mouse button to open the Local menu and 
choose Node Edit from the Local menu.

2. Click the right mouse button to open the Local menu, and choose Arc Divide. TotalCAD will display 
the Divide Arc By dialog.

3. Enter the number of parts    into which you want to divide the arc into the dialog, then press <Enter>.



Node Edit of Dimensions
Dimensions have nodes that let you manipulate the position of the dimension line, extension lines, and 
dimension text. You can also move the associative nodes of the dimension, including the vertex of an 
angular dimension. This has the effect of changing the dimension´s automatic text, and breaking the 
association between the dimension and the object with which the associative nodes were linked.



Manipulating Text
TotalCAD has a rich set of features for manipulating text, based on the principle that you can edit the text 
either as a TrueType font, or as a polygon. 
When you first create text, it is a TrueType font. You can select the text, resize it, rotate it, and stretch it. 
One advantage of this is that the text will always look "correct" onscreen and in printed copy, no matter 
how it is scaled or rotated. When text is in this state you can edit it by changing the Attribute field of the 
General property sheet in the Properties dialog. Double-click on the text with the Select tool to bring up 
this dialog. You can reformat the text (changing its font, size, attributes, and justification) using the Format
Text toolbar or the Text property sheet of the Properties dialog.
If you want more freedom to manipulate the text graphically, you need to turn the text into an irregular 
polygon. To do this, select the text object using the Select tool, the choose Format|Explode. The first time 
you do this, you will turn the text object into a group of polygons. You can now resize, stretch, rotate, or 
flip the graphic text using handle-based editing, producing a variety of effects. 
If you explode the text a second time, it will ungroup so that each individual character can be manipulated
as a polygon. You can resize, stretch, move, flip, or rotate each individual character in Select Edit mode. 
You can change the pen, brush pattern, or other properties of the multiline by double-clicking on the 
selection and changing the settings in the Properties dialog.
If you select an individual polygon (character), and then right-click and choose Node Edit from the local 
menu, you can edit individual nodes. You can move, delete, and add nodes; and you can also break the 
polygon into a multiline.
If you explode an individual polygon character, it will be broken into individual line segments.

See Also 



Node Edit with Lines and Polygons, Select Edit, Text Property Sheet 



Drawing Environment
The View menu provides features that let you control two aspects of the drawing environment. These 
features enable you to:

Change your view of the drawing area by zooming and panning.
Set up your desktop by displaying and hiding toolbars and other interface controls.



Views of the Drawing Space
The TotalCAD drawing space is a plane on which you can place drawing entities and other objects. A view
is the area of the drawing space that appears on your screen. As your drawing become larger and more 
complex, it´s important to be able to find views that let you work at the right location in your drawing, at an
appropriate level of detail. You may need to concentrate your work within a tiny portion of the drawing, 
you may need to pull back and see all the objects on the drawing, or you may need to see the drawing at 
the size it will be when printed. TotalCAD offers a variety of options for panning and zooming that get you 
quickly to the exact view that you need.

Tip 
See Also 



Another powerful way to control your view of the drawing is by selectively viewing layers. You can control 
the visibility of layers through the Tools|Layers property sheet.



Layers Property Sheet



Zooming
Zooming means to move in or out of the drawing space, viewing the drawing at a greater or lesser level of
detail. The View menu provides a number of zooming commands. 
One quick and easy way to zoom is to use the plus and minus keys of the numeric keypad: plus zooms in 
one step; minus zooms out one step. The amount that you zoom in each step depends on the zoom 
factor, which by default is set to 2. You can set the zoom factor in the Tools|Program Setup dialog.

Notes 
Tip 
See Also 



When you zoom in and out using the plus and minus keys, the view centers on the mouse cursor.    If you 
zoom in using the menu command, you will zoom in on the center of the current view, regardless of the 
position of the mouse cursor.

As you zoom out, TotalCAD simplifies the representation of very small objects on the screen to increase 
redraw speed.



To zoom in on a particular point in the drawing and place it at the center of the screen, place the mouse 
cursor over the point and press the <+> key on the numeric keypad.



Program Setup Dialog, Zoom Commands 



Panning
Panning means to move the view to another location across the plane of the drawing. TotalCAD´s View 
menu provides several different options for panning.
Two simple ways of panning are to use the scroll bars or arrow keys. The scroll bars work the same way 
that they do in other Windows programs. You can click the scrollbar arrow buttons to scroll one step, click 
in the body of the scrollbar to scroll about one third of a screen, or drag the "thumb" of the scrollbar to 
move quickly across the drawing. The arrow keys are also simple and intuitive: press the up, down, left, or
right arrow key to pan a single step.

Tip 



To quickly pan to a specific point, place the mouse cursor at the point, then type <Ctrl>+<End>. You will 
instantly move to a view with the point you chose at the center 
of the screen.



Setting up the Desktop
In TotalCAD 1.0 you can set up the user interface to suit your own preferences, or to fit the requirements 
of a particular drawing task. You do this by selectively displaying and hiding toolbars and other interface 
controls, and by positioning or "docking" toolbars and other movable controls, such as palettes, on the 
TotalCAD desktop.

Tip 
See Also 



You can control whether TotalCAD saves your desktop arrangement when you exit by setting the Save 
Desktop on Exit option in the Program Setup dialog.



Program Setup Dialog



Displaying and Hiding Controls
The View menu provides a number of commands for displaying and hiding interface controls such as the 
Edit Bar, Coordinate Fields, and rulers. Each of these commands is a toggle, which means that it acts as 
an on/off switch. If the menu command is displayed with a check mark, the control is currently displayed. 
If the menu command is displayed without a check mark, the control is hidden.
You can display and hide the TotalCAD toolbars through the Tools|Desktop property sheet, which is also 
accessible through the View|Toolbars command.

Tip 
See Also 



It´s generally a good idea to set your preferred settings in the Tools|Desktop property sheet, and then use 
the View menu to show and hide individual controls as you are working.



Desktop Property Sheet, TotalCAD Desktop 



Docking Toolbars
You can move any toolbar, or the Edit Bar, by positioning the mouse over its edge and dragging it to 
another position. There are three places on the TotalCAD screen where you can "dock" toolbars: the 
upper toolbar area, just below the menu bar; the left or right edge of the screen, which expands to form a 
vertical docking area; and the drawing area. When you dock a toolbar on the upper part of the screen it 
will be oriented horizontally. If you place it along the left or right edge of the screen it will be positioned 
vertically. Toolbars placed over the drawing area will act as a floating palette. A floating palette is always 
visible in front of your drawing.



Creating and Inserting Objects
The Insert menu gives you access to all of the TotalCAD drawing tools, as well as to dialogs that let you 
insert various types of objects into your drawing. You can use the drawing tools to create:

Drawing entities (such as lines, circles, and polygons). 
Construction entities (temporary lines that you use as reference points or to mark off areas in 

your drawing).
You can also insert the following types of objects into your drawing:

Pictures (Windows metafiles or bitmaps).
OLE objects, which you can edit using other Windows applications from within TotalCAD.

Creating Entities 

See Also 



View Symbol Library 



Creating Entities
To use any drawing tool you need to understand a set of common techniques. These techniques include :

Formatting objects by setting their properties.
Defining points by using the mouse in combination with snap modes, or by using the Coordinate 

Fields, and specifying measurements, such as length and angle, using the Edit Bar.
Finishing and canceling operations.
Using the Local Menu.

For a more detailed discussion of how to apply the techniques in the process of creating an actual 
drawing, run the TotalCAD online tutorial by choosing Tutorial from the Help menu.



Formatting Entities
When you draw an entity in TotalCAD, the entity is formatted using the current default properties of the 
tool with which you draw it. These properties include, among many other things, the width, style, and color
of the pen, as well as the pattern and color of the brush. In addition to these common properties, some 
types of entities, such as text, double lines, curves, and dimensions, have properties that belong only to 
the specific entity type. To set the properties for a drawing tool, you can activate the tool and choose 
Format|Properties, or you can simply right-click on the drawing tool.
Once an entity is drawn, you can format it by changing its properties. To do this, first select the entity, then
choose Format|Properties; or simply activate the Select tool, then double-click on the entity that you want 
to format.

Note 
See Also 



You cannot access or change the properties of construction lines.



Setting Properties, Property Toolbar , Properties 



Defining Points and Specifying Measurements
To create any entity you must use some combination of the following three methods:

Define points by clicking the mouse in the drawing area, using snap modes.
Define points by entering their coordinates in the Coordinate Fields.
Specify measurements (lengths, angles, and sometimes other information) in the Edit Bar.

Almost always, the first step in drawing any entity is to define its starting point. After the first point is 
defined, you create the entity by defining a series of points and/or specifying measurements.
For example, to draw a circle using the Center and Point tool, you first need to define a point for the 
center of the circle. After this point is defined, you have three ways of completing the circle: 

Define any point that will be on the perimeter of the circle using the Coordinate Fields or mouse.
Specify the radius of the circle in the Edit Bar.
Specify the circumference of the circle in the Edit Bar.

The method you choose depends on the specific characteristics of the tool you are using, the drawing 
task, and your own preferences. 

Warning 



Trying to draw an entity in the Edit Bar without defining the entity´s starting point can sometimes lead to 
confusing results. It´s almost always simpler to start drawing an entity by defining its starting point.



Defining Points with the Mouse
In a sense, you define points with the mouse by simply pointing and clicking. However, what exactly 
happens when you define a point this way depends on snap modes and on TotalCAD´s Ortho setting. The
following topics discuss these features briefly.

Using Snap Modes 
Constraining Angles with Ortho 
Setting Snap Modes and Ortho 



Using Snap Modes
The result you get when you click the mouse in the drawing area depends, in part, on the current snap 
mode. If your snap mode is currently set to No Snap, then the point will simply be defined at the position 
where you clicked the mouse. Otherwise, the location of the point will be calculated relative to a drawing 
object or to the grid. If there is no point to snap to based on the mouse position, TotalCAD will beep, and it
won´t define a point at all. To find out how to change snap modes, see Setting Snap Modes and Ortho.

See Also 



Snap Modes 



Constraining Angles with Ortho
To constrain angles when you are drawing with the mouse, use Ortho mode. You can activate Ortho 
through the Modes menu, the Snap toolbar, or the Local Menu. The Local Menu turns Ortho on or off only
until the next point is defined; TotalCAD then reverts to the Ortho setting in the Modes menu. 
If you are using TotalCAD´s factory settings, Ortho restricts lines to orthogonal (vertical and horizontal) 
angles. You can configure ortho mode to less restrictive settings in the Angle property sheet (choose 
Tools|Angle). Some CAD users, for example, prefer to restrict angles to increments of 15 degrees.

See Also 



Angle Property Sheet, Ortho 



Setting Snap Modes and Ortho
You can change Snap modes and Ortho mode any time, even while you are in the middle of drawing an 
entity. For example, to create a spoke on a wheel you could snap the first point of a line to the center of a 
circle, then snap the second point of the line to a point on the perimeter of the circle. To set a default snap
mode, use the Snaps toolbar or the main menu; to set a "one shot" snap mode that stays in effect until 
you define the next point, use the Local Menu. To use the Local Menu, click the right mouse button in the 
drawing area to open the menu, choose the desired Snap mode, then click the mouse to define the point. 

Note 
Tip 



The Local Menu gives you "one shot" mode changes. If you change modes using the Local Menu, the 
mode will change back to the setting in the Modes menu after you define the next point.



Another convenient way to turn Ortho on or off temporarily is to hold down the <Shift> key while drawing.



Defining Points Using the Coordinate Fields
In addition to using the mouse with Snap Modes and Ortho, you can also define points by entering them 
directly into the Coordinate Fields and then pressing <Enter>. Points defined in the Coordinate Fields are 
are always defined at the exact coordinate positions specified, regardless of the snap mode. The type of 
coordinates you type in the Coordinate Fields depends on the coordinate system you are using. In the 
absolute and relative coordinate systems you use X,Y coordinates. In the polar coordinate system you 
enter an angle and distance.
You can lock down the coordinates in the Coordinate Fields, so that the values in the boxes don´t change 
when you move the mouse cursor over the drawing area. To do this, check their lockdown boxes (these 
are immediately to the left of the fields). 

See Also 
Tip 



Coordinate Fields, Coordinate Systems 



The Coordinate Field lockdown boxes are particularly useful when you lock down just one dimension. If 
you enter a value in just one of the fields and lock it down, you can then set the second coordinate using 
the mouse. This makes it easy to define a series of points along a specific horizontal or vertical line.



Drawing with the Edit Bar
The Edit Bar lets you draw entities parametrically by specifying dimensions and angles. To do this, you 
must define a starting point for the entity that you are drawing. For example, to draw a regular polygon 
using the Edit Bar, define the centerpoint of the polygon using the mouse or Coordinate Fields, and define
the polygon´s number of sides, radius, and start angle in the Edit Bar.

Using the Edit Bar Lockdown Boxes 

Note 



Creating or editing an entity with the Edit Bar ignores Ortho and snap mode settings. The entity will be 
defined using the exact values that you enter in the Edit Bar.



Using the Edit Bar Lockdown Boxes
Many fields on the Edit Bar have lockdown check boxes, similar to those on the Coordinate Fields. When 
these boxes are checked, the values in the fields don´t change when you move the mouse over the 
drawing area. This makes it possible to lock down one of the values and manipulate the second value 
with the mouse.
For example, you might want to specify the exact radius of an arc in the Edit Bar, then use the mouse to 
determine the locations of the arc´s starting and ending angles. After defining the starting point for the arc,
you could type its radius into the Edit Bar, then lock down the Radius field. This prevents the radius from 
changing when you re-enter the drawing area. You could then use the mouse and snap modes to 
determine the arc´s starting and ending angles.



Finishing and Canceling
Some entities are defined by a specific number of points. For example, you can draw a triple-point circle 
by defining three points. When you define the circle´s third point, the circle is finished automatically.
Other entities, such as multilines, are composed of an indeterminate number of parts. You can add as 
many segments to a multili as you like.
Users of earlier versions of TotalCAD may be confused by the way you cancel and finish such entities in 
TotalCAD 1.0. However, with a little practice you will find that TotalCAD 1.0 is consistent and intuitive in 
the way it handles these operations. It will help the transition if you remember these rules:

Cancel always means to stop the current drawing operation and start over. It removes the entire 
entity you are currently drawing. For example, if you press <Esc> or choose Cancel from the Local Menu 
while you are drawing a multiline, the entire multiline will vanish, not just the last segment.

Finish means to complete the entire entity. For example, if you are creating a multiline you can 
finish the entity by (1) double-clicking, (2) pressing the right mouse button and choosing Finish from the 
Local Menu, or (3) pressing <Ctrl>+<F> while working in the Edit Bar. 

Pressing <Enter> in the Edit Bar means to accept the current setting in the Edit Bar fields. If you 
press <Enter> while drawing a multiline, the settings in the Edit Bar will be used to draw the next segment
of the multiline. If you are creating an entity with a fixed number of steps, then pressing <Enter> in the 
Edit Bar will finish the entity, provided you have already defined a starting point.

Note 
Tip 



When you are working in the Coordinate Fields, pressing <Enter> simply defines a point as specified in 
the Coordinate Fields. 



Entities that can be closed geometrically, specifically the Multiline, Double Multiline, Bezier Curve, and 
Spline Curve tools, provide another option for finishing. If you choose Close from the Local Menu, 
TotalCAD will complete the entity by drawing a line or curve from the entity´s first point to its last point.



Using the Local Menu
The Local Menu is context-sensitive: The specific commands and options available in the Local Menu 
change, depending on the currently active drawing or editing tool. Many of these commands and options 
are quite powerful, so it really pays to right-click in the drawing area and see what options are there when 
you are learning to use a drawing tool.
For example, when you are using the Text tool, the Local Menu lets you size and rotate the text "on the 
fly," and specify with great precision exactly where the text will be placed relative to the insertion point.



Formatting Objects
TotalCAD´s Format menu contains commands and tools for setting the appearance and format of drawing
entities and other objects. These features enable you to:

Format objects by setting their properties.
Combine objects into groups.
Explode groups and objects into their constituent parts.
Apply hatch patterns to objects.
Send objects to the back and bring them to the front.
Align multiple selected objects.

Setting Properties 
Property Toolbar 
Formatting Text 
Groups



Setting Properties
Every object in TotalCAD has a set of properties. The exact set of properties depends on the type of 
object. All drawing entities share the following common sets of properties, organized by property sheet in 
the Properties dialog:

General. The layer on which the object resides, and a text attribute (generally its name) 
associated with it.

Pen. The color, width, and style of lines.
Brush. Determine the characteristics of fills and hatches.

There are also properties associated with specific classes of entities. Dimensions, for example, have a 
number of properties that apply specifically to them, located on the Format property sheet. Double lines, 
text, and curves also have properties and corresponding property sheets specific to them.
When you set properties, you can either set the default properties for a drawing tool, or set the individual 
properties of selected objects. These options are covered in the following topics.

Setting the Default Properties of a Tool 
Setting the Properties of Selected Objects    

Note 
See Also 



The Properties dialog is context-sensitive, meaning that it will display only the property sheets appropriate
to the currently selected tool (or the currently selected objects). For example, if you select a line segment 
and a double-line segment, then bring up the Properties dialog, you will see the General, Pen, Brush, and
Double-Line property sheets. You won´t see the Curve property sheet, for example, because the objects 
you have selected don´t include any curves.



Properties 



Setting the Default Properties of a Tool
When you set the default properties of a tool, all subsequent entities drawn with that tool will have the 
settings you specified, until you explicitly change them. To access the default properties, either right-click 
on the tool icon, or activate the tool and then choose Format|Properties.



Setting the Properties of Selected Objects
The Properties dialog is context-sensitive, meaning that when you open it it will display the set of property
sheets that are appropriate to the objects selected. If you select a double line, or a set of entities that 
include a double-line entity, then bring up the Properties dialog, the properties dialog will contain the 
double-line property sheet.
You can use this dialog to set the default properties for a drawing tool; or to set the individual properties of
a particular object or set of objects.
If you have property settings that you want to reuse, you can save them as a style, then reapply the style 
later to other entities.

See Also 



Layers Property Sheet, Property Toolbar , Properties 



Property Toolbar
The Property toolbar gives you a quick and convenient way of setting the properties of any selected 
object or set of objects, or for setting the default properties of a drawing tool. If the Property toolbar is not 
visible on the screen, you can display it using the View Toolbars dialog. 
If no objects are currently selected, the settings on the Property toolbar apply to the active drawing tool. 
For example, if you activate any single line tool and then change the settings on the Property toolbar, the 
settings will apply to all objects drawn with any single line tool. 
If there are objects selected, settings in the Property toolbar apply to the selected objects.
The Property toolbar consists of five pulldown list boxes. From left to right they are:

Style. Use this list box to apply predefined property settings to a drawing tool. You can save styles
in the Properties dialog. This control can be used only to set the properties of a drawing tool; it is 
unavailable if you are setting the properties of selected objects.

Layer. Use this list box to set the layer on which objects are drawn.
Color. Use this list box to set the pen color.
Line Style. Use this list box to set the style of the line. You can use a continuous line or choose 

from several types of dotted or dashed lines.
Brush Style. Use this list box to choose a fill pattern for closed entities.

Note 
See Also 



In TotalCAD 1.0 you cannot apply a style to a selection. The Style pulldown box is accessible only when 
you are setting the default properties of a drawing tool.



Layers Property Sheet, Properties, Formatting Entities 



Formatting Text
You can format text in TotalCAD using either the Text Format toolbar or the Text property sheet.    The Text
property sheet offers more options than the Text Format. 
You can display and hide the Text Format toolbar via the Desktop property sheet, which you can access 
by choosing either View|Toolbars or Tools|Desktop. You can use Text Format toolbar either to set default 
properties for the Text tool (which will be saved with your drawing), or you can use it to format selected 
text. To change default settings, activate the Text tool on the Insert toolbar, then choose settings on the 
Text Property toolbar. These setting will stay in effect until you explicitly reset them. To format selected 
text, first select the text using the Select tool, then choose settings in the Text Format toolbar.
The Text Format toolbar has the following controls:

Font . Pull down this list box to set the font. You can use any TrueType font that is installed on 
your system.

Size. Pull down this list box to set the text size. (The size can be in either World or Paper units, 
depending on the current mode. Check the icon in the upper-left corner of the ruler.)

Attributes. Click the Bold, Italic, and Underline buttons to turn these text attributes on and off.
Justification. Click these buttons to choose whether the text is left, center, or right-justified in its 

frame. Left-justified text will be typed in to the right of the point where you placed the text; right-justified 
text extends to the left of this point; center-justified text will be centered on the point.

See Also 



Manipulating Text, Text Tool, Text Property Sheet 



Groups
TotalCAD drawing objects can be combined into groups. The drawing objects can be entities, such as 
lines circles and arcs, or they can be other groups. TotalCAD treats a group as a single object for 
purposes of selecting and editing.
To break up a group into its constituent parts, select it, then use the Explode command. 
The names of groups are held in the Attribute field of the properties dialog. To view or edit this field, 
activate the Select tool, then double-click on the group.
Because groups can themselves contain groups , you can think of them as complex hierarchical 
structures. 

Tip
See Also



You can view the structure of a group insert by selecting it and exploring the Selection Info palette (View|
Selection Info).



Create Group, Explode 



Snaps and Coordinates
Modes enable you to control how TotalCAD responds to your actions when you are drawing or editing. 
Some modes are mutually exclusive; others can be used in combination. This provides you with an 
enormous number of possible techniques, but the fundamental principles underlying all the modes are 
consistent and relatively simple. Once you understand these principles, you will be able to exploit them to 
find efficient and precise methods of drawing and editing.
There are two major categories of modes:

Snap Modes, which determine where exactly TotalCAD defines a point when you click the mouse 
in the drawing area.

Coordinate System Modes, which determine how you can use mathematical coordinates to 
specify the location of any point on the drawing.



Snap Modes
Snap modes let you define points relative to objects in the drawing area when you are drawing or editing 
with the mouse. You can define points relative to drawing entities, construction lines, and the grid. All snap
mode functions are similar: You first set the snap mode, then click on or near the object that you want to 
snap to. Rather than defining the point exactly where you clicked the mouse, TotalCAD will define the 
point precisely on the object. The point that TotalCAD chooses depends on the snap mode. You can, for 
example, snap to the end of a line, the midpoint of a line, the center of a circle, or a point on the grid.
Snap Aperture 
Local Snap 



Snap Aperture
The critical distance between the point of the mouse click and an object or grid point is the snap aperture. 
You can think of the snap aperture as a circular area centered on the point of the mouse click. If an object
containing a qualifying snap point is located within the snap aperture at the time of the mouse click, your 
point will be defined at the nearest qualifying snap point. If more than one object is located within the snap
aperture, your point will still be defined at the closest qualifying snap point.
Note that in most cases the snap point itself does not need to be located within the snap aperture. (Snap 
to Grid and Snap to Near Point are obvious exceptions to this.)

Tips 
Notes 
See Also 



To see the snap aperture while you are working, choose View|Aperture.

To get additional visual feedback when using Snap modes, turn on the Magnetic Point tool. When 
Magnetic Point is activated, the rubber band line that provides you feedback about the entity you are 
creating is attracted to the snap point. This lets you see exactly where the point will be defined after you 
click the mouse.



You can set the radius of the snap aperture in the General property sheet of the Tools|Program Setup 
dialog.

Defining points with the status bar overrides the current snap mode and defines the point at precise 
coordinates that you specify.



Program Setup Dialog 



Local Snap
You can change snap modes in three different ways. You can use the menu, the Snap toolbar, or the local
menu. When you choose a mode from the menu or the Snap toolbar, the effect is the same: The snap 
mode changes until you reset it. The local menu is different. Use it for "one shot" mode changes, or local 
snap. This means that when you change snap modes in the local menu, the mode remains in effect until 
you define the next point. TotalCAD then switches back to the last mode you set in the main menu or 
toolbar, or defaults to No Snap mode.
This is a useful feature, because it lets you set the snap mode you use most frequently in the main menu 
or toolbar, then switch modes "on the fly" in the local menu when you are working in your drawing. Many 
users, for example, like to work with Snap to Grid as their default snap mode, so they set the mode to 
Snap to Grid in the main menu. While working in a drawing they may need to snap, for example, to the 
corner of a polygon. To do this, they change the snap mode temporarily to Vertex in the local menu and 
define a point on the polygon corner. TotalCAD then automatically switches back to Snap to Grid, the 
mode they most commonly use.



Coordinate Systems
Coordinate systems provide different methods of specifying the location of any point in the drawing using 
coordinates. TotalCAD has three coordinate system modes: absolute, relative, and polar. Both the 
absolute and the relative coordinate modes are in the Cartesian coordinate system.

Cartesian Coordinates 
Polar Coordinates 
Drawing with Coordinate Systems 



Cartesian Coordinates
A Cartesian coordinate specifies the distance of a point from the X or Y axis along a line that is parallel to 
the other axis. (When the drawing area is labeled with Cartesian coordinates it is a Cartesian plane.) You 
can specify the location of any point on the drawing using two coordinates, the first being the distance 
from the Y axis on a line parallel to the X axis, the second being the distance from X axis on a line parallel
to the Y axis. The intersection of the X and Y axes is the origin of the coordinate system; its coordinates 
are (0,0).
For example, to specify the location of a point that is 2 units measured horizontally from the Y axis and 3 
units measured vertically from the X axis, you would use the coordinates (2,3). For locations to the left of 
the Y axis or below the X axis you need to use negative values. To specify a location 2 units to the left of 
the Y axis and 2 units below the X axis, you would use the coordinates (-2,-2).

Absolute Coordinates 
Relative Coordinates 



Absolute Coordinates
When using absolute coordinates in TotalCAD, you specify the location of points relative to a location 
called the Absolute Origin, point (0,0) in the drawing plane. The Absolute Origin never changes location. 
By default, this point is in the lower-left corner of the page (although you can change the position of the 
page using in the Page Setup dialog).

See Also 



Page Setup Dialog 



Relative Coordinates
When you are working in relative coordinates in TotalCAD, you specify points on the drawing relative to a 
point that we´ll call the Relative Origin. This point moves in the drawing space as you work. Suppose, for 
example, that you are drawing a multiline. As you define each point of the multiline, the point you just 
defined becomes (0,0). This enables you to draw each segment of the multiline relative to the last 
segment.

See Also 



Program Setup Dialog, Relocate Origin 



Polar Coordinates
In the polar coordinate system, you define the location of a point by its absolute distance and angle from 
the Relative Origin. As in the relative coordinate system, the Relative Origin follows you as you work. 

See Also 



Relative Coordinates, Relocate Origin



Drawing with Coordinate Systems
TotalCAD lets you change coordinate systems at any time while you are working. If you are drawing the 
outer wall of a house, for example, you may want to start the first wall at an absolute location in the 
drawing space, so you would use absolute coordinates for the first point. Each successive wall, however, 
would be defined by its length and angle relative to the first wall, so you might use polar coordinates for 
the remaining points.

Tip



Advanced users can "force" TotalCAD to use a coordinate system other than the current system while 
working in the Coordinate Fields. If you precede a coordinate with a $ sign, it will be interpreted as an 
absolute coordinate; if you precede it with an @ sign it will be interpreted as a relative coordinate; if you 
precede it with a > sign it will be interpreted as a polar coordinate.



Setting Options
The Tools menu gives you access to dialog boxes that let you control TotalCAD program and drawing 
settings. These features let you:

Set program options that are saved with the application.
Set drawing options that are saved with the drawing or template.

Program and Drawing Setup 
Setting Up Scale and Units 
Setting Up the Grid
Setting Up Layers 



Program and Drawing Setup
The Tools menu contains two large dialogs, Program Setup and Drawing Setup. Changes that you make 
in the Program Setup are saved whenever you exit TotalCAD: The next time you start TotalCAD, the 
settings will be exactly the ones you selected. Changes that you make in the Drawing Setup dialog are 
saved with your drawing, and they will come back exactly as you left them the next time you open the 
drawing in which they were saved.
If you have a standard way of setting up a drawing and you want to use the settings in other drawings as 
well, you can save the Drawing Setup options in a template using the Edit|Save As dialog. You can make 
the template that you use most frequently the default template (the template that TotalCAD chooses if you
don´t specify a template) in the Create from Template dialog. You can also create multiple templates for 
different types of CAD tasks.

Tip 
See Also 



To save the setup of your Desktop controls (that is, the display and position of toolbars and other interface
controls), you must check the Save Desktop on Exit box in the General property sheet of the Program 
Setup dialog.



Create from Template Dialog, Drawing Setup Dialog, Program Setup Dialog, Save As Dialog 



Setting Up Scale and Units
TotalCAD has two distinct "spaces": world space and paper space. The units in world space apply to the 
real-world object that your drawing models. The units in paper space apply to the paper on which your 
drawing will be printed. Scale is the ratio of Paper units to World units. A scale of 3/16" = 1´, for example, 
means that an object 3/16" long in your drawing is modelling a real-world object that is one foot long.
Normally the coordinate system, the ruler, and the grid all show units in world space. You can switch to 
paper space by clicking the icon in the upper-left corner of the Ruler.
The Units and Scale property sheet gives you control over:

The type of units used in both paper space and world space.
The scale of your drawing.
The format and precision of the numbers in your drawing.

You can set these options either by choosing from one of TotalCAD´s standard settings, which correspond
to settings common to specific CAD disciplines, or you can specify custom settings.

Note 
See Also 



Dimensions always show World units, unless you manually override the dimension text.



Units and Scale Property Sheet 



Setting Up the Grid
The grid is a matrix, displayed as a pattern of dots, crosses, or lines, that divides your drawing 
geometrically into Cartesian coordinate locations. You can make the grid visible or invisible using the 
View|Grid command. You make the grid active or inactive by switching the Snap to Grid option on and off 
(using the Modes|Snaps|Snap to Grid menu option, the Snap toolbar, or the local menu). Note that you 
can snap to an invisible grid, and you can view an inactive grid: Whether the grid is visible has nothing to 
do with whether it is active.
TotalCAD has a major grid and a minor grid. The major grid shows larger divisions of your drawing space;
the minor grid shows finer divisions of the drawing space between the major divisions. Using the Grid 
property sheet of the Drawing Setup dialog, you can specify how far apart the grid points are spaced, how
many minor grid divisions there are between major grid points; and you can specify how frequently the 
grid points are visible. This lets you make only larger grid divisions are visible, but still enables you to 
snap to the invisible finer divisions. 

See Also 



Grid Property Sheet, Snap to Grid, View Grid 



Setting Up Layers
One of the most powerful ways you can organize a complex drawing is to create layers on which to place 
different categories of object. Layers are like acetate sheets used in traditional drafting.
Layers in TotalCAD can be visible or invisible, editable or not editable. These properties allow you to view 
only the drawing objects that are relevant to the current task, and to protect objects on the drawing from 
inadvertent change.
You can also distinguish layers of the drawing by giving them distinct colors and line styles. You can 
assign colors and styles to layers in the Layers property sheet. Objects on the layer will then have the 
color and line style assigned to the layer, provided the relevant properties of the object are set to By 
Layer. For example, if you want an object´s pen color to have the default color of the object´s layer:

1. Double-click on the the object with the Select tool to go to the object´s property sheets.
2. Bring the Pen property sheet to the front.
3. Set the Color property to By Layer.
4. Click <OK> to close the dialog.

See Also 



Layers Property Sheet 



Working with Multiple Documents
TotalCAD uses a multiple document interface. This means that the TotalCAD application window can 
contain multiple document windows, each of which contains a TotalCAD drawing. Whenever you open a 
TotalCAD drawing or start a new TotalCAD drawing, the drawing will appear in its own window, within the 
TotalCAD application window.
If you are familiar with other Microsoft Windows programs, you already know how to work with windows 
and minimized window icons. For instruction on basic techniques, such as moving, sizing, restoring, 
maximizing, and minimizing document windows under Windows 3.1 and Windows 95, see your Microsoft 
Windows documentation.
One big advantage of the multiple document interface is that it allows you to intuitively move and copy 
objects from one drawing to another.
Moving and Copying Objects between Drawings 



Moving and Copying Objects between Drawings
There are two basic methods for copying and moving objects between drawings: copy and paste (or cut 
and paste), and OLE drag and drop.
Copying/Cutting and Pasting Objects between Drawings 
Drag and Drop 

Note 
Tip 



In describing how to use these techniques, we´ll refer to the drawing from which you´ll be copying or 
moving objects as the source document; we´ll refer to the drawing into which you´ll be moving or copying 
the objects as the target document.



Before dragging and dropping objects, it´s a good idea to choose the Tile command from the Window 
menu. This will arrange the windows on the screen so that they are both completely visible, without 
overlap.



Copying/Cutting and Pasting Objects between Drawings
You can use the Windows clipboard to transfer objects between drawings, regardless of whether both of 
the drawings are open at the same time. Cut and paste allows you to remove an object from the source 
document at the same time that you paste the object into the target document.

1. Select the object or objects in the source document that you want to copy. You can use any of the 
select tools (available from the Select toolbar), or any of the Select commands from the Edit menu.

2. Choose Edit|Copy (<Ctrl>+<C>), or Edit|Cut (<Ctrl>+<X>) from the menu.    This places a copy of the 
objects on the Windows clipboard. (Edit|Cut will remove the selected objects from the source 
document.)

3. Activate the target document by clicking in its window, or by choosing it from the Window menu.
4. Choose Edit|Paste from the menu, or press <Ctrl>+<V>. The object will be pasted from the Windows 

clipboard into the target document.

The objects that you pasted from the clipboard will appear at the center of the target document window.



Drag and Drop
OLE drag and drop provides a simple and intuitive way to copy objects between drawings. You can drag 
objects from one drawing window into another, and you can drag objects stored in libraries and symbols 
from their library palette into another drawing.
Between Drawings 
Dragging and Dropping Library Objects between Drawings 



Between Drawings
To drag a drawing object from one drawing into another:

1. Select the object or objects that you want to drag into another drawing.
2. Place the cursor over the reference point of the selection. This is a movable handle located by default

at the center of the selection. You will know that the cursor is in the right place when it turns into a 
four-directional pointer.

3. Press and hold down the mouse button while dragging the selected objects into the window of the 
target document. An outline of the selection will follow the mouse cursor as you drag.

4. Release the mouse button to drop the selected objects. A copy of the sel-ected objects will appear at 
the point where you released the mouse button.

Warning 



If you drag an object by any point other than the reference point, you will only be able to drag the object 
within the window of the source document. Make sure that the mouse cursor is placed over the reference 
point of the selection before attempting to drag the selection into another window.



Dragging and Dropping Library Objects between Drawings
You can also drag and drop objects from a drawing´s libraries into another document. Moving a symbol to
another drawing accomplishes two things: It inserts the symbol into the target drawing, and it places the 
symbol itself into the corresponding library of the target document.

1. Open the symbol palette using View|Symbol.
2. Place the mouse cursor over the symbol in the palette that you want to copy, then hold down the 

mouse button while you drag the symbol into the target document window.
3. Release the mouse button. The symbol will appear in the target document at the place where you 

released the mouse button. The symbol will also appear in the target document´s symbol palette.

Note 



After you have moved the object, the target document becomes the active window. Notice that the symbol
palette will change, displaying the contents of the target document´s symbol library.



Paper units are the unit of measure for the paper, and for the drawing objects on the paper at their printed
size.



World Units are the units of measure for the "real world" objects that your drawing objects represent.





Command Reference

File Menu and Dialogs

Edit Menu and Tools

View Menu and Tools

Insert Menu and Tools 

Format Menu and Tools 

Modify Menu and Tools

Modes Menu and Tools

Tools Menu and Dialogs

Windows Menu 



File Menu and Dialogs
New 
Start a new TotalCAD drawing.
Open Dialog 
Open a drawing in one of several file formats.
Close 
Close the current drawing.
Save 
Save the current drawing to disk.
Save As Dialog 
Save the current drawing under a new name.
Save All 
Save all open drawings.
Libraries 
Bring up the Symbol Libraries property sheet of the Drawing Setup dialog.
Summary Info Dialog 
View or edit information about the current drawing.
Page Setup Dialog 
Choose options for printing your drawing.
Print Dialog 
Print the current drawing.
Send 
Send current drawing over network using Microsoft Mail.
Recent File List 
Re-open one of the four most recently used files. 
Exit 
Close all open drawings and exit TotalCAD.



New
Menu: File|New Hotkey: <Ctrl>+<N> Toolbar: Standard

Use the New command to start a new TotalCAD drawing.
Create from Template Dialog 



Create from Template Dialog
Templates are a special type of drawing file that provides a basis for a new drawing. Templates preserve 
all of the settings that are saved with the drawing, such as unit and scale options, angle conventions, grid 
settings, and colors, as well as symbol libraries. If the Prompt for Template Name option in the General 
property sheet of the Program Setup dialog is checked when you choose the New command, then the 
Create from Template dialog will be displayed. 
When the dialog opens, it will display the templates that are stored in the current TotalCAD Template 
folder. Click on a template then click OK to use the template as a basis for your drawing. TotalCAD will 
then run a wizard that will assist you in making additional choices based on the template you have 
chosen.

 The Open a Template dialog contains these additional controls:

Don´t Ask Again. Check this option if you want to bypass when you start a new drawing. 
Set Default. Click this button if you want the template you are now opening to become the default 

template (that is, the template that will be used if no other template is chosen).
Show Preview. Check this box if you want TotalCAD to display a preview of the template in the 

Preview box.
Description. This area displays information about the currently selected template.

Tip 
Note 
See Also 



You can change the default template directory using the File Locations property sheet of the Program 
Setup dialog.

If you create a single template that you want to use most of the time, check both the Don´t Ask Again and 
Use as Default options, then open the template. The new template will become the default, and the dialog
will no longer be displayed when you start a new drawing.



If you choose Don´t Ask Again in the dialog box, you can reverse this setting in the General property 
sheet of the Program Setup dialog. Choose Tools|Program Setup and check the Prompt for Template 
Name check box.



Program Setup Dialog, Save As Dialog 



Open Dialog
Menu: File|Open Hotkey: <Ctrl>+<O> Toolbar: Standard

The Open command displays the Open dialog, which allows you to open an existing TotalCAD drawing, or
a CAD drawing in any of several different standard formats. The appearance and features of the Open 
dialog differ significantly in Windows 3.1 and Windows 95.
This is a variation of the Windows Open dialog, in which you use standard Windows navigation to choose 
a template. To open a drawing:

1. Use standard Windows controls to navigate to the directory where the file is located.
2. Use the Files of Type control to choose the file types to display in the File Name list box. If you do 

nothing with this control, then only standard TotalCAD drawing files (.TCW) will be displayed.
3. Select the file that you want to open, then click Open (or simply double-click on the file you want to 

open). In Windows 3.1, click OK.

The Open dialog also provides the following controls:

Read Only. Check this option if you wish to view a file while making sure that you don´t 
inadvertently change it.

Description. This area displays text saved in the Subject field of the Summary Info dialog. You 
can place information in this field to help you identify and categorize your drawings.

Show Preview. Check this option to display a thumbnail of the drawing you have selected in the 
preview area of the dialog.

See Also 



Save As Dialog, Supported File Types 



Close
Menu: File|Close

The Close command closes the current file. If the file has been changed since it was last saved, TotalCAD
will ask you whether you want to save the file before closing.

See Also 



Close All 



Save
Menu: File|Save      Hotkey: <Ctrl>+<S> Toolbar: Standard

The Save command saves the current drawing to disk, using the directory and file name in which the file 
was previously saved. If this is the first time you have saved the file, this command will display the Save 
As dialog, prompting you for a name and location for the file.

Tip 
See Also 



To create a new copy of the file, use Save As.



Save As Dialog 



Save As Dialog
Menu: File|Save As

The Save As command displays the Save As dialog, which lets you save the current drawing using a file 
name and directory that you specify. The appearance and function of the Save As dialog differ 
significantly in Windows 3.1 and Windows 95.
This is a standard Windows Save dialog. To save a drawing in a specific directory and under a specific file
name:

1. Use the Drive and Directory controls to navigate to the directory where you want to save the file. 
2. Type a name for the file in the File Name text box.
3. Use the List Files of Type control to choose the type of file you want to save. If you do nothing with 

this control, then the file will be saved as a normal TotalCAD (.TCW) file. 
4. Select the file that you want to open, then press <Enter> to open the file.

Tip 
See Also 



Other graphics programs are most likely to be able to read your TotalCAD drawing if it is saved as a .DXF 
file. This has become the standard file exchange type for CAD drawings.



Save, Save All, Supported File Types 



Save All
Menu: File|Save All

The Save All command saves all open drawing files. If any of the files have not been previously saved, 
TotalCAD will prompt you for a directory and file name for those files.

See Also 



Save, Save As Dialog 



Libraries
Menu: File|Libraries Toolbar: Standard

The Libraries command brings up the Symbol Libraries property sheet of the Drawing Setup dialog.

See Also 



Symbol Libraries Property Sheet 



Summary Info Dialog
Menu: File|Summary Info

The Summary Info command opens the Summary Info dialog, in which you can record information that 
will be saved with your drawing file.
Use the text fields of the dialog box to record information about your drawing. The contents of these fields
could be useful in helping you to identify drawings or versions of drawings. It can also potentially be used 
by Windows file search utilities. The Save Preview Graphics with Drawing options let you choose the type
of graphic image that will be stored with the drawing, so that it can be previewed in TotalCAD and in other 
Windows programs:
None. Choose this option if you do not want preview graphics to be saved with your drawing.
Bitmap. Choose this option to store the preview graphic as a bitmap. This option is better suited to large 
files because it displays less detail.
Metafile. Choose this option to store the preview graphic as a Windows metafile. This option is better 
suited to small files because it displays more detail.



Page Setup Dialog
Menu: File|Page Setup

The Page Setup dialog provides a rich set of features that let you determine exactly how drawings will be 
printed. It consists of two property sheets: Paper and Layout.



Paper Property Sheet
The Paper property sheet lets you determine the size and orientation of the printer paper and the drawing 
sheet. The printer paper is the physical paper that goes through the printer; the drawing sheet is the area 
on which your drawing will be printed, which can span multiple sheets of printer paper. This property 
sheet also contains a variety of option controls and a function for viewing or setting the scale of the 
drawing.

Printer Paper 
Drawing Sheet Size 
Options (Printing Only) 
Page Layout Scale 
Keep Centered 

See Also 



Page Setup Dialog, Printer Paper and the Drawing Sheet, Layout Property Sheet 



Printer Paper
The Printer Paper control group lets you set the size and orientation of the printer paper. These are the 
same settings that you can control through the Print Setup dialog, so changes that you make in this dialog
will be reflected in Print Setup, and vice versa. To set the paper size and orientation:

1. Click in the Size list box and choose a standard paper size.
2. Choose either portrait or landscape orientation by clicking one of the option buttons. The icon to the 

left of the option buttons will change to reflect your choice.

Clicking the Setup button in this control group brings up the Print Setup dialog, in which you can choose 
another printer or access functions that directly control your printer.



Drawing Sheet Size
The Drawing Sheet Size control group lets you control the size and orientation of the area on which your 
drawing will be printed. This area can be imposed on a single sheet of printer paper, or it can span 
multiple sheets of printer paper. Its orientation can also be set separately from the orientation of the 
printer paper. For a description of how printer paper and drawing sheet size are related, see Printer Paper
and the Drawing Sheet. To set the size and orientation of the drawing sheet:

1. Click in the Size list box and choose a standard paper size, or type in a custom size using standard 
measurements (for example 2 ft x 2 ft).

2. Choose either portrait or landscape orientation by clicking one of the option buttons. The icon to the 
left of the option buttons will change to reflect your choice.

The page display on the right will change to reflect the relationship between printer paper and drawing 
sheet size and orientation.



Options (Printing Only)
The buttons in the Options (Printing Only) control group let you determine what elements are printed. 
These options affect only the printing of the drawing and are not reflected in the appearance of the 
drawing on screen.
Print margins. Check this button to print a border on the margin of the printer sheets. This is useful for 
framing the drawing if it is printed on a single sheet.
Print crop marks. Check this option button to print crop marks on the printer sheets. This is useful if you 
want to print across multiple printer sheets and crop the sheets so that they can be pasted against a 
backing.
Print grid. Check this option if you want to print grid marks. The grid will be printed if it is currently 
displayed.
Print construction. Check this option if you want to print constructions lines.



Page Layout Scale
The controls in the Scale control group let you scale the drawing so that it fits within the drawing sheet or 
choose a custom scale.
To scale the drawing so that it fits into the drawing sheet, click the Fit button. If the Keep Centered option 
is turned on, the drawing will be centered as it is fit into the drawing sheet.
To choose a custom scale, click in the list box and choose a pre-set scale, or type a scale directly into the 
list box in the form 1 in = 1 ft. When typing custom scales, you can use any measurement available in the
Units and Scale property sheet of the Drawing Setup dialog (available from the Tools menu). You can click
the Reset button at any time to return the scale that was set when you entered the Page Layout dialog.



Keep Centered
Check the Keep Centered option to keep the drawing centered over the drawing sheet.



Layout Property Sheet
The Layout property sheet gives you direct control of the number of rows (sheets of printer paper 
arranged vertically) and columns (sheets of printer paper arranged horizontally). It also has functions for 
setting the printer paper margins, setting the height and width of the drawing sheet in either World or 
Paper coordinates, and relocating the paper in the drawing area.

Margins 
Rows and Columns 
Origin 



Margins
The margins control group contains four text boxes in which you can specify the top, bottom, left, and 
right margins of the printer paper in Paper units. By default, the margins are displayed in units set in the 
Units and Scale property sheet, but you can enter values in other units as well.

Note 



You cannot set the margins of the drawing sheet independently of the margins of the printer paper.



Rows and Columns
The Rows and Columns controls let you set the number of rows and columns of printer sheet paper, for 
tiled printing. As you increase the number of rows and columns, the size of the drawing sheet—the area 
on which your drawing will be printed—increases correspondingly. The Paper Height and Paper Width 
controls let you directly set the height and width of the drawing sheet. As you increase these values, 
TotalCAD will automatically increase the number of rows and columns to accomodate the change in the 
drawing sheet size.



Origin
The Origin controls let you re-set the position of the lower-left corner of the page in the drawing area. To 
use the control, enter X (horizontal) and Y (vertical) absolute coordinates in the text boxes, using the 
current World units.

Tip 
See Also 



This feature is useful if you want to print a particular area of a large drawing by relocating the paper to the
area that you want to print.



Coordinate Systems, Units and Scale Property Sheet 



Print Dialog
Menu: File|Print Hotkey: <Ctrl>+<P> Toolbar: Standard

The Print dialog provides a set of functions which include printing a single view of a drawing, or printing 
specific sheets in a drawing that spans multiple sheets of printer paper.

Print Source 
Print Range 
Print Quality 
Copies 
Print Setup Dialog 

See Also 



Page Setup Dialog, Views of the Drawing Space 



Print Source
The Print Source control group lets you choose whether to print all of the drawing objects, or only those 
that are currently selected.

Note 



You can control the printing of other elements, such as crop marks, margins, and constructions, in the 
Paper property sheet of the Page Layout dialog.



Print Range
The Print Range control group provides options for setting a specific view of the drawing to print, and for 
selecting a range of pages when printing a drawing that spans multiple printed sheets.
All. Select this option if you want to print all of the current drawing. If you have chosen a Selection in the 
Print Source control group, only objects that are selected will be printed. (If your drawing spans multiple 
printer sheets, the total number of sheets will be shown in this option label.)
View. Select this option to print a single view of the drawing. You can print the current view by default, or 
click in the list box and choose any named view.
Range. Select this option to print a range of pages if the Page Layout dialog is set up to print multiple 
pages. Specify the first page to be printed in the left text box, and the last page to be printed in the right 
text box. TotalCAD counts the printer sheets starting in the lower-left corner from left to right, and from 
bottom to top.
Fit on 1 page. Check this box if you want to print everything on a single page. This option is compatible 
either with printing a view, or with printing the entire drawing. You can´t have this option checked and the 
Range option turned on at the same time.



Print Quality
The contents of this list box will vary, depending on settings available in your current printer. In some 
cases the list box may contain specific settings, such as 300 or 600 DPI (Dots Per Inch). In other cases, 
the list box may contain High, Medium, Low, and Draft settings. Higher quality print settings produce finer 
resolution; lower quality print settings print out more quickly.



Copies
Type the number of copies of the drawing that you want to print in the copies text box.



Print Setup Dialog
The Setup button brings up the Print Setup dialog. This is a Microsoft Windows dialog, and its 
appearance will vary depending on the version of Windows that you are running.
The Print Setup dialog enables you to choose a printer, if there are multiple printers available, as well as 
to set the paper size, paper source, and paper orientation. The contents of the dialog will vary, depending 
on the current printer.
Under Windows 3.1 the Options button will bring up a dialog through which you can control your printer. If 
you are running Windows 95, the Properties button brings up a set of property sheets through which you 
can control your printer.
For more information, see your Windows documentation and the documentation for your printer.



Send
Menu: File|Send

The Send command is a standard Microsoft Office function. If Microsoft Mail is installed on your system, 
or if you are running Windows 95 on a network, this command will open a new message containing the 
current document as an attachment. You can then send the document over your network via Microsoft 
Mail or Microsoft Exchange.



Recent File List
Below the Send command on the File menu, TotalCAD displays the four most recently opened drawings. 
These can be drawings that are currently open but not active, or they can be drawings that were recently 
saved, but which are not currently open.
Choosing a drawing from this list makes it the currently active drawing. If the drawing is already opened, 
TotalCAD will make it active; if the drawing is not opened, TotalCAD will open the drawing.

Warning 



If you rename a drawing or move it to another directory using File Manager or another utility, the file name
will remain in the recent file list, but TotalCAD will not be able to locate the file.



Exit
Menu: File|Exit Hotkey: <Ctrl>+<X>

Use the Exit command to close all open drawings and exit TotalCAD. TotalCAD will warn you about any 
files that have been changed since they were last saved, giving you an opportunity to save them.



Edit Menu and Tools
The following table summarizes the commands accessible from the Edit menu:

Undo 
Reverse previous action.
Redo 
Reverses the effect of the previous Undo command.
Cut 
Remove selected objects and place them on Windows clipboard.
Copy 
Copy selected objects to clipboard.
Paste 
Paste objects into drawing from clipboard.
Paste Special 
Paste objects from clipboard as data or as OLE objects.
Clear Commands 
Remove selection, all objects, a single construction line, or all construction lines from drawing.
Select Commands 
Activate the Select tool.
Copy Entities Tools 
Create multiple copies of objects along lines, around arcs, in two-dimensional arrays, and more.
Edit Links 
Make changes to linked OLE objects.
Edit Object 
Edit OLE object using its source application.



Undo
Menu: Edit|Undo Hotkey: <Ctrl>+<Z> Toolbar: Standard

The Undo command reverses the previous action, restoring your drawing to its state prior to your last 
editing or drawing command. The name of this command will change, depending on the specific action 
that it undoes.

See Also 



Redo 



Redo
Menu: Edit|Redo Hotkey: <Ctrl>+<A> Toolbar: Standard

The Redo command reverses the effects of an Undo command. The name of this command changes, 
depending on the specific action that it redoes.

See Also 



Undo 



Cut
Menu: Edit|Cut Hotkey: <Ctrl>+<X> Toolbar: Standard

The Cut commands removes any selected object or objects from your drawing and places them in the 
clipboard. From the clipboard you can paste them into TotalCAD drawings or into other Windows 
applications using the Paste or Paste Special commands.

See Also 



Copy, Paste, Paste Special, Copy Entities Tools 



Copy
Menu: Edit|Copy Hotkey: <Ctrl>+<C> Toolbar: Standard

The Copy commands copies any selected object or objects from your drawing and places them in the 
clipboard. From the clipboard you can paste them into TotalCAD drawings or into other Windows 
applications using the Paste or Paste Special commands.

See Also 



Cut, Paste, Paste Special, Copy Entities Tools



Paste
Menu: Edit|Paste Hotkey: <Ctrl>+<V> Toolbar: Standard

The Paste command pastes into your drawing any data that has been copied or cut into the clipboard. 
You can paste TotalCAD drawing objects, as well as text, bitmap, or Windows metafile data from that has 
been placed in the clipboard in other programs.



Paste Special
Menu: Edit|Paste Special

The Paste Special command displays the Paste Special dialog.
The Paste Special dialog lets you choose how to paste into your drawing an object that was previously 
cut or copied to the clipboard. The object on the clipboard can be from TotalCAD, or it can come from 
another application. The options available in the Paste Special dialog depend on the type of object in the 
clipboard, and on the program in which the object was created (the source application). 
When you open the Paste Special dialog, you will see a number of choices in the As list box. For 
example, if there is a document on the clipboard created in Microsoft Word, the As text box will contain 
the following options:

Word Document
Picture (Metafile)
Text

If you choose Word Document, the data in the clipboard will be inserted into your drawing as an OLE 
object, which you can edit within TotalCAD using Microsoft Word features. If you choose Picture, the data 
will be inserted as an image. If you choose Text, the data will be inserted as text, creating a TotalCAD text
object, which you can treat exactly like text created with the TotalCAD Text tool.
If you choose to insert a clipboard object into your drawing as an OLE object, you have a choice of either 
linking or embedding the object. If you click the Paste option button, you will embed the OLE object in 
your drawing. This means that the drawing will have its own independent copy of the OLE object: Any 
changes you make to this object will not affect the file on which it was based. If you activate the Paste 
Link option button, the OLE object will be linked to the file on which it was based. This means that any 
changes made to the file will be reflected in the OLE object, and any changes made to the OLE object will
also affect the file.
If you check the Display as Icon check box, the OLE object will appear in your drawing as an icon. (When 
this box is checked, you can click on the Change Icon button to select another icon.)

Note 
Tip 
See Also 



There are only two types of data that can be inserted into TotalCAD as an editable TotalCAD drawing 
object. These are text data, which is inserted as a TotalCAD text object, and actual TotalCAD drawing 
entities that have been copied onto the clipboard from TotalCAD drawings. All other clipboard objects will 
be pasted either as OLE objects, or as pictures (either bitmaps or metafiles).



If you plan to insert multiple copies of a single object into your drawing, you can keep your drawing file 
from growing too large by linking the objects rather than embedding them. This is possible because each 
linked object is simply a reference to the file on which it is based. If you link the object multiple times, 
each copy of the object shares the same source of data.



Edit Links, Edit Object, Insert Object, Insert Picture, Paste 



Clear Commands
Menu: Edit|Clear

The Clear commands let you remove graphic objects and other objects from a drawing. The Edit|Clear 
menu item opens a submenu containing four options: 

Clear Selection 
Clear all objects that are currently selected.
Clear All 
Clear all objects in the drawing.
Clear Construction 
Activate the clear construction tool, with which you can delete individual construction lines.
Clear All Constructions 
Clear all construction lines in the drawing.
You can reverse any clear with the Undo command.



Clear Selection
Menu: Edit|Clear|Selection Hotkey: <Del>

Use the Clear Selection command to delete any graphics or other objects that have been selected. If no 
objects have been selected, then this command is unavailable.

See Also 



Select Commands, Cut 



Clear All
Menu: Edit|Clear|All

Use the Clear All command to delete everything on the drawing space and begin a new drawing.



Clear Construction
Menu: Edit|Clear|Construction

The Clear Construction command activates the Clear Construction tool, with which you can delete 
individual construction lines. To use it, first activate the tool, then click on any construction that you wish to
delete. Choose Cancel from the local menu or switch to another tool when you are finished.



Clear All Constructions
Menu: Edit|Clear|All Constructions

Use the Clear All Constructions command to delete all construction lines from your drawing.



Select Commands
Menu: Edit|Select

If you want to perform an editing action on an object or a set of objects in your drawing, you generally 
need to select the objects first. When you select objects, they change to a pale magenta color and appear
inside a frame with handles. 

Select 
Activate the selection tool.
Select All 
Select all objects in the drawing.
Select By Commands 
Access a submenu that lets you select objects that by their type, layer, attribute, or with a freeform 
"fence."



Select
Menu: Edit|Select Toolbar: Insert Entity

The Select tool lets you select and deselect objects in the drawing area using the mouse. You can select 
a graphic entity (as well as an OLE object or bitmap) by clicking on it, or you can select objects using a 
selection rectangle. Once objects are selected, you can deselect everything by clicking the mouse 
anywhere in the drawing area outside of the selection rectangle.You can also deselect everything by 
pressing <Esc> or choosing Cancel from the Local menu. 
Selection by Clicking 
Selection within Rectangle 

Warning 



If you try to deselect everything by clicking inside the selection rectangle, nothing will happen: You need 
to click outside the selection rectangle. Normally this is not a problem, but it might be confusing if you are 
zoomed in so that your view is inside the selection rectangle. If you find yourself in this situation just press
<Esc> or choose Cancel from the Local menu to deselect everything.



Selection by Clicking
To select any object, simply activate the Select tool, then click on the object.
To select a series of objects, adding them one at a time to the selection, hold down the <Shift> key while 
clicking on each object in succession. To deselelect multiple objects one at a time, hold down the <Shift> 
key and click on each selected object in succession.



Selection within Rectangle
The selection rectangle gives you different results, depending on whether Open Window mode is on or 
off. To change this option, click the right mouse button in the drawing area to open the Local menu, then 
choose Open Window mode. If the menu item has a check next to it, the option is on; otherwise the option
is off.
To use the selection rectangle with the Open Window option on, hold the left mouse button down and 
move the cursor, creating a rectangle over an area that contains any part of the objects that you want to 
select, then release the mouse button. If any portion of an object is inside the rectangle, the entire object 
will be selected.
To use the selection rectangle with the Open Window option off, hold the left mouse button down and 
move the cursor, creating a rectangle over an area that contains the objects that you want to select in 
their entirety, then release the mouse button. If any portion of an object is outside the rectangle, it will not 
be selected.



Select All
Menu: Edit|Select All

Use the Select All command to select all objects that are currently on the drawing.



Select By Commands
Menu: Edit|Select By

Select By opens a submenu of special selection commands:

Select by Entity Type Dialog 
Brings up a dialog that lets you select objects by their type.
Brings up a dialog that lets you select all the objects on a layer or subset of layers.
Select by Fence 
Activates a tool that lets you select a set of objects by drawing a polygonal "fence" around them.



Select by Entity Type Dialog
Menu: Edit|Select By|Entity Type

The Select By Entity Type command opens a dialog that lets you select all the objects in the drawing that 
belong to specific types. 
You can use this dialog to select objects that belong to any type or combination of types, using common 
Windows list box selection techniques. For example, if you wish to select all linear and angular 
dimensions in your drawing, you would hold down the <Ctrl> key while clicking on Linear Dimension and 
Angular Dimension, highlighting both items. If you wish to add objects of these types to a current 
selection, place a check in the Add to the Current Selection check box. If this box is not checked, then any
currently selected items will be deselected as the new objects are selected.



Select by Fence
Menu: Edit|Select By|Fence

The Select by Fence tool lets you select a set of objects by drawing a polygonal "fence" around them. 

1. Activate the Select by Fence tool.
2. Define a series of points by clicking and moving the mouse, using any snap mode. Each point you 

define will become a new vertex (corner) of an irregular polygon fence. Make sure that any objects 
you wish to select are contained within the fence.

3. Right-click in the drawing area and choose Finish to complete the fence and select the objects.

Note 
See Also 



Like the Select tool, the Select by Fence tool responds to the state of the Open Window Mode option. You
can change in the Local menu after right-clicking in the drawing area. If Open Window Mode is on, then 
any objects that are partially contained within the fence will be selected. If Open Window Mode is off, then
only objects that are entirely contained within the fence will be selected.



Selection within Rectangle 



Copy Entities Tools

Menu: Edit|Copy Entities Toolbar: Copy

TotalCAD´s tools for copying entities enable you to make single or multiple copies of entities, and at the 
same time precisely control the placement of the copies.

Linear Copy 
Make copies along a line, specifying the interval between each copy.
Radial Copy 
Arrange copies in an arc, specifying the angular distance between each copy and the rotation of each 
copy relative to the previous copy.
Array Copy 
Copy entities in a two-dimensional array, specifying the distance between each entity.
Fit Linear Copy 
Make copies along a line, specifying the total distance into which all the copies fit.
Fit Radial Copy 
Arrange copies in an arc, specifying the total angular distance in which all the copies must fit, and the 
rotation of each copy relative to the previous copy.
Fit Array Copy 
Copy entities in a two-dimensional array, specifying the dimension of the rectangle into which they fit.
Mirror Copy 
Create a mirror image of an object on the opposite side of a line that you specify.
Vector Copy 
Make a single copy of an object, specifing the angle and distance of the copy from the original.

Tip 
Note 



When you are using the Copy Entities tools, you may often find it necessary to switch back and forth 
between the Edit Bar and the drawing area. One reason for this is to use the Edit Bar to specify the 
number of copies that you want to make. Remember that you can move to the Edit Bar without moving 
the mouse by pressing <Tab>. You can return to the drawing space from the Edit Bar, with the cursor in 
exactly the position you left it, by either clicking once in the drawing area, or by pressing <Ctrl>+<D>.



If you do not change the rotation or scale of the copies that you create, TotalCAD will include the original 
copy in the number of sets. If you do rotate or scale the copies, the original will not be included in the 
number of sets. For example, if you specify a new scale or rotation and specify 20 sets, TotalCAD will 
make 20 copies of the original. If you do not specify a new scale or rotation, TotalCAD will make 19 
copies, using the original as the 20th copy.



Linear Copy
Menu: Edit|Copy Entities|Linear Toolbar: Copy

Use Linear Copy to create one or more copies of an object along a straight line, specifying the distance 
between each copy, the angle of the line along which the copies will be made, and the number of copies.

1. Select the object or objects that you want to copy.
2. Choose the Linear Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it
4. Type these values into the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values into XStep and YStep to specify the horizontal and vertical distance of each copy 
from the previous copy.

Type the number of copies you want to make into Sets. 
5. Press <Enter> to create the copies.

Note 



You can also specify the XStep and YStep values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of sets, as well as values for 
rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to accept the 
current values.



Radial Copy
Menu: Edit|Copy Entities|Radial Toolbar: Copy

Use Radial Copy to arrange one or more copies of an object in an arc, specifying the angular distance 
from one copy to the next.

1. Select the object or objects that you want to copy.
2. Choose the Radial Copy tool.
3. Define a point for the centerpoint of the arc around which you want to arrange the copies. The radius 

of the arc is the distance from this point to the reference point of the selection. This arc is visible as a 
rubber-band circle in the drawing area.

4. Press <Tab> or click in Edit Bar to activate it, then enter the following values into the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type the number of copies you want to make into Sets. If you have scaled or rotated the copies, 
the original will not be included in the number of sets. TotalCAD will choose appropriate default values for 
Angle and +Rot based on the number of sets you enter.

Optionally type a value into the Angle text box to specify the angular distance between the copies.
Optionally type a value into +Rot to specify the rotation of each copy relative to the previous copy.

5. Press <Enter> to create the copies.

Notes 



You can also specify Angle by defining a point within the rubber band circle in the drawing area using the 
mouse. However, the number of sets, the +Rot rotation value, as well as values for rotating and resizing 
the copies, must be specified in the Edit Bar first, unless you want to accept the current values.

The Sets, Angle, and +Rot values are interdependent. Changing the number of sets will change the 
values in Angle and +Rot; changing Angle will affect +Rot. These default ratios are designed to give you 
an elegant, symmetrical radial copy. Once you have entered values in these fields, however, the 
automatic interdependency is switched off, and you can enter any values you like.



Array Copy
Menu: Edit|Copy Entities|Array Toolbar: Copy

Use Array Copy to arrange copies of selected objects into a two-dimensional array (rows and columns). 
You specify the horizontal and vertical distance between the copies.

1. Select the object or objects that you want to copy.
2. Choose the Array Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it, then enter the following values in the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values in the XStep and YStep fields to specify the horizontal and vertical distance between 
the centerpoints of the copies.

Type values into the Rows and Columns fields to specify the number of rows and columns in the 
array.
4. Press <Enter> to create the copies.

Note 



You can also specify the XStep and YStep values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of rows and columns, as well 
as values for rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to 
accept the current values.



Fit Linear Copy
Menu: Edit|Copy Entities|Fit Linear Toolbar: Copy

Use Linear Fit Copy to create one or more copies of an object along a straight line, specifying a length 
into which all the copies will fit.

1. Select the object or objects that you want to copy.
2. Choose the Linear Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it, then enter these values into the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values into XSize and YSize to specify the length of the line onto which all the copies will fit. 
The copies will be placed on this line an equal distance apart.

Type the number of copies you want to make into the Sets field. If you have scaled or rotated the 
copies, the original will be included in the number of sets.
4. Press <Enter> or create the copies.

Note 



You can also specify the XSize and YSize values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of sets, as well as values for 
rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to accept the 
current values.



Fit Radial Copy
Menu: Edit|Copy Entities|Fit Radial Toolbar: Copy

1. Select the object or objects that you want to copy.
2. Choose the Radial Fit Copy tool.
3. Define a point for the centerpoint of the arc around which you want to arrange the copies. The radius 

of the arc is the distance from this point to the reference point of the selection. This arc is visible as a 
rubber-band circle in the drawing area.

4. Press <Tab> or click in Edit Bar to activate it, then type the following values in the Edit Bar fields:

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type the number of copies you want to make into the Sets field. 
Optionally type a value into the Angle text box to specify the angular distance into which all the 

copies will fit.
Optionally type a value into the +Rot field to specify the rotation of each copy relative to the 

previous copy. 
5. Press <Enter> or click the mouse in the drawing area to create the copies.

TotalCAD will make radial copies in a counterclockwise direction, starting with the original object and 
ending at the angle set in step 4. The copy direction will be counterclockwise regardless of the direction 
setting in the Angle property sheet of the Drawing Setup dialog.

Notes 



You can also specify Angle by defining a point within the rubber band circle in the drawing area using the 
mouse. However, the number of sets, the +Rot rotation value, as well as values for rotating and resizing 
the copies, must be specified in the Edit Bar first, unless you want to accept the current values.

The Sets, Angle, and +Rot values are interdependent. Changing the number of sets will change the 
values in Angle and +Rot; and changing Angle will affect +Rot. These default ratios are designed to give 
you an elegant, symmetrical radial copy. Once you have entered values in these fields, however, the 
automatic interdependency is switched off, and you can enter values into fields without affecting values in 
the related fields.



Fit Array Copy
Menu: Edit|Copy Entities|Fit Array Toolbar: Copy

Use Fit Array Copy to arrange copies of selected objects into a two-dimensional array (rows and 
columns). The reference points of the outermost objects in the array will align to the edges of a rectangle 
that you define..

1. Select the object or objects that you want to copy.
2. Choose the Fit Array Copy tool.
3. Press <Tab> or click in the Edit Bar to activate it.

Optionally type values into XScale, YScale, and Rotation if you want to scale and rotate at the 
same time as you copy.

Type values in the XSize and YSize fields to specify the horizontal and vertical extents of the 
rectangle into which all the copies will fit.

Type values into the Rows and Columns fields to specify the number of rows and columns in the 
array.
4. Press <Enter> to create the copies.

Note 



You can also specify the XSize and YSize values by defining a point relative to the selection in the 
drawing area using the mouse or Coordinate Fields. However, the number of rows and columns, as well 
as values for rotating and resizing the copies, must be specified in the Edit Bar first, unless you want to 
accept the current values.



Mirror Copy
Menu: Edit|Copy Entities|Mirror Toolbar: Copy

Use Mirror Copy to create a mirror image of an object on the opposite side of a line that you specify.

1. Select the object or objects that you want to copy. If the Edit Bar is not visible, display it using View|
Toolbars.

2. Choose the Mirror Copy tool.
3. Click in the drawing area or use the Coordinate Fields to define a point in the drawing area through 

which a mirror construction line will pass.
4. Enter the angle of the mirror construction line in the Angle field, and press <Enter>. Alternatively, you 

can use the Coordinate Fields or click in the drawing area to define a second point through which the 
mirror construction line will pass.

TotalCAD will draw a mirror image of the selected objects at the same distance from the line on the 
opposite side.



Vector Copy
Menu: Edit|Copy Entities|Vector Toolbar: Copy

Use Vector Copy to place a copy of an object at a specified angle and distance from the reference point of
the original.

1. Select the object or objects that you want to copy.
2. Choose the Vector Copy tool.
3. Use the Coordinate Fields or click in the drawing area to define two points of a virtual line to specify 

the angle and distance of the copy from the original. This line appears in the drawing area as an 
arrow.

Alternatively, you can define enter the angle and distance of the vector directly in the Edit Bar and press 
<Enter>.



Edit Links
Menu: Edit|Links

Edit Links displays a dialog in which you can make changes to any linked OLE objects in the current 
drawing. OLE objects are created in other Windows applications and inserted into your TotalCAD drawing 
with the Insert Object command. You can edit an OLE object within TotalCAD using the Windows 
application in which the object was created (the source application). For example, you can insert a 
Windows Paintbrush object into your drawing and edit it within TotalCAD using the Windows Paintbrush 
tools.
A linked object is one that retains its link to the file on which it is based. Changes to the OLE object affect 
the file, and changes to the file affect the object. These changes take place when the OLE object is 
updated. You can set each linked object so that the update happens automatically, or so that the update 
must be done manually.
The Links list box contains all the links in the active drawing. The changes that you make in the Edit Links
dialog affect any links that are highlighted in the list. You can highlight multiple links by holding down the 
<Shift> or <Ctrl> key and clicking in the list. The Links column in the list gives you the name and path of 
the file to which the OLE object is linked. The Type column tells you the name of the source application. 
The Update column tells you whether the link is set to be updated automatically or manually.

Update Option. These option buttons enable you set whether the selected links are updated 
automatically or manually.

Update Now. This button updates the current link immediately. This is how you update a link if it is
set to be manually updated.

Open Source. This button opens the source file in the application that created it. This enables you
to compare the linked object to the source file, and it allows you to edit the file in the source application.

Change Source. This button opens a dialog that lets you choose a new source for the linked OLE 
object. Once the OLE object is linked to the new file, its contents will change to match the new file.

Break Link. This button terminates the link between the OLE object and its source file. Once the 
link is broken, the OLE object is treated as an embedded object. It is still an OLE object, but changes to it 
no longer affect the source file, and changes to the source file no longer can affect the object. Breaking 
the link also affects the size (in bytes) of your drawing, since the embedded object contains its own copy 
of the data in the object, while the linked object contains only a reference to the object.

See Also 



Edit Object, Embedded and Linked OLE Objects, Insert Object 



Edit Object
Menu: Edit|Objects

Edit Object enables you to edit a selected OLE object in the object´s source application. 

1. Select an OLE object in your drawing. This object may appear as a document or a bitmap, or it may 
appear as an icon, depending on the options you chose when you inserted the OLE object.

2. Choose Edit|Objects from the menu, or simply double-click on the object.

If open editing is available, you will be given two choices in a submenu under Edit|Objects. Choose Edit|
Objects|Edit for in-place editing. Choose Edit|Objects|Open for open editing in the source application.

Note 
See Also 



Other names can appear in place of Object on the Edit menu, depending on the OLE source application. 
If you select a Microsoft Word object, for example, the name on the menu will change to Document 
Object.



Edit Object, Embedded and Linked OLE Objects, Insert Object 



View Menu and Tools
Redraw 
Manually refresh a drawing that has changed.
Zoom Commands 
Access tools and commands for moving your view closer to or further away from an area of the drawing.
Pan Commands 
Pick particular points in the drawing and move them to specific locations on the screen.
Previous View 
Return to the previous view of the drawing.
View Grid 
Display or hide the grid.
View Aperture 
Change cursor to a circle that represents the snap aperture.
View Crosshairs 
Display crosshairs in place of mouse cursor.
View Rulers 
Display or hide the rulers.
View Status Bar
Display or hide the Status Bar.
View Edit Bar
Display or hide the Edit Bar.
View Symbol Library 
Display or hide the Symbol Library palette.
View Toolbars 
Display the Desktop property sheet in which you can display or hide toolbars.
View Selection Info 
Display or hide the information about the currently selected object.



Redraw
Menu: View|Redraw Hotkey: <F5> Toolbar: View

In most cases TotalCAD will automatically redraw your screen whenever the drawing changes. 
Occasionally, however, you may find that the screen is not completely "cleaned up" after a drawing or 
editing operation. If this happens, you can manually redraw the screen using the Redraw command.



Zoom Commands

Menu: View|Zoom Toolbar: View

The Zoom commands and tools let you "zoom" into your drawing to view detail areas close up, or pull 
back to view larger areas of your drawing. The following table summarizes the Zoom commands and 
tools:

Zoom In 
Move one step into the drawing.
Zoom Out 
Move one step further from the drawing.
Zoom Window 
Activate the Zoom Window tool, with which you can select an area to view.
View Extents 
Zoom to a view that contains all of the objects in the drawing.
Full View 
Return to "starting" view of the drawing.
View Printed Size 
View the drawing at the size it will be when printed.



Zoom In
Menu: View|Zoom|Zoom In Hotkey: <Gray +> Toolbar: View

The Zoom In command magnifies the current view of the screen. The scale of magnification is determined
by the zoom factor, which by default is equal to two. You can reset the zoom factor in the General 
property sheet of the Tools|Program Setup dialog.

Note 
See Also 



If you zoom in using the menu command, you will zoom in on an area centered on the current view. If you 
zoom in using the <Gray +> key, you will zoom in to an area defined so that the mouse cursor is kept in 
the same relative position within the view rectangle.



Program Setup Dialog 



Zoom Out
Menu: View|Zoom|Zoom Out Hotkey: <Gray -> Toolbar: View

The Zoom Out command backs away from the area where the mouse cursor is currently located. The 
amount that the view pulls back in each step is determined by the zoom factor, which by default is equal 
to two. You can reset the zoom factor in the General property sheet of the Tools|Program Options dialog.

Note 
See Also 



If you zoom out using the menu command, you will zoom out to an area centered on the current view. If 
you zoom out using the <Gray +> key, you will zoom out to an area defined so that the mouse cursor is 
kept in the same relative position within the view rectangle.



Program Setup Dialog 



Zoom Window
Menu: View|Zoom|Zoom Window Hotkey: <Ctrl>+<Home>
Toolbar: View

The Zoom Window tool enables you select a rectangle area of the screen and zoom in to a view of the 
that area. To use this tool:

1. Activate the Zoom Window tool. 
2. Click to specify one corner of the zoom window.
3. Move the mouse cursor to the point where you want to place the diagonally opposite corner of the 

zoom window, so that the zoom window encompass the area that you want to view.
4. Click to specify the opposite corner of the window. TotalCAD will immediately zoom in on the area that

the zoom window encloses.

You can also drag the mouse to create the zoom window, in which case your view will zoom in 
immediately after you release the mouse button.

Note 



Because the dimensions of the zoom rectangle will probably not be exactly proportional to the screen, 
TotalCAD chooses the closest view based on the zoom rectangle you define.



View Extents
Menu: View|Zoom|Extents Hotkey: <Ctrl>+<Backspace> Toolbar: View

The View Extents command zooms to a view of the smallest area of your drawing that completely 
contains all of the objects in your drawing. This is the same as the area enclosed by the selection 
rectangle if you select all the objects in the drawing.



Full View
Menu: View|Zoom|Full View Hotkey: <Shift>+<Backspace> Toolbar: View

The Full View command returns you to the default view at which you began your drawing. 



View Printed Size
Menu: View|Zoom|Printed Size Toolbar: View

The View Printed Size command takes you to a view of the drawing at approximately the size it will be 
when printed. In this view one inch of screen space is approximately equal to one inch on paper.

Note 



The exact correspondence of screen space to paper space will vary, depending on your graphics display 
and screen resolution.



Pan Commands
The Pan commands and tools move your view across the drawing area, in any direction.

Pan to Point 
Choose a point and scroll the drawing so that the point is at the center of the screen.
Vector Pan 
Choose a point and a destination and scroll the drawing so that the point moves to the destination.



Pan to Point
Menu: View|Pan to Point Hotkey: <Ctrl>+<End>

Use the Pan to Point feature to choose a point on the screen and scroll the drawing so that the point you 
chose moves to the center of the screen. This feature is available from the menu as a tool and from the 
keyboard as a command. To use the menu version of the feature:

1. Choose View|Pan to Point to activate the Pan to Point tool. The cursor will change to an arrow 
pointing to the center of a small crosshair icon.

2. Click on any point in the drawing. This point will move to the center of the screen. 

To use the keyboard Pan to Point command, place the cursor at a point on the screen and press 
<Ctrl>+<End>. The point at the location of the cursor will scroll to the center of the screen.



Vector Pan
Menu: View|Vector Pan

Use the Vector Pan tool to choose a point and a destination, and scroll the drawing so that the point 
moves to the destination. To use Vector Pan:

1. Activate the Vector Pan tool.
2. Click at any location in the drawing area. This specifies the location of the point that you would like to 

move (the base point).
3. Move the cursor to the destination point and click. The drawing will scroll so that the base point 

moves to this destination.



Previous View
Menu: View|Previous View Toolbar: View

The Previous View command returns you to the previous view of the drawing. 

Tip 



This command is particularly useful if you want to switch back and forth between two views.



View Grid
Menu: View|Grid

The View Grid command is a toggle that displays and hides the grid. The grid is a pattern of dots, 
crosses, or lines that divides your drawing space geometrically into Cartesian or polar coordinate 
locations. You can define points at positions on the grid using the Snap to Grid snap mode. You can set 
the spacing, type, and display parameters of the grid in the Tools|Grid property sheet.

Note 
See Also 



Making the grid visible or invisible does not affect whether the grid is active. The grid can be visible and 
inactive, and it can be invisible and active. To control whether the grid is active, use the Snap to Grid 
command from the Modes|Snaps menu, the Snaps toolbar, or the Local menu.



Coordinate Systems, Grid Property Sheet, Snap to Grid 



View Aperture
Menu: View|Aperture

The View Aperture command is a toggle that displays the snap aperture. The snap aperture is the circular
area in which an entity needs to be located in order to snap to a point located on the entity, or in which a 
grid point or graphic point must be located in order to snap to that point.
You can have View Aperture and View Crosshairs turned on simultaneously.

Tip 
See Also 



You can set the radius of the snap aperture in the Tools|Program Setup dialog.



Snap Aperture, View Crosshairs 



View Crosshairs
Menu: View|Crosshairs

The View Crosshairs command is a toggle that changes the cursor to crosshairs and back to a normal 
cursor. The crosshair extension lines let you see more clearly how the current location of the cursor 
corresponds to positions on the ruler and on graphic objects.

See Also 



Program Setup Dialog, View Aperture 



View Rulers
Menu: View|Rulers

The View Rulers command is a toggle that displays and hides the Rulers. Rulers are displayed along the 
top and left edges of the screen and show the measurements of your drawing in Page or World units. You
can change between Page and World units by clicking the Units button located near the upper-left corner 
of the drawing area at the intersection of the horizontal and vertical rulers.
You can change the units and scale of the drawing in the Units and Scale property sheet of the Tools|
Drawing Setup dialog. The ruler will change to reflect the current scale and display.

See Also 



Drawing Setup Dialog 



View Status Bar
Menu: View|Status Bar

The View Status Bar command is a toggle that displays and hides the Status Bar. The Status Bar is 
displayed along the bottom of your screen. It contains a brief status message, the Coordinate Fields, and 
a zoom percentage box on its right side, which displays the zoom percentage of your current view.



View Edit Bar
Menu: View|Edit Bar

The View Edit Bar command is a toggle that displays and hides the Edit Bar. The Edit Bar is a control that
enables you to create and edit entities by entering distances, angles, and other data directly into the Edit 
Bar fields. You can drag the Edit Bar and place it anywhere in the tool area under the menubar. You can 
also place the Edit Bar over the drawing space, where it will float over the drawing as a palette.

Tip 
Note 
See Also 



Although you can draw in TotalCAD using only the mouse, many drawing and editing tools are more 
accurate if you work in the Edit Bar, and some tools have limited use without the Edit Bar. You will 
probably want to keep the Edit Bar on screen at all times.



The fields in the Edit Bar change dynamically, depending on the currently active drawing or editing tool. 
The number of fields can vary quite a lot, so it´s a good idea to place the Edit Bar toward the left edge of 
the screen so that all the fields will always be visible. 



Drawing with the Edit Bar 



View Symbol Library
Menu: View|Symbol Library

The View Symbol Library command is a toggle that displays and hides the Symbol Library palette. The 
Symbol Library palette shows the symbols in the current symbol library. 
Symbols are actually fully independent TotalCAD drawings. A symbol library is simply a Windows folder 
(directory) that contains any number of TotalCAD files. The Symbol palette displays the contents of a 
symbol library, as large icons, small icons, or file names. If you click on any of the symbols displayed in 
the palette, a description of the symbol will appear in the description area at the bottom of the palette, as 
shown in the preceding illustration. 

Placing a Symbol in a Drawing 
Turning a Selection into a Symbol 
Changing to Another Open Symbol Library 
Opening a New Symbol Library 
Changing Your View of a Symbol Library 

Tip 
See Also 



To access much of the power of the Symbol palette, you need to go through its local menu, which you 
display by right-clicking in the Symbol palette title bar.



Symbol Libraries Property Sheet 



Placing a Symbol in a Drawing
To place a symbol in your drawing, simply drag it out of the Symbol palette and drop it in your drawing. 
The symbol will be placed in the drawing at the point where you release it. The symbol will remain 
selected after you place it, so that it can be repositioned and scaled.
The symbols that IMSI provides with TotalCAD are groups. This means that they have names, which 
makes them easier to keep track of, and it means that they can be selected and manipulated as a single 
unit. 

Warning 



Don´t expect all symbols to be this well-behaved. A symbol is really just a TotalCAD drawing, and it won´t 
be a group unless the person who created the symbol saved it as a group.



Turning a Selection into a Symbol
Any TotalCAD drawing can be a symbol. To create your own symbol library, all you really need to do is 
save all the drawings that comprise the library into a single Windows folder. However, another equally 
good way to save symbols is to drag selections from drawings into the Symbol palette. This gives you the 
additional option of saving only part of an existing drawing as a symbol.

1. Select the parts of your drawing that you want to turn into a symbol. (If you want to drag your entire 
drawing into the Symbol palette, choose 
Edit|Select All.) 

2. Before dragging it into the Symbol palette, it´s a good idea to group the selection by choosing Format|
Create Group. (This isn´t strictly necessary, but it will make the symbol easier to work with later.)

3. Hold the mouse over the selection´s reference point (the dot in the middle of the selection). You will 
know the mouse is in the right position when the cursor turns into a four-directional pointer.

4. Hold the mouse button down and drag the selection into the Symbol palette. Release the mouse 
button to drop the selection. The Save Symbol As dialog appears.

5. Save the symbol as a file, just as you would in the regular Save As dialog. You have the option of 
navigating to another folder, which will have the effect of placing the symbol into a different symbol 
library. If you put it in a folder that isn´t already a symbol library, TotalCAD will open a new symbol 
library in your drawing.

See Also 



Save As Dialog 



Changing to Another Open Symbol Library
You can have multiple symbol libraries open in your drawing. (You open and name symbol libraries in the 
Tools|Symbol Library property sheet.) To view the open libraries from the Symbol palette, right-click in the 
palette´s title bar to display its local menu. At the bottom of the local menu all of the open symbol libraries 
are displayed. To switch to another library, click on its name in the local menu. The contents of that library 
will then be displayed in the Symbol palette.



Opening a New Symbol Library
To open a new symbol library, right-click in the Symbol palette title bar and choose Open. This displays 
the Symbol Libraries property sheet, in which you can name and open new libraries.

See Also 



Symbol Libraries Property Sheet 



Changing Your View of a Symbol Library
The Symbol palette can display its symbols as icons, small icons, or as names. To switch between these 
three options, first right-click in the Symbol palette title bar to display its local menu, then choose Names, 
Small Icons, or Large Icons. A check mark will appear next to the currently selected option.



View Toolbars
Menu: View|Toolbars

The View Toolbars command displays the Desktop property sheet, which enables you to hide and view 
TotalCAD toolbars, as well as other interface controls. 

See also 



Desktop Property Sheet 



View Selection Info
Menu: View|Selection Info

The View Selection Info command displays and hides the Selection Info palette. This palette contains 
information about the currently selected object, such as its entity type, dimensions, and location in the 
drawing. 
The Selection Info palette contains two windows. The upper window shows the type and structure of the 
objects selected. If an object is a group containing other objects, this relationship will be displayed in 
outline form. A plus sign next to an item indicates that it contains other items that are not displayed. To 
open the outline, and see what objects are contained, click on the plus sign; click again to close the 
outline to see a higher level of the hierarchy.
The lower window displays precise data about whatever object is currently selected in the upper window. 
It shows the object´s graphic type, its coordinate location in the drawing space, and its dimensions in 
current World units.
Pressing the Copy button copies this data to the Windows clipboard so that you can paste it into a word 
processor or text editor, such as Windows notepad. The text that you copy contains special markers so 
that programmers, or very adventurous users, can "parse" the data in their own programs. 

Note 



Experienced Web users may notice that the markers are similar to those used in HTML.



Insert Menu and Tools
The Insert menu provides access to tools that let you draw entities and commands that enable you to 
insert pictures and OLE objects into your drawing.

Construction Tools 
Create temporary construction lines.
Point 
Draw single-point marker entities in various shapes.
Line
Draw lines, rectangles, polygons, and lines tangent to circles and arcs.
Double Line Tools 
Draw double line segments, rectangles, and polygons.
Circle/Ellipse 
Draw circles and ellipses.
Arc Tools 
Draw circular and elliptical arcs.
Curve Tools 
Draw Bezier curves, spline curves, and freehand sketches.
Text Tool 
Add single- or multiple-line text to the drawing.
Dimension Tools 
Draw dimension entities.
Insert Picture 
Insert images (bitmaps or metafiles) into the drawing.
Insert Object 
Insert OLE objects into the drawing.



Construction Tools
Menu: Insert|Construction

The construction tools enable you to place temporary construction lines on your drawing. Construction 
lines are entities used for reference: You can define points in relation to constructions and use them to 
segment your drawing space. 
Horizontal Construction Line 
Draw a horizontal construction line.
Vertical Construction Line 
Draw a vertical construction line.

Notes 



Construction lines exist on their own layer of the drawing, called "$CONSTRUCTION". You can clear this 
layer with the Clear|Constructions command. You can clear an individual construction with the Edit|Clear|
Construction tool.
The properties of constructions cannot be accessed or changed.



Horizontal Construction Line
Menu: Insert|Construction|Horizontal Line

To place a horizontal construction line in your drawing:

1. Activate the Horizontal Construction Line tool.
2. Define a point that you want the line to intersect. TotalCAD draws a horizontal construction line that 

intersects the point you have defined.



Vertical Construction Line
Menu: Insert|Construction|Vertical Line

To place a vertical construction line in your drawing:

1. Activate the Vertical Construction Line tool.
2. Define a point that you want the line to intersect. TotalCAD draws a vertical construction line that 

intersects the point you have defined.



Point
Menu: Insert|Point|Dot, Star, Square, Cross, or Circle Toolbars: Insert

You can create five different types of marker points: dot, star, square, cross, or circle. Each type of point is
created in the same way. Four of these points are essentially similar, except for their shape. The Dot point
is different: It stays the same size no matter how close you zoom in or how far you zoom out. This is 
useful if you want to use it as a point of reference while working in different views of the drawing. 
To place a point:

1. Activate the Point tools and select the type of point you want to create.
2. Define a point.

Note 
Tip 



Points cannot be scaled or rotated.



If you create a point of a particular shape and you subsequently want to change the shape, activate the 
Select tool, double-clicking on the point, then change its Point Type in the Point property sheet. 



Line
Menu: Insert|Line Toolbar: Insert

The Line tools enable you to draw a single line segment, multiple connected segments (multilines), 
polygons, rectangles, perpendicular lines, parallel lines, and lines tangent to arcs.

Single Line 
Draw a single line segment.
Multiline 
Draw a series of connected line segments.
Polygon 
Draw a regular polygon with an arbitrary number of sides.
Rectangle 
Draw an orthogonal rectangle.
Perpendicular Line 
Draw a line perpendicular to an existing line from any point.
Parallel Line 
Draw a line parallel to an existing line, at a specific distance from the line.
Tan Arc Pt 
Draw a line tangent to an arc, touching the arc at the line´s midpoint.
Tan to Arc 
Draw a line tangent to an arc, with the line´s second endpoint touching the arc.
Tan from Arc 
Draw a line tangent to an arc, with the line´s first endpoint touching the arc.
Line 2 Arcs 
Draw a line tangent to two arcs, with each endpoint of the line touching one of the arcs.



Single Line
Menu: Insert|Line|Single Toolbars: Insert

Use the Single Line tool to draw a line segment between two defined points:

1. Activate the Single Line tool. 
2. Define the line segment´s starting point. 
3. Do one of the following:

Define the line segment´s ending point. 
Set the length and angle of the line segment in the Edit Bar, then press <Enter>. 



Multiline
Menu: Insert|Line|Multiline Toolbars: Insert

The Multiline tool enables you to draw a series of connected line segments that comprise one entity. You 
can create a multiline by defining a series of points. Alternatively, you can set a starting point, then define 
each line segment in sequence by entering its length and angle in the Edit Bar, pressing <Enter> to 
complete each segment of the multiline, and pressing <Ctrl>+<F> to finish the multiline:

1. Activate the Multiline tool.
2. Define the first point of the multiline entity.
3. Do one of the following:

If necessary, reset the Snap mode, then define a second point: TotalCAD draws a line segment 
between the two points. 

Specify the length and angle of the segment in the Edit Bar and press <Enter>.
4. Repeat step 3, adding connected segments to the multiline, until the multiline is finished. 
5. To define the last point in the series, double-click, choose Finish from the Local Menu, or press 

<Ctrl>+<F> if you are working in the Edit Bar. 

Tips 
Note 



Instead of choosing Finish, you can have TotalCAD close the multiline for you by choosing Close from the
Local Menu. This draws a line segment from the last point of the multiline to the first point.

To undo the most recently drawn segment of the multiline, open the Local Menu and choose One Step 
Back.



Once a multiline is closed, TotalCAD treats it as a polygon, which means that it will be filled with the color 
and pattern of the current brush. You can control brush formatting through the Format|Properties dialog.



Polygon
Menu: Insert|Line|Polygon Toolbars: Insert

Use the Polygon tool to draw a regular polygon by defining points for the polygon´s center and for one of 
its vertices:

1. Activate the Polygon tool.
2. Define a point for the center of the polygon.
3. Enter the number of sides for the new polygon in the Sides field on the Edit Bar.
4. Do one of the following:

Define a second point for one of the polygon´s vertices.
Type values for the polygon´s radius, and degree of rotation in the Edit Bar. The radius is the 

distance from the centerpoint to one of the vertices, and the degree of rotation is the angle of a line from 
the centerpoint to one vertex.

Note 



You could create a regular polygon by defining the distance between the center and the midpoint of a line 
segment. TotalCAD 1.0 does not currently support this capability.



Rectangle
Menu: Insert|Line|Rectangle Toolbars: Insert

The Rectangle tool enables you to create a rectangle by defining two diagonally opposite corners. 
Rectangles created in this way are oriented orthogonally, although they can subsequently be rotated 
using the editing tools:

1. Activate the Rectangle tool.
2. Define a point for one corner of the rectangle.
3. Do one of the following:

Define a point for the diagonally opposite corner. 
Specify the A (horizontal) and B (vertical) size of the rectangle in the Edit Bar, then press <Enter>.

Tip 



If you use the Edit Bar method, the A size will be drawn upward from the starting point, and the B size will 
be drawn to the right of the starting point. To draw downward or to the left, use negative values.



Perpendicular Line
Menu: Insert|Line|Perpendicular Line Toolbars: Insert

Use the Perpendicular Line tool when you want to draw a line perpendicular to an existing line. The new 
line extends from a defined point to the existing line:

1. Activate the Perpendicular Line tool.
2. Click on an existing line segment to which you want to draw the perpendicular line.
3. Define the point from which you want to the perpendicular line to originate. 

If the point you define is beyond the end of the existing line segment, TotalCAD by default will draw the 
perpendicular line from this point to the point where the two lines would meet if the existing line segment 
were extended. To constrain the perpendicular line so that it must meet the existing line segment, right-
click in the drawing area and choose Limit to Segment in the Local Menu.



Parallel Line
Menu: Insert|Line|Parallel Toolbars: Insert

Use the Parallel Line tool to draw a line parallel to an existing line.

1. Activate the Parallel Line tool.
2. Click on or near an existing line. Let´s call this the source line. As you move the mouse cursor away 

from the source line, TotalCAD draws a line parallel to it. 
3. Define a second point, which will be the second endpoint of the new line.

You can also select the source line, then specify the length of the parallel line and its distance from the 
source line in the Edit Bar. Press <Enter> or <Ctrl>+<F> to finish the parallel line.

Tip 



To create a parallel line that is constrained to be the same length as the source line, right-click in the 
drawing area with the Parallel Line tool active, then switch on the Keep Length option in the Local Menu.



Tan Arc Pt
Menu: Insert|Line|Tan Arc Pt Toolbars: Insert

The Tan Arc Pt tool enables you to draw a line tangent to an arc or circle with the midpoint of the line 
centered at the point of tangency:

1. Activate the Tan Arc Pt tool.
2. Click on the arc or circle on which you want to draw the line. A line appears tangent to the arc at a 

point on the arc near the mouse click.
3. Move the mouse to adjust the length of the line. The line length changes in both directions so that the 

midpoint of the line remains at the point where the line and arc meet. Click to set the line length.
4. A dotted line appears, from the center of the arc or circle to the mouse position, perpendicular to the 

tangent line. Move the mouse to change the angle of the dotted line and the position where the 
tangent line touches the arc, then click to set the angle of the tangent line.

Alternatively, you can click on the circle or arc, then specify the length and angle of the tangent line in the 
Edit Bar, then press <Enter>.



Tan to Arc
Menu: Insert|Line|Tan to Arc Toolbars: Insert

Use the Tan To Arc tool to draw a line tangent to an arc or circle from a defined point. 

1. Activate the Tan to Arc tool.
2. Define the point from which you want to draw the tangent line.
3. Click on the side of the arc or circle to which you want to draw the tangent line.

Tip 



To create a tangent line with a fixed length, define the first point of the line, then enter a length in the Edit 
Bar and check the lockdown box. Return to the drawing area and click on the circle or arc near the point 
of tangency. If the length you define is too long or too short this won´t work—but you can return to the Edit
Bar to adjust the length.



Tan from Arc
Menu: Insert|Line|Tan from Arc Toolbars: Insert

Use the Tan from Arc tool to draw a line tangent from an arc or circle.

1. Activate the Tan from Arc tool.
2. Click on the side of the arc or circle from which you want to draw the tangent line.
3. Do one of the following:

Define the point to which you want to draw the tangent line. 
Specify the length of the line in the Edit Bar, then press <Enter>.



Line 2 Arcs
Menu: Insert|Line|Line 2 Arcs Toolbars: Insert

Use the Line 2 Arcs tool to draw a line tangent to two arcs or circles:

1. Activate the Draw|Line|Line 2 Arcs tool.
2. Click on the side of the first arc or circle from which you want the line drawn tangent. 
3. Click on a side of the second arc or circle.

Note 



The current Snap mode is irrelevant when you use this tool.



Double Line Tools
Menu: Insert|Double Line Toolbars: Insert

Use the double line tools to draw two parallel lines as a single entity. The Double Line tools are essentially
similar to the Line tools, except that there are no Double Line tools for drawing lines tangent to arcs.

Double Line Properties 
Double Line Separation 
Double Line Segment 
Draw a double line segment by defining two endpoints.
Double Line Multiline 
Draw a series of connected double lines.
Double Line Rectangle 
Draw a horizontal double line rectangle.
Perpendicular Double Line    
Draw a double line perpendicular to an existing line.



Double Line Properties
Double Lines have unique properties that you can set in the Double Line property sheet of the Edit|
Properties dialog. You can access the default properties for double lines by right-clicking on any double 
line tool. You can access the properties of a specific double line entity by activating the Select tool and 
then double-clicking on the entity. 
In the Double Line property sheet you can:

Set the distance between the two lines of the double line.
Determine whether the endpoints of the double line are open or closed. Each endpoint can be set

individually.
Set the alignment of the double line. Alignment sets whether the nodes (reference points) of the 

double line are aligned along its "left" line, its "right" line, or along its center. 
The alignment of the nodes determines how the double line aligns itself to the coordinate system, and to 
the grid and other objects when you use snap modes to position the double line.

Tip    



To determine which is the left and which is the right side of a double line, imagine yourself standing on the
starting point of the line, facing the endpoint. No matter which way you rotate the line, the right side 
remains on your right. This is similar to the terms "port" and "starboard" which define directions relative to 
the fore and aft of a ship. The critical thing is to know the direction in which the double line is drawn.



Double Line Separation
The width of a double line is set only in its property sheet. If you stretch or scale a double line, its width 
always remains the same. If you want the width of the double line to change as you resize a selection that
contains the double line, first select the double line and choose Explode from the Format menu. The first 
time you explode a double line, it will become a group of single line segments. (If the double line entity is 
itself contained within a group, you will need to explode it more than once.) Once the double line is 
exploded into two single lines, the distance between the two single lines will be scaled along with the 
selection that contains them.

See Also 



Double Line Property Sheet 



Double Line Segment
Menu: Insert|Double Line|Single Toolbars: Insert

Use the Double Line Segment tool to draw a double line segment between two defined points. 

1. Activate the Double Line Segment tool. 
2. Define the double line segment´s starting point. 
3. Do one of the following:

Define the double line segment´s ending point.
Specify the length and angle of the double line segment in the Edit Bar, then press <Enter>.



Double Line Multiline
Menu: Insert|Double Line|Multiline Toolbars: Insert

The Double Line Multiline tool enables you to draw a series of connected double line segments. You can 
create a multiline by defining a series of points. Alternatively, you can set a starting point, then define 
each double line segment in sequence by entering the length and angle of each segment in the Edit Bar, 
pressing <Enter> to complete each segment of the multiline.

1. Activate the Double Line Multiline tool.
2. Define the first point of the multiline entity.
3. Do one of the following:

If necessary, reset the Snap mode, then define a second point: TotalCAD draws a double line 
segment between the two points. 

Specify the length and angle of the double line segment in the Edit Bar and press <Enter>.
4. Repeat step 3, adding connected double line segments to the multiline, until the multiline is finished. 
5. To define the last point in the series, right-click in the drawing area and choose Finish from the Local 

Menu, or press <Ctrl>+<F> if you are working in the Edit Bar. 

Tips 



You can have TotalCAD close the multiline for you by choosing Close from the Local Menu. This draws a 
double line segment from the last point of the multiline to the first point, resulting in a double line polygon.

If you want to cancel the previous line segment, open the Local Menu and choose One Step Back.



Double Line Rectangle
Menu: Insert|Double Line|Rectangle Toolbars: Insert

This tool enables you to create a double line rectangle by defining two diagonally opposite corners. 
Rectangles created in this way are orthogonal, although they can subsequently be rotated using editing 
tools.

1. Activate the Double Line Rectangle tool.
2. Define the first point.
3. Do one of the following:

Define a point for the diagonally opposite corner. 
Specify the vertical and horizontal dimensions of the rectangle in the Edit Bar, then press 

<Enter>.
Note 



If you use the Edit Bar method, the A size will be drawn upward from the starting point, and the B size will 
be drawn to the right of the starting point. You can draw downward and to the left by entering negative 
values.



Perpendicular Double Line
Menu: Insert|Double Line|Perpendicular Line Toolbars: Insert

Use the Perpendicular Double Line tool when you want to draw a double line perpendicular to an existing 
line. The double line extends from a defined point to the existing line.

1. Activate the Perpendicular Line tool.
2. Click on an existing line segment to which you want to draw the perpendicular double line. (This can 

be one of the sides of another double line.)
3. Define the point from which you want the perpendicular line to originate. 

Tip 



If the point you define is beyond the end of the existing line segment, TotalCAD will normally draw the 
double perpendicular line from this point to where it would meet the existing line segment if the existing 
line segment were extended. If you want to constrain the perpendicular line so that it will not be drawn 
beyond the ends of the existing line segment, right-click in the drawing area to open the Local Menu, then
choose Limit to Segment.



Circle/Ellipse
Menu: Insert|Circle/Ellipse Toolbar: Insert

The Circle/Ellipse menu item opens a submenu containing tools for drawing circles and ellipses. You can 
also access these tools from the Ellipse toolbar, and on the Ellipse flyout of the Insert toolbar.

Center and Point 
Draw a circle by specifying its centerpoint and radius.
Double Point 
Draw a circle by defining two opposite points on its perimeter.
Circle Tan to Arc 
Draw a circle tangent to another circle or arc.
Circle Tan to Line 
Draw a circle tangent to a line.
Triple Point 
Draw a circle by defining three points on the circle´s perimeter.
Ellipse 
Draw an ellipse by defining its bounding rectangle.
Rotated Ellipse 
Draw an ellipse rotated at any angle.



Center and Point
Menu: Insert|Circle/Ellipse|Center and Point Toolbar: Insert

Use the Center and Point tool to create a circle by defining its center and a point on its perimeter. 

1. Activate the Center and Point tool.
2. Define a point for the center of the circle.
3. Do one of the following:

Define a point on the perimeter of the circle.
Enter the radius of the circle in the Radius field, or the circumference of the circle in the Circumf. 

field on the Edit Bar, then press <Enter>.



Double Point
Menu: Insert|Circle/Ellipse|Double Point Toolbar: Insert

The Double Point tool lets you draw a circle by defining two opposite points on the circle´s perimeter:

1. Activate the Double Point tool.
2. Define a point that will be on the perimeter of the circle. 
3. Do one of the following:

Define a second point, 180 degrees from the first point on the perimeter of the circle.
Specify the diameter (or circumference) of the circle and the angle of the line in the Edit Bar, then 

press <Enter>.



Circle Tan to Arc
Menu: Insert|Circle/Ellipse|Tan to Arc Toolbar: Insert

Use the Circle Tan to Arc tool to draw a circle tangent to an arc or to another circle. 

1. Activate the Circle Tan to Arc tool.
2. Click on the existing arc or circle to which you want the circle to be tangent.
3. Do one of the following:

Define the centerpoint of the circle.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking there (or press <Ctrl>+<D>). Click once 
more to continue to the next step.
4. Move the mouse along the permimeter of the arc to position the circle on the arc. If you move the 

mouse along the inside of the arc, the circle will move to the inside of the arc; if you move the mouse 
along the outside of the arc, the circle will move to the outside. Once the circle is in place, click the 
mouse to fix its position.

Note 



After clicking on the circle or arc (step 2), you can set the radius or circumference of the circle you are 
drawing in the Edit Bar and press <Enter>, finishing the entity. Be aware that if you use this method, you 
will not be able to reposition the circle on the arc using this tool, so make sure that you place it where you 
want it with the first click.



Circle Tan to Line
Menu: Insert|Circle/Ellipse|Tan to Line Toolbar: Insert

Use the Circle Tan to Line tool to draw a circle tangent to an existing line.
1. Activate the Circle Tan to Line tool.
2. Click on the line to which you want the circle to be tangent.
3. Do one of the following:

Define the centerpoint of the circle.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking there (or press <Ctrl>+<D>). Click once 
more to continue to the next step.
4. Move the mouse along the line to position the circle, then click (using any snap mode) to fix the circle

´s position.

Note 



After clicking on the line (step 2), you can set the radius or circumference of the circle you are drawing in 
the Edit Bar and press <Enter>, finishing the entity. Be aware that if you use this method, you will not be 
able to reposition the circle on the line using this tool, so make sure that you place it where you want it 
with the first click.



 Triple Point
Menu: Insert|Circle/Ellipse|Triple Point Toolbar: Insert

Use the Triple Point tool to draw a circle that passes through any three points.

1. Activate the Triple Point tool.
2. Define the first, then the second, then the third point through which the perimeter of the circle will 

pass.



Ellipse
Menu: Insert|Circle/Ellipse|Ellipse Toolbar: Insert

The Ellipse tool lets you create an ellipse by defining a bounding rectangle for the ellipse. The axes of the 
ellipse will be orthogonal; however, you can rotate the ellipse after you have created it using the editing 
tools.

1. Activate the Ellipse tool.
2. Define the first point or corner of the bounding rectangle.
3. Do one of the following:

Define the diagonally opposed corner of the bounding rectangle.
Specify the lengths of the ellipse´s major and minor axes in the Edit Bar, then press <Enter>.



Rotated Ellipse
Menu: Insert|Circle/Ellipse|Rotated Ellipse Toolbar: Insert

The Rotated Ellipse tool enables you to create an ellipse tilted at any angle. 

1. Activate the Rotated Ellipse tool.
2. Define the centerpoint of the ellipse.
3. Define a point to specify an angle and distance from the centerpoint. This creates an axis from the 

defined point, through the centerpoint, to an opposite point the same distance from the centerpoint. 
You can view this axis on the screen as you adjust the position of the point using the mouse or 
Coordinate Fields.

4. Define a second point to specify the length of the opposite axis. This axis will of course be 
perpendicular to the first axis.

Alternatively, you can define the centerpoint of the ellipse, specify the length and angle of the major axis 
and the length of the minor axis in the Edit Bar, then press <Enter>.



Arc Tools
Menu: Insert|Arc Toolbars: Insert

Drawing arcs is very similar to drawing circles. Generally, the arc tools work precisely the same way as 
the circle tools, except that they add one extra step: defining the start and end angles of the arc.

Circumference and Length of Arcs 
Combining Edit Bar and Mouse When Drawing Arcs 
Center and Point Arc 
Draw a circular arc by specifying its centerpoint and a point on its circumference.
Double Point Arc 
Draw a circular arc by defining the endpoints of its diameter.
Arc Tan to Arc 
Draw a circular arc tangent to a circle or arc.
Arc Tan to Line 
Draw a circular arc tangent to a line.
Triple Point 1-2-3 
Draw a circular arc by defining (1) its starting point, (2) a point on its perimeter, and (3) its ending point.
Elliptical Arc 
Draw an elliptical arc by defining its bounding rectangle.
Rotated Elliptical Arc 
Draw an elliptical arc rotated at any angle .

Note 



Arcs are always drawn in a counterclockwise direction.



Circumference and Length of Arcs
When you are drawing arcs using the Edit Bar, you will need to distinguish between the Circumf. field and 
the Length field. 
The Circumf. field holds that value that represents the circumference of the arc circle, that is, the length of
the circle that the arc would form if it were closed. This field and the Radius field are mutually dependent: 
Changing one changes the other. The Length field is the actual length of the arc, taking into account its 
starting and ending angles.



Combining Edit Bar and Mouse When Drawing Arcs
Arcs are relatively complex entities, and it´s likely that you´ll want to use various combinations of the Edit 
Bar and the mouse to create them.

Tip 



Keep in mind that if you specify values in the Edit Bar, you must lock the fields down before returning to 
the drawing area to finish the entity. If you don´t, the values that you typed in the Edit Bar will change 
when you re-enter the drawing area.



Center and Point Arc
Menu: Insert|Arc|Center and Point Toolbars: Insert

Use the Center and Point tool to create an arc by defining its center, a point on its circumference, and its 
starting and ending angles.

1. Activate the Center and Point tool.
2. Define the centerpoint of the arc.
3. Define a point at a distance from the centerpoint to specify the radius of the arc. TotalCAD draws a 

circle with the specified radius and centerpoint. A dotted line appears, extending from the centerpoint 
of the circle to the cursor.

4. Move the cursor to change the the dotted line to the angle at which you want the arc to start, then 
click to set the arc´s starting angle. Move the cursor counterclockwise to draw the arc, then click the 
mouse button to define the ending angle.

Alternatively, you can define a point for the center of the circle, enter the radius (or circumference) of the 
arc and its starting and ending angles (or length) in the Edit Bar, and then press <Enter>. 
You can also combine the two approaches. For example, you could define the center and radius of the 
arc using the mouse, then specify the starting and ending angles in the Edit Bar.



Double Point Arc
Menu: Insert|Arc|Double Point Toolbars: Insert

The Double Point tool lets you draw an arc by defining the endpoints of its diameter.

1. Activate the Double Point tool.
2. Define the starting point of a line that will pass through the center of the arc. 
3. Define the endpoint of this line. TotalCAD draws a circle that passes through the two defined points. A

dotted line appears, extending from the centerpoint of the circle to the cursor.
4. Move the cursor to change the the dotted line to the angle at which you want the arc to start, then 

click to set the arc´s starting angle. Move the cursor counterclockwise to draw the arc, then click the 
mouse button to define the ending angle.

Alternatively, you can define the first point of the arc´s diameter, then specify all the quantities that define 
the arc in the Edit Bar. 

You can also combine the two approaches. For example, you could define the center and radius of the 
arc using the mouse, then specify the starting and ending angles in the Edit Bar.



Arc Tan to Arc
Menu: Insert|Arc|Tan to Arc Toolbars: Insert

Use the Arc Tan to Arc tool to draw an arc tangent to an existing arc or circle. 

1. Activate the Arc Tan to Arc tool.
2. Click on the existing arc or circle to which you want the arc to be tangent. 

3. Do one of the following:

Define the centerpoint of the arc you are drawing.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking there (or press <Ctrl>+<D>). Click to 
continue to the next step.
4. Move the mouse along the permimeter of the arc to position the circle on the arc. If you move the 

mouse along the inside of the arc, the circle will move to the inside of the arc; if you move the mouse 
along the outside of the arc, the circle will move to the outside. Once the circle is in place, click the 
mouse to fix its position. A dotted line appears, extending from the centerpoint of the circle to the 
cursor.

5. Move the cursor to change the the dotted line to the angle at which you want the arc to start, then 
click to set the arc´s starting angle.

6. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

Note 



After clicking on the circle or arc (step 2), you can set the radius (or circumference) of the arc, as well as 
its starting and ending angles ( or length) in the Edit Bar,. then press <Enter> to finish the entity. Be aware
that if you use this method, you will not be able to reposition the circle on the arc using this tool, so make 
sure that you place it where you want it with the first click.



Arc Tan to Line
Menu: Insert|Arc|Tan to Line Toolbars: Insert

Use the Arc Tan to Line tool to draw an arc tangent to an existing line.

1. Activate the Arc Tan to Line tool.
2. Click on the line to which you want the arc to be tangent.

3. Do one of the following:

Define the centerpoint of the arc you are drawing.
Enter the radius or circumference of the circle in the Edit Bar, then lock down the field in which 

you typed the value, then return to the drawing area by clicking there (or press <Ctrl>+<D>). Click to 
continue to the next step.
4. Move the mouse to either side of the line and define a point to position the arc on the line. A dotted 

line appears, extending from the centerpoint of the circle to the cursor.
5. Move the cursor to change the the dotted line to the angle at which you want the arc to start, then 

click to set the arc´s starting angle.
6. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 

angle.

Note 



After clicking on the line (step 2), you can set the radius (or circumference) of the arc, as well as its 
starting and ending angles ( or length) in the Edit Bar,. then press <Enter> to finish the entity. Be aware 
that if you use this method, you will not be able to reposition the circle on the line using this tool, so make 
sure that you place it where you want it with the first click. 



Triple Point 1-2-3
Menu: Insert|Arc|Triple Point 1-2-3 Toolbars: Insert

The Triple Point 1-2-3 tool lets you draw an arc by defining three points: a starting point, a middle point, 
and an ending point. The arc will touch all three of the points.

1. Activate the Triple Point 1-2-3 tool.
2. Define the starting point of the arc. 
3. Define a point through which the arc will pass.
4. Define the endpoint of the arc.



Elliptical Arc
Menu: Insert|Arc|Elliptical Toolbar: Insert

The Elliptical Arc tool lets you create an elliptical arc by defining its bounding rectangle. The lengths of the
minor and major axes of the arc are determined by the lengths of the sides of the bounding rectangle. The
axes of the arc will be orthogonal; however, you can rotate the arc after you have created it using the 
editing tools:

1. Activate the Ellipse tool.
2. Define a point for the first corner of the bounding rectangle.
3. Define a point for the diagonally opposite corner of the bounding rectangle. TotalCAD draws an ellipse

bounded by the rectangle that you have defined. A dotted line appears, extending from the 
centerpoint of the ellipse to the cursor.

4. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 
set the arc´s starting angle.

5. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

Alternatively, you can define the starting point of the elliptical arc, then specify its major and minor axes 
and starting and ending angles in the Edit Bar. You can also combine use of the mouse and Edit Bar.



Rotated Elliptical Arc
Menu: Insert|Arc|Rotated Elliptical Toolbar: Insert

The Rotated Elliptical Arc tool enables you to create an elliptical arc tilted at any angle:

1. Activate the Rotated Elliptical Arc tool.
2. Define the centerpoint of the arc.
3. Define a point to specify an angle and distance from the centerpoint. This creates an axis from the 

defined point, through the centerpoint, to an opposite point the same distance from the centerpoint. 
This is the major axis of the elliptical arc.

4. Define a third point to specify the length of the minor axis (perpendicular to the major axis).TotalCAD 
draws an ellipse with the specified major and minor axes. A dotted line appears, extending from the 
centerpoint of the ellipse to the cursor.

5. Move the cursor to change the dotted line to the angle at which you want the arc to start, then click to 
set the arc´s starting angle.

6. Move the cursor counterclockwise to draw the arc, then click the mouse button to define the ending 
angle.

You can also define the centerpoint of the ellipse, then specify the length and angle of the major axis and 
the length of the minor axis, as well as the starting and ending angles of the arc, in the Edit Bar.



Curve Tools
Menu: Insert|Curve Toolbar: Insert

Curve Properties 
Bezier Curve 
Connects two endpoints; gravitates toward control points along its path.
Spline Curve 
Continuous curve that connects a series of points.
Sketch Curve 
Freehand multiline drawn with mouse.



Curve Properties
Curve´s have special properties that can be set in the Curve property sheet of the Properties dialog. This 
property sheet lets you show or hide the frame of a Bezier or Spline curve, transform a Bezier curve into a
spline curve, or vice versa. You can access the default properties of curves by property sheet by double-
clicking on a curve with the Select tool, or by selecting the curve and then choosing Format|Properties.

Tip 
See Also 



You can close a Bezier or Spline curve by choosing Close from the Local Menu instead of Finish. This 
draws a curved line between the two endpoints. You can also close curves or break open closed curves 
using Node Edit mode, employing the same technique that you use on multilines and polygons.



Breaking Polygons, Closing Multilines, Curve Property Sheet 



Bezier Curve
Menu: Insert|Curve|Bezier Toolbar: Insert

To create a Bezier curve, define points along the intended path of the curve. The curve will span the two 
endpoints and be pulled toward the intermediate points, which act as control points along its path.

1. Activate the Bezier Curve tool.
2. Define the first endpoint of the curve. 
3. Continue to define points along the path of the curve.
4. To define the final point, right-click and choose Finish from the Local Menu. If you want to close the 

curve, choose Close instead of Finish.

If at any point you wish to undo the segment of the curve that you just drew, right-click in the drawing area
and choose One Step Back from the local menu.
An alternative to defining points along the path of the curve is to specify the length and angles of the line 
segments between the points, which form the frame of the curve. You can do this in the Edit Bar, pressing
<Enter> to complete each segment of the frame, then pressing <Ctrl>+<F> to complete the entire curve. 
This procedure is essentially similar to drawing a multiline.



Spline Curve
Menu: Insert|Curve|Spline Toolbar: Insert

To create a Spline curve, define points along the intended path of the curve. The curve will pass through 
the defined points.

1. Activate the Spline Curve tool.
2. Define the first endpoint of the curve. 
3. Continue to define points along the path of the curve. 
4. To define the final point choose Finish from the Local Menu. If you want to close the curve choose 

Close instead of Finish.

If at any point you wish to undo the segment of the curve that you just drew, right-click in the drawing area
and choose One Step Back from the local menu.
An alternative to defining points along the path of the curve is to specify the length and angles of the line 
segments between the points, which form the frame of the curve. You can do this in the Edit Bar, pressing
<Enter> to complete each segment of the frame, then pressing <Ctrl>+<F> to complete the entire curve. 
This procedure is essentially similar to drawing a multiline.



Sketch Curve
Menu: Insert|Curve|Sketch Toolbar: Insert

The Sketch tool is used for freehand drawing.
1. Activate the Sketch tool. 
2. Click the mouse to define the starting point of the sketch.
3. Move the mouse to draw a freehand polyline.
4. Click the mouse to define the final endpoint of the sketch polyline.



Text Tool
Menu: Insert|Text Toolbar: Insert

The features for creating, formatting, and manipulating text in TotalCAD 1.0 are powerful; however, 
entering text and placing it in your drawing is simple and intuitive:

1. Activate the Text tool.
2. If you wish to set the font, size, and attributes of text prior to typing, display the Text Format toolbar 

(using View|Toolbars) and choose settings from the toolbar. You can use any TrueType font installed 
in your system. Alternatively, you can right-click on the text tool and set the text attributes in the Text 
property sheet.

3. Click in the drawing area at the point where you want to place your text.
4. Type the text that you want to place, using the <Backspace> key to make corrections. Press 

<Shift>+<Enter> to add a new line of text. To finish the entity, press <Enter>, or right-click and choose
Finish from the Local Menu.

Text Properties 
Text Height and Angle Options 
Text Alignment Options 

Note 



For information about installing TrueType fonts, see your Windows documentation.



Text Properties
The Text tool has a special set of properties that are accessible through the Text property sheet. You can 
access the default properties of the Text tool by right-clicking on the tool. You can access the properties of
selected text by double-clicking on a selection. The Text property sheet has options for setting font, style, 
text height, and color.

Tip 
See Also 



To edit the contents of the text, select the text object and choose Format|Properties, then edit the text in 
the Attribute field of the General property sheet. To reformat the text, use the Text property sheet in the 
same dialog.



Manipulating Text, Formatting Text, Text Property Sheet 



Text Height and Angle Options
The Local Menu offers options for changing the height and angle of text "on the fly" while the Text tool is 
active. 
If you right-click and choose Height from the Local Menu, a rectangle will appear. Move the mouse to 
position the lower-right corner of the box until it is the desired size. Click the mouse to set the text height, 
then continue entering text.
If you choose Angle from the Local Menu, a rectangle will appear. Move the mouse to rotate the 
rectangle, then click the mouse. You can now continue entering text into the angled text frame.
You can also change the text height and by typing values into the Height and Angle fields of the Edit Bar.

Note 
Tip 
See Also 



The editing and formatting tools provide other options for rotating and resizing text more precisely after it 
has been drawn.



To use Ortho while rotating text, hold down the <Shift> key.



Manipulating Text, Formatting Text, Text Property Sheet



Text Alignment Options
The text alignment options of the Text tool give you precise control over how the text is aligned relative to 
the point where it is inserted in your drawing. To access these options, activate the text tool, right-click in 
the drawing area, then choose Align (the command will be followed by two capital letters that vary, 
depending on the current alignment setting).
The figures next to each alignment setting show you graphically how the text is positioned relative to the 
insertion point, which is represented by a star. There are three vertical positions (Top, Center, and 
Bottom), and three horizontal positions (Left, Middle, and Right). When you re-open the Local Menu with 
the Text tool active, the letters next to the command represent the current settings. TL, for example, 
means that the the insertion point will be at the top-left corner of the text.



Dimension Tools
Menu: Insert|DimensionToolbars: Insert

TotalCAD contains a variety of dimension tools that you can use to display the measurements of lines and
angles. Dimensions generally consist of a dimension line or arc, extension lines extending to the object 
being measured, and dimension text. Leader dimensions consist of dimension text and a simple leader 
line. Dimensioning an entity means to display a dimension that measures or otherwise marks that entity. 
By default, dimension text contains a measurement of the dimensioned object or coordinates in current 
World units. (Leader dimensions, which contain text labels, are the exception to this rule.) You can 
override the default text of a dimension by specifying the text in the Edit Bar prior to finishing the 
dimension.
Manual, Segment, and Entity Dimensioning 
Associative Dimensions 
Setting Dimension Properties 

Horizontal Dimension 
Draw a linear dimension showing horizontal distance.
Vertical Dimension 
Draw a linear dimension showing vertical distance.
Parallel Dimension 
Draw a linear dimension showing absolute distance between two points.
Angular Dimension 
Draw a angular dimension showing the angle formed by two lines, by points on the perimeter of a circle or
arc, or the angle formed by any two points relative to a defined vertex.
Radius Dimension 
Draw a dimension indicating the radius of an arc or circle.
Diameter Dimension 
Draw a dimension indicating the diameter of an arc or circle.
Leader Dimension 
Draw a simple line leader with label text.



Manual, Segment, and Entity Dimensioning
Horizontal, vertical, and parallel dimensions are collectively known as linear dimensions. When you create
a linear dimension, you have three primary choices:

You can draw the dimension manually, using the Coordinate Fields, Edit Bar, or the mouse and 
snap modes.

You can associate the dimension with a line segment.
You can associate the dimension with an entire entity (such as a multiline or group).

To choose one of these three modes:

1. Activate the dimension tool that you want to use.
2. Right-click in the drawing area to open the Local Menu.
3. Do one of the following:

Click to place a check mark next to Segment Dimensioning to associate the dimension with a line 
segment. 

Click to place a check mark next to Entity Dimensioning to associate the dimension with an entity.
If you want to create the dimension manually, uncheck both Segment Dimensioning and Entity 

Dimensioning.
Once you have selected a dimensioning mode, the mode is saved with the drawing and remains in effect 
for that drawing unless you explicitly change it. 
For further information on drawing linear dimensions, read the following sections on the individual 
dimension tools.

Tip 
See Also 



If you generally prefer one of the dimensioning modes over the others, you can save it in a drawing 
template.



Horizontal Dimension, Parallel Dimension, Vertical Dimension 



Associative Dimensions
Dimensions can be associated to objects. This means that you can freely move, rotate, or resize the 
objects with which the dimension is associated, and the dimension will retain its position relative to the 
objects, and the dimension text will change automatically to reflect changes resulting from the objects 
being resized or moved (provided that you did not override the automatic text in the Edit Bar when you 
created the dimension).
If you want a dimension to be associated with an object, you first need to be sure that the Associative 
Dimension option is turned on. To do this, first right-click on any dimension tool to bring up the Properties 
dialog, which will contain the property sheets for default dimension properties. If there is no check mark in
the Associative Dimension check box, then click in the box. Click OK to close the dialog.
Once this box is checked, then any dimension that is "connected" to an object will be associated with the 
object. You can accomplish this in the following ways:

Use Segment Dimensioning.
Use Entity Dimensioning.
Use any snap mode to snap the dimension to an existing object.
Use a dimension tool that automatically connects to an entity. If you dimension an angle on a 

circle, for example, the dimension will be associated with the circle. If you dimension an angle between 
two lines, the dimension will be associated with both lines.

Tips 



To tell whether a dimension is associated with an entity, select the entity. Any dimensions associated with 
that entity will be colored blue.

If you want to turn off default associative dimensions, first right-click on a dimension tool to bring up the 
Properties dialog. Then, in the Format property sheet, uncheck the Associative Dimensions check box. 



Setting Dimension Properties
The Dimension property sheets provide a large number of options for controlling the format of 
dimensions. You can set the default properties of dimensions by right-clicking on a dimension tool and 
then choosing settings in the Dimension property sheets. These settings are saved in your drawing or 
template and remain in effect until you explicitly change them. 
If you want to set the properties of a dimension or a set or dimensions, activate the Select tool, select the 
dimensions that you want to format, then double-click on the selection to bring up the Properties dialog.

See Also 



Dimension Property Sheets 



Horizontal Dimension
Menu: Insert|Dimension|Horizontal Toolbars: Insert

Use the Horizontal Dimension tool to display the horizontal length of an entity, or to display the Horizontal 
distance between any two points that you define in the drawing space:

1. Activate the Horizontal Dimension tool.
2. If desired, change the current dimensioning mode, as described in the Manual, Segment, and Entity 

Dimensioning.
3. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
4. Define a final point to determine the direction and length of the dimension´s extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default, automatic dimension text, type the text you want in the Edit Bar prior to fininishing 
the dimension.



Vertical Dimension
Menu: Insert|Dimension|Vertical Toolbars: Insert

Use the Vertical Dimension tool to display the Vertical length of an entity, or to display the vertical distance
between any two points that you define in the drawing space:

1. Activate the Vertical Dimension tool.
2. If desired, change the current dimensioning mode, as described in the Manual, Segment, and Entity 

Dimensioning.
3. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
4. Define a final point to determine the direction and length of the dimension´s extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default, automatic dimension text, type the text you want in the Edit Bar prior to fininishing 
the dimension.



Parallel Dimension
Menu: Insert|Dimension|Parallel Toolbars: Insert

Use the Parallel Dimension tool to display the absolute length of an entity (the distance between the two 
points on the entity that are farthest apart).

1. Activate the Parallel Dimension tool.
2. If desired, change the current dimensioning mode, as described in Manual, Segment, and Entity 

Dimensioning.
3. Do one of the following:

If Segment or Entity Dimensioning mode is active, click on the segment or entity that you want to 
dimension.

If you are dimensioning manually, define two points, using any snap mode or the Coordinate 
Fields. (You can also specify the length and angle of a line connecting the two points in the Edit Bar.)
4. Define a final point to determine the direction and length of the dimension´s extension lines. (You can 

also specify this length directly in the Edit Bar.)

To override the default, automatic dimension text, type the text you want in the Edit Bar prior to fininishing 
the dimension.

Note 



When dimensioning a circle or arc, you can position the parallel dimension at any angle.



Angular Dimension
Menu: Insert|Dimension|Angular Toolbars: Insert

Use this tool to dimension angles in your drawing. You can dimension:

The angle formed by any two lines.
The angle of an arc.
The angle formed by any two points on the perimeter of a circle.
A freeform angle that you create by defining a vertex node and two points.

Dimensioning an Angle Formed by Two Lines 
Dimensioning Angles on Circles 
Dimensioning Angles on Arcs 
Dimensioning Freeform Angles 



Dimensioning an Angle Formed by Two Lines
To dimension the angle formed between two lines

1. Activate the Angular Dimension tool.
2. Click on the first line.
3. Click on the second line. If you now move the mouse cursor between the two lines, TotalCAD forms a 

dimension showing the inner angle. If you move the mouse cursor outside the two lines, a dimension 
will be formed showing the outer angle.

4. Click to specify the position of the dimension arc.



Dimensioning Angles on Circles
To dimension the angle formed between any two points on the perimeter of a circle:

1. Activate the Angular Dimension tool.
2. Click on the circle that you want to dimension. A rubber-band line will appear, extending from the 

center of the circle to the location of the mouse cursor.
3. Define a second point, which forms an angle with the first point you defined, with the centerpoint of 

the circle as the angle´s vertex.
4. Define a third point to specify the location of the dimension arc. If you specify a location between the 

first two points, you will dimension the inner angle; if you specify a location outside the two points, you
will dimension the outer angle. You can locate the dimension arc inside or outside the circle.



Dimensioning Angles on Arcs
To dimension the angle of an arc:

1. Activate the Angular Dimension tool.
2. Click on the arc that you want to dimension.
3. Click to specify the location of the dimension arc. You can dimension either the inner or outer arc, and

you can place the dimension either inside or outside the arc that you are dimensioning.

Note 



When you use the Angular Dimension tool on an arc, TotalCAD automatically dimensions the angle 
formed by the endpoints of the arc. If you want to dimension the angle formed by any other two points on 
the perimeter of the arc, you can employ the Angle Node technique described in Dimensioning Freeform 
Angles, using snap modes to define points at the center and on the perimeter of the arc.



Dimensioning Freeform Angles
You can dimension the angle formed by any two points in the drawing space relative to a defined vertex, 
using the Angle Node option from the Local Menu:

1. Activate the Angular Dimension tool.
2. Right-click in the drawing area to display the Local Menu, then choose Angle Node.
3. Define a point, using any snap mode or the Coordinate Fields, for the vertex of the angle.
4. Define two more points to form an angle with the vertex node.
5. Define a point to position the dimension arc. You can measure either the inner or outer angle formed 

by the three points.



Radius Dimension
Menu: Insert|Dimension|Radius Toolbars: Insert

Use the Radius Dimension tool to dimension the radius of an arc or circle. 

1. Activate the Radius Dimension tool.
2. Click on the arc or circle that you want to dimension. TotalCAD draws a dimension from the center of 

the circle or arc to its perimeter. 
3. Define a second point to position the dimension on the perimeter of the circle, and to specify the 

position of the dimension text. The text can be positioned either inside or outside the circle or arc.

Alternatively, you can click on the circle or arc that you want to dimension, specify the text, angle, and 
length of the dimension in the Edit Bar, then press <Enter>.



Diameter Dimension
Menu: Insert|Dimension|Diameter Toolbars: Insert

Use the Diameter Dimension tool to dimension the Diameter of an arc or circle. 

1. Activate the Diameter Dimension tool.
2. Click on the arc or circle that you want to dimension. TotalCAD draws a dimension through the center 

of the circle or arc to opposed points on its perimeter. 
3. Define a second point to position the angle of the dimension, and to specify the position of the 

dimension text. The text can be positioned either inside or outside the circle or arc.

Alternatively, you can click on the circle or arc that you want to dimension, specify the text, angle, and 
length of the dimension in the edit bar, then press <Enter>.



Leader Dimension
Menu: Insert|Dimension|Leader Toolbars: Insert

Use the Leader tool to create dimension text attached to a simple line leader pointing to a location in your 
drawing. The Leader tool is similar to the Multiline tools in that it can contain an arbitrary number of 
connected line segments, which can be oriented at any angle.

1. Define the starting point of the leader (the end that is pointing toward an object).
2. Define a second point to specify the second endpoint of the line segment. TotalCAD will draw a line 

between the two points with an arrowhead on the first point.
3. If necessary, define more points, adding new line segments to the leader.
4. Type the text of the note in the field on the Edit Bar.
5. Complete the leader by double-clicking, or choosing Finish from the Local Menu.

You can also use the Edit Bar to create a leader. First define the starting point of the leader, then enter the
length and angle of the line segment in the Edit Bar. Press <Enter> to add a new line to the dimension 
without finishing the entity. Press <Ctrl>+<F> to complete the leader.

Note 



This tool serves a function similar to the Arrow (Selection) tool used in many standard Windows 
applications. 



Insert Picture
Menu: Insert|Picture Toolbar: Insert

Use this command to insert a picture into your drawing. The picture file can be of type WMF (Windows 
metafile), BMP (bitmap), or DIB (device-independent bitmap). Once the image is inserted, you can move 
it, copy it, or scale it. You cannot, however, rotate pictures or edit their contents. If you want to change the 
contents of the picture, you need to edit it in a bitmap editor, such as Windows Paint, then re-insert it into 
your TotalCAD drawing.
To insert a WMF or bitmap picture:

1. Choose Insert|Picture to display the Insert Picture dialog.
2. Choose the type of graphic file you want to import from the List Files of Type dropdown list.
3. If necessary, navigate to the directory where the graphic file you need is located. 
4. Choose the file that you want to open from the File Name list box and click the OK button.

Tip 
See Also 



You can edit a bitmap using Windows Paint, or any other bitmap editor that is registered in your Windows 
system, by simply double-clicking on the bitmap.



Insert Object 



Insert Object
Menu: Insert|Object Toolbar: Insert

The Insert Object command lets you insert OLE (Object Linking and Embedding) objects from other 
Windows applications into your TotalCAD drawing. You can edit the object from within TotalCAD using the
features and commands of the Windows application in which the object was created (the source 
application). For example, you can insert a Microsoft Word application into your drawing and edit the text 
or graphics using Microsoft Word tools.
To insert an OLE object into your drawing, first choose Insert|Object to display the Insert Object dialog. 
You can then Choose one of two basic options by clicking the Create New or the Create From File radio 
button (Create New is the default). The following topics describe how to insert objects using these two 
options.

Create New 
Create From File 
Embedded and Linked OLE Objects 

See Also 



Edit Links, Edit Object, Paste Special 



Create New
The Create New option lets you embed a new OLE object from another application into your drawing. 

1. Choose Insert|Object to display the Insert Object dialog.
2. If you want an icon representing the OLE object to be placed in your drawing, click the Icon check 

box.
3. Choose an OLE application from the dialog´s scrolling list: Either double-click the application´s name, 

or select it and press <Enter>. The object will appear in your TotalCAD drawing.

You can create and edit the OLE object using tools from the external application.



Create From File
The Create From File option lets you either embed or link an OLE object into your drawing based on a file
previously created in the source application. See Embedded and Linked OLE Objects for an explanation 
of the difference between embedding and linking. 

1. Choose Insert|Object to display the Insert Object dialog.
2. Click the Create From File radio button. The appearance of the dialog will change.
3. If you want the OLE object to be displayed as an icon in your drawing, click the Icon check box.
4. Check the Link check box if you want the OLE object to be linked; otherwise it will be embedded. 
5. Type the path and name of the file that you want to use in the text box, or click the Browse button and

locate the file using the Open dialog.

An OLE object based on the file will be inserted into your TotalCAD drawing. To edit the object in 
TotalCAD using the application that created the file, double-click the object, or select the object and 
choose Edit|Object. To update or edit links to a linked object, use the Edit|Links dialog.

See Also 



Edit Object, Edit Links, Paste Special 



Embedded and Linked OLE Objects
OLE objects that you insert can be either linked or embedded. Note these important differences between 
embedded and linked OLE objects:

Embedded objects become an integral part of your TotalCAD file, and take up more space in the 
file than a linked object. Embedded objects will move with the file if you transfer it to another computer 
system. If you make subsequent changes to the file on which the embedded OLE object was based, 
these changes will not affect the embedded OLE object.

Linked objects are references to the file on which they were based, and they retain their 
connection to that file. If you make changes to the file on which a linked OLE object is based, the changes
will also affect the linked OLE object.

See Also 
Warning 



Edit Links



If you move a TotalCAD file containing a linked object to another system, you will need to move any linked
files along with the TotalCAD file. Linked OLE objects are referenced to their files by a specification of 
their drive and path. If you move the linked file to another drive or directory, Windows will attempt to find 
the linked file, but if it cannot locate the file, you will need to change the drive path and directory using the 
Edit|Links dialog.



Format Menu and Tools
The Insert menu provides access to tools that let you draw entities and commands that enable you to 
insert pictures, files, and OLE objects into your drawing. The following table summarizes the contents of 
the Insert menu:
Properties 
Edit the properties of objects.
Create Hatch 
Draw a hatch pattern over selected objects.
Create Group 
Define all objects in the selection as a group.
Explode 
Break up an object into its constituent parts.
Bring to Front and Send to Back 
Move selected objects to the front or back of the object stack on their layer.
Align Commands 
Line up all selected objects on the left, right, top, bottom, vertical center, horizontal center, or along a line 
that you specify.



Properties
Menu: Format|Properties Toolbar: Modify

Properties are similar to attributes. The Properties command displays the Properties dialog. Use this 
dialog to set the properties    of objects, or the default properties of drawing tools. 
The Properties dialog contains a set of property sheets. The General, Pen, and Brush property sheets are
available whenever you display the dialog. Other property sheets (Double Line, Curve, Point, Text, and 
the three dimension property sheets) are displayed only when the tool to which they apply is activated, or 
if an entity to which they apply is selected.

General Property Sheet 
Pen Property Sheet 
Brush Property Sheet 
Curve Property Sheet 
Double Line Property Sheet 
Dimension Property Sheets 
Point Property Sheet 
Text Property Sheet 

See Also 



Select Commands, Property Toolbar 



General Property Sheet
The General property sheet of the Properties dialog lets you:

Select the layer of the drawing on which objects are drawn.
View or edit an object´s text attribute.
Select a style (a set of pre-defined property settings).
Save a set of property settings as a style, or edit the property settings of an existing style.

The property sheet contains the following controls:
Attribute. To give selected objects a text attribute, click in the Attribute text box and type in whatever 
information you want to record. You might, for example, want to record the part number or cost of a 
physical component represented in the drawing. The Attribute text field is used to hold the names of 
groups.
Layer. To set the layer property, which determines the layer on which entities are drawn, click on the 
Layer drop-down list box, then click on the desired layer. You can create new layers using the Layers 
dialog (Tools|Layers).
Style. A style is a set of saved property settings.

Selecting, Editing, and Creating New Styles 



Selecting, Editing, and Creating New Styles
To select an style that has already been defined, click the down arrow on the right side of the Style text 
box, the click to select the style from the drop-down list that appears. The property settings that define 
that style will now become the default property settings of the tool, the properties of which you are editing.
To edit an existing style:

1. Select the style from the drop-down list.
2. Make changes to settings in the Properties dialog, in any of the property sheets that are available in 

the dialog.
3. Click the OK button to close the dialog.

To create a new style:

1. If you like, select a style that you want to use as a basis for a new style. (If you skip this step, then 
you will use whatever style is currently selected.)

2. Select a style name in the text box and type a name for the new style.
3. Click the New button. This creates a new style that has all the property settings of the style you 

selected in step 1.
4. Make any changes you like to settings in the property sheets, then click the OK button. The property 

sheet settings will be saved in the new style, which will be available the next time you open the 
Properties dialog for the tool for which you are setting properties.

Notes 



Styles are applicable only if you are setting the default properties of a drawing tool. You cannot apply a 
style to selected objects, nor can you define a style based on the properties of selected objects.

There are separate sets of styles for points, single-line entities, double-line entities, arcs, curves, 
dimensions, and text. Circle and arcs share the same set of styles. The set of styles available to you 
depends on the tool whose properties you are modifying.



Pen Property Sheet
The Pen property sheet lets you set properties of the drawing pen, such as its pattern, color, and 
thickness.
The Pen property sheet contains the following controls:
Pattern. Scroll through this list to choose a pattern for the line. You can choose either a continuous line, or
one of many dot-and-dash patterns.
Alignment. Click this box if you want the pattern to align itself so that the corners of rectangles and 
polygons are always solid.
Color. Click in this box to choose a color for the drawing pen. If you select By Layer, the pen color will be 
set to the default color of the object´s layer. This color is set in the Layers property sheet.
Dash Scale. You can modify the factor in this box to set the scale of the pen´s dot-and-dash pattern. For 
example, if you set the scale to .5 (instead of 1, the default), the dots and dashes will be half the default 
scale, and the pattern will therefore be repeated twice as often.
Width Scaling. This setting determines whether the width of the line will be scaled, or remain the same 
size, when you zoom in and out of the drawing. If you select Device, the width will be scaled relative to 
your computer screen, and will remain the same size at any magnification. If you choose World, then the 
width will be scaled with your drawing, and will change size as you zoom in and out. This setting also 
applies to the size of the elements in the pen´s dot-and-dash pattern.
Width. Click in this box to choose a width for the pen, or type a custom width directly into the box. 

Note 
See Also 



You can create new colors using the Color Palette property sheet (Tools|Color Palette).



Layers Property Sheet 



Brush Property Sheet
The Brush property sheet lets you set fill properties of objects, as well as the properties of hatches. Fills 
appear only on closed entities, such as circles and polygons.

The Brush property sheet contains the following controls:

Pattern. To change the fill pattern, scroll through the Brush Style list box and click to select the pattern 
that you want. The name of the pattern will be displayed just above the Brush Style list box.
Color. To change the color of the fill, click on the Color drop-down list box, then scroll through the list and 
click to select the color that you want. Choose By Pen if you want the Brush color to match the Pen color. 
Choose By Layer if you want the color to match the default color of the object´s layer (set in the Layers 
property sheet).

Hatch. Use the Hatch controls to control the scale and angle of the fill pattern. The default scale of the 
pattern is 1, so increasing it to 2 doubles the size of the pattern elements, and decreasing the scale to .5 
halves the size of the components. Use the Angle spin button to change the angle of the hatch pattern, 
rotating it inside the filled entity (or type a custom value directly into the text box). If you check the Cross 
Hatch check box, the pattern will be drawn across the entity a second time, in a direction perpendicular to 
the first pattern. This gives you many more choices of hatch patterns.

Note 
See Also 



You can create new colors using the Color Palette property sheet (Tools|Color Palette).



Color Palette Property Sheet, Property Toolbar 



Curve Property Sheet
The Curve property sheet is visible only when a Bezier or spline curve entity is selected, or when the 
Bezier or spline curve tool is active and no entities are selected. This property sheet does not apply to 
sketch curves.
The Curve property sheet contains the following controls:
The number of segments between adjacent control points. Curves are composed of a number of 
miniscule line segments drawn between control points. Spline curves intersect the control points; Bezier 
curves gravitate toward the control points but do not intersect them. Use this spin control to set the 
number of line segments drawn between each control points. Large numbers will round the contours of 
the curve; small numbers will flatten out the contours.
Show Frame. Check the Show Frame check box to display a multiline frame connecting the curve´s 
control points. This provides visual feedback about how the curve is drawn.
Curve Type. Use the Curve type option buttons to set whether the curve is drawn as a Bezier or spline 
curve.

See Also 



Curve Tools 



Double Line Property Sheet
The Double Line property sheet is visible only when a double line entity is selected, or when a double line 
tool is active and no entities are selected. 

The Double Line property sheet contains the following controls:
Separation. To set the distance between the two lines of the double line, specify the distance in the 
Separation text box.
Reference. Use the Reference option buttons to determine the alignement of the double line nodes. 
These points determine how the double line will align itself to coordinate positions when you draw or 
position the line. You can set the double line nodes to align to its left line, its right line, or to a centerpoint 
exactly between the two lines. (You can edit these nodes directly in Node Edit mode).
End Caps. Click in the Start and End check boxes to determine whether the startpoint and endpoint of 
double lines are open or closed.

See Also 



Double Line Tools,Node Edit with Lines and Polygons 



Dimension Properties
Dimensions consist of three basic components: 

The dimension lines, with arrows pointing to either end of the dimension.
Extension lines, which connect the dimension line to the object being dimensioned.
Dimension text, normally displaying the distance being dimensioned in World units.

Extension lines have optional line segments that continue the extension outward beyond the dimension 
line (extensions to the extension).
A dimension can have interior dimension lines or two exterior dimension lines.
The Format property sheet contains options that let you format dimension arrowheads, and text position.

See Also 



Dimension Tools 



Format Property Sheet
The Format property sheet gives you control over the shape of dimension arrows and the position of text 
relative to the dimension line.
The Arrowhead group contains the following controls:
1st and 2nd. Click in these drop-down boxes to choose dimension arrow shapes. The arrowheads can 
have angles of either 30 or 45 degrees; they can be filled, open, or closed. If you like, you can choose 
None (no arrow at all), or Tick (a simple angled line). 
Size. Click in this control to choose a size for the length of the arrowhead, or type in a custom size.
Tick Extension. If you set the arrowhead to Tick in the 1st and 2nd boxes, you can specify the length of 
the tick´s extension line in the Tick Extension control.

The Text Position group contains the following controls:
Font. Click in this box to choose a TrueType font for the dimension text. All TrueType fonts installed on 
your system will be available.
Height. Click in this text box to choose a text height, or type in a custom height. You can set the height in 
either World or Paper units, depending on the current mode.
Position. Choose Outside if you want the text placed outside of the dimension line, Above if you want the 
text "above" the dimension line ("above" is relative to the orientation of the text, not relative to your 
screen), or On Line if you want to place the text directly on the dimension line. This position can be 
manually adjusted (see the next control).
On Line Adjustment. Type a number into this text box to specify the distance of the text above or below 
the dimension line. A value of zero (the default value) will place the text on the same level as the 
dimension line. Higher values move the text above the line ("above" is relative to the orientation of the 
text); lower (negative) values move the text below the line.
Force Text Horizontal. Check this box if you want the dimension text to be horizontal no matter how the 
dimension is rotated.
Force Dimension Text Inside Extension Lines. Click this box if you want to keep dimension text between 
the extension lines, regardless of the distance between the extension lines. If you leave this box 
unchecked, TotalCAD will decide whether to place dimension text inside or outside the extension lines.



Point Property Sheet
The point property is included in the properties dialog only when a point entity is selected, or when a point
tool is active. It includes settings for changing the size of a point, its shape, and its color.
The Point property sheet contains the following controls:
Size. Type a value in this box to set the width and height of the point. This value affects all types of points 
except the dot, which is always displayed at a minimal size. You can set the size in either World or Paper 
units, depending on the current mode. (Check the icon at the upper-left corner of the ruler to see whether 
TotalCAD is showing World or Paper units.)
Point Type. Click in an option button to select the type of point (dot, star, square, cross, or circle).
Color. Click in this box and scroll to choose a color for the point from the color palette.



Text Property Sheet
The Text property sheet is included in the Properties dialog only when a text entity is selected, or when 
the text tool is active. It includes options for setting font, style, height, color, text effects, and text 
justification.
The Text property sheet contains the following controls:
Font. Click on this box and scroll to select a TrueType font for the text. All the TrueType fonts that are 
installed in your system will be available.
Height. Click in this box and scroll to choose a text height, or type a custom text height directly into the 
box. You can set the height in either World or Paper units, depending on the current mode. (Note that text 
can be measured in points only if you are using Paper units.)
Style. Click in this box to choose a text style (Normal, Italic, Bold, or Bold Italic).
Color. Click in this box and scroll to select a color for the text from the color palette.
Effects. Check the options in this box to turn on any of these text effects: Underline, Strikethrough, Text 
Box (a simple border around the text), Hidden (used for notes that you don´t wish to display), and All 
Caps.
Justification. Click an option button to choose whether the text is left-, center-, or right-justified. When you 
are creating text, left-justified text is typed to the right of the insertion point; right-justified text is typed to 
the left of the insertion point, and center-justified text is centered on the insertion point.

Note 
Tip 



If you change the justification of existing text, the change will have an effect only if the existing text has 
multiple lines.



You can get more precise control of the placement of text relative to the insertion point by using the Align 
feature. You can access this feature by right-clicking in the drawing area while the Text tool is active, and 
then choosing the Align... command from the Local menu. The Align feature can only be applied to text as
it is being drawn; you can´t use it to format existing text.



Create Hatch
Menu: Format|Create Hatch Toolbar: Entity Format

The Create Hatch command applies a hatch pattern to selected entities. To apply the hatch:

1. If you wish to change the hatch pattern or other hatch settings, right-click on the Hatch tool to bring up
the Properties dialog, then click the Brush tab to bring the Brush property sheet to the front. 

2. Use the Brush property sheet to format the hatch pattern. Formatting a hatch pattern is essentially the
same as formatting a fill pattern, so you can refer to the Brush Property sheet topic for a description of
the property sheet options. 

3. Use the Select tools to select the object or objects that you want to hatch.
4. Click the Hatch tool (or choose Format|Hatch) to apply the hatch pattern to the selection.

Note 
See Also 



A hatch pattern, unlike a fill pattern, is an object independent of the objects to which it has been applied. 
You can select the hatch and manipulate it independently.



Brush Property Sheet 



Create Group
Menu: Format|Create Group

Use the Create Group command to combine any currently selected drawing objects into a group.

1. Use any selection method to select a set of drawing objects. You can select drawing entities or 
groups.

2. Click the Create Group tool or choose Format|Create Group from the menu.

See Also 



Groups, Explode



Explode
Menu: Format|Explode

Use the Explode command to break up any object into its constituent parts. You can explode an object or 
group of objects by selecting them, then choosing Format|Explode.
When you explode an object, you break it down to the next level of constituents. For example, you might 
explode a group that contains a group, a line segment, and some text. After exploding the outer group, 
you could then explode its constituents: the group into its parts, and the text into polylines.

Tips 
See Also 



You can use Explode to break hatch patterns into constituent entities, and to break text into polylines.

You can also explode double-line entities into groups of single-line entities. This is useful if you would like 
to scale the width of double lines along with an object that contains the double lines.



Create Group, Groups



Bring to Front and Send to Back
In a TotalCAD drawing, objects on each layer are stacked in the order that you create them, from back to 
front. The object at the front of the stack is visible on top of all other objects on its layer. The object 
furthest to the back of the stack is overlapped by all other objects on its layer.
TotalCAD provides two commands, Bring to Front and Send to Back, that will change the order of the 
entities in the stack, bringing the selection to the front, or sending it to the back.

Warning 
Tip 
See Also 



The Bring to Front and Send to Back commands will not function as you expect if the objects are on 
different layers and the layers have different redraw order values. The redraw order value of each layer is 
set in the Layers property sheet. Layers with higher redraw order values will always be in front of layers 
with lower redraw order values. If the objects are on different layers and the layers have equal redraw 
order values, then Bring to Front and Send to Back will work across layers.



If you want to systematically place some categories of objects in front of others, use the redraw order 
property of layers.



Layers Property Sheet 



Bring to Front
Menu: Format|Bring to Front

Use the Bring to Front command to bring any currently selected entites to the front of the entity stack. 
This command is especially useful when you are dealing with overlapping filled entities, or bitmaps.

1. Select the object or objects, using any selection method, that you want to bring to the front of the 
entity stack.

2. Choose the Bring to Front command.



Send to Back
Menu: Format|Send to Back

Use the Send to Back command to send any currently selected entites to the back of the entity stack. This
command is especially useful when you are dealing with overlapping filled entities, or bitmaps.

1. Select the object or objects, using any selection method, that you want to send to the back of the 
entity stack.

2. Choose the Send to Back command.

Note 



Sending an object to back has no effect on its layer, and changing its layer has no effect on its position in 
the entity stack. 



Align Commands
Use the Align commands to line up any currently selected objects. With all the Align commands except 
Along Line, the objects are lined up relative to the bounding box of the selection. The bounding box is a 
virtual rectangle that com-pletely contains all of the selected objects. (Because TotalCAD draws a frame 
around the objects you have selected, you can see the extents of the bounding box.)

Align Bottom 
Along the bottom of the bounding box.
Align Middle 
Along a virtual horizontal line passing throught the vertical center of the bounding box.
Align Top 
Along the top of the bounding box.
Align Left 
Along the left edge of the bounding box.
Align Center 
Along a virtual vertical line passing throught the horizontal center of the bounding box.
Align Right 
Along the right edge of the bounding box.



Align Bottom
Menu: Format|Align Bottom Toolbar: Entity Format

Use Align Bottom command to align the bottom edges of the currently selected objects along the bottom 
of the selection´s bounding box.

1. Select all the objects that you want to align, using any selection method. TotalCAD will create a 
rectangular frame around the selection.

2. Choose the Align Bottom command from the menu or toolbar.



Align Middle
Menu: Format|Align Middle Toolbar: Entity Format

Use the Align Middle command to center the selected objects vertically in the selection´s bounding box.

1. Select all the objects that you want to align, using any selection method. TotalCAD will create a 
rectangular frame around the selection.

2. Choose the Align Middle command from the menu or toolbar.



Align Top
Menu: Format|Align Top
Toolbar: Entity Format

Use the Align Top command to align the top edges of the currently selected objects along the top of the 
selection´s bounding box.

1. Select all the objects that you want to align, using any selection method. TotalCAD will create a 
rectangular frame around the selection.

2. Choose the Align Top command from the menu or toolbar.



Align Left
Menu: Format|Align Left Toolbar: Entity Format

Use the Align Left command to align the left edges of the currently selected objects along the left edge of 
the selection´s bounding box.

1. Select all the objects that you want to align, using any selection method. TotalCAD will create a 
rectangular frame around the selection.

2. Choose the Align Left command from the menu or toolbar.



Align Center
Menu: Format|Align Center Toolbar: Entity Format

Use the Align Center command to center the currently selected objects at the horizontal center of the 
selection´s bounding box.

1. Select all the objects that you want to align, using any selection method. TotalCAD will create a 
rectangular frame around the selection.

2. Choose the Align Center command from the menu or toolbar.



Align Right
Menu: Format|Align Right Toolbar: Entity Format

Use the Align Right command to align the right edges of the currently selected objects along the right 
edge of the selection´s bounding box.

1. Select all the objects that you want to align, using any selection method. TotalCAD will create a 
rectangular frame around the selection.

2. Choose the Align Right command from the menu or toolbar.



Modify Menu and Tools

The tools on the Modify menu are conventionally called CAD editing tools. These tools provide a variety 
of special editing functions for modifying the shape of entities.

Object Trim 
Defines entities as a cutting edge, then trims objects in and around the cutting edge.
Stretch 
Stretches an entity composed of line segments by moving a selected set of vertices.
Split 
Splits an entity into two entities.
Meet 2 Lines 
Shrinks or extends two lines or double lines so that two of their endpoints form a clean intersection.
Chamfer 
Joins two line segments or double line segments with a flattened corner.
Line Length 
Changes the length of a line while retaining its connection with other lines in a polygon or multiline.
Shrink/Extend Line 
Changes the length of a line so that it precisely meets another entity.
Arc Complement 
Reverses the starting and ending angles of an arc.
Fillet 
Connects two lines, either single or double lines, with a smoothly fitted arc.
T-Meet 2 Double Lines 
Forms a clean T intersection of two double lines.
Intersect 2 Double Lines 
Forms a clean X intersection of two double lines.

Note 



There is practical distinction between the tools on the Modify menu and those on the Edit menu. When 
you use the Edit menu tools, you must first select the object or objects that you want to edit. The Modify 
menu tools are similar to the drawing tools, in that you first activate the tool, then follow a series of steps 
to complete the edit. When you finish the edit, the tool remains active, so that you can either begin a 
second editing operation of the same type, or switch to another tool.



Object Trim
Menu: Modify|Object Trim Toolbar: Modify

Object Trim is a powerful editing tool that lets you define an entity or set of entities as a cutting edge. You 
can then cut out any parts of the drawing in or around the cutting edge tool, leaving only the parts of the 
drawing that you want to keep. You can trim any part of the drawing that touches the cutting edge. To use 
Object Trim:

1. Draw a new entity (or a set of entities) over an existing entity in such a way that the new entity defines
areas of the existing entity that you want to remove. You might, for example, want to use a circle to 
remove the ends of intersecting lines that fall outside of the circle.

2. Activate the Object Trim tool.
3. Click on the new entity to define it as a cutting edge. You can continue to add entities to the cutting 

edge by holding down the <Shift> key and clicking on additional entities.
4. Click on parts of the drawing in or around the cutting edge to remove it from the drawing. TotalCAD 

will not allow you to remove the last remaining part of the drawing touching the cutting edge.

Warning 



Object trim will not work with certain complex entities, specifically curves, dimension, and text. To use the 
tool on these types of object (as well as on groups), you must first select the object that you want to trim, 
then use the Format|Explode command to break the entity into simple sub-entities. In the case of text, you
must explode the entity twice (first into groups of multilines, then into multilines).



Stretch
Menu: Modify|Stretch Toolbar: Modify

Use the Stretch tool to move groups of nodes on any object or set of objects. This has the effect of 
stretching (or shrinking) the object by relocating the selected set of nodes. To move the nodes you use a 
vector line, similar to the vector line used in the Vector Copy command.

1. Choose the Stretch tool.
2. Click to define the first corner of the selection rectangle. Drag the mouse over the drawing so that the 

rectangle encloses all of the nodes (vertices) that you want to move, then click to complete the 
selection rectangle. A small rectangle will appear at each of the nodes that you have selected.

3. Define the first point of a vector line, either by clicking the mouse (using any snap mode), or by 
entering the point´s coordinates in the status bar.

4. Specify the length and angle of the vector. You can do this either by directly entering the length and 
angle in the edit bar, or by defining the vector line´s second point. You can define the second point 
using either the mouse (with any snap mode), or by entering the point´s coordinates in the status bar.

All of the selected nodes will move, from their original locations, the length and angle defined by the 
vector line. The objects in which the nodes were selected will stretch, shrink, or move accordingly.

Note 
See Also 



If you select all of the nodes on any entity, the entire entity will simply be moved (as with the Vector Copy 
command). This is also the effect if you select any node on a circle or arc.



Node Edit 



Split
Menu: Modify|Split Toolbar: Modify

Use the Split tool to divide an entity into two separate entities. This tool works on any single-line or 
double-line entity, as well as on circles, and arcs. 

Splitting Line and Double Line Entities 
Splitting Arcs and Circles 

Note 
See Also 



You can also use this tool to split curves and other complex entities, but you need to explode the entity 
first.



Explode 



Splitting Line and Double Line Entities
You can use the Split tool to split entities into two parts. 

1. Activate the Split tool.
2. Click on the line or double-line that you want to split: Let´s call this the target. TurboCad draws a 

perpendicular line intersecting the target.
3. Move the mouse cursor until the perpendicular line is at the point where you want to split the target.
4. Click to split the target.

Note 



If the target is a closed entity (a rectangle or    polygon), then you will need to split the entity in two places 
to divide it into two entities.



Splitting Arcs and Circles
To divide an arc into two arc segments:

1. Choose the Split tool.
2. Click on the arc that you want to split. A dotted line appears, connecting the cursor to the centerpoint 

of the arc.
3. Click to define the angle at which to split the arc.

Splitting a circle is the same as splitting an arc, except that at step 3 you need to define a starting and an 
ending angle (breaking the circle in two places).



Meet 2 Lines
Menu: Modify|Meet 2 Lines Toolbar: Modify

Use the Meet 2 Lines function to shrink or extend two lines or double lines so that two of their endpoints 
meet. This function automatically cleans up the corner formed by two double lines. 

1. Activate the Meet 2 Lines tool.
2. Click on the first, then the second line or double line.

When the two lines are crossed, the two lines will be shrunk in the direction of the mouse clicks. In other 
words, the two parts of the line that you click on will be preserved; the parts of the lines on the opposite 
side of the intersection will be trimmed.



Chamfer
Menu: Modify|Chamfer Toolbar: Modify

Use the Chamfer tool to join two line segments or double line segments with a flattened corner. You can 
also use the Chamfer Multiline option to chamfer all the corners of a multiline or polygon.
When you activate a chamfer tool, the values you can use to calculate the chamfer appear in the edit bar.

The Chamfer tool draws a chamfer between points on each line calculated by their distance from the point
of intersection on the first (Distance A) and second (Distance B) lines clicked:

1. Activate the Chamfer tool. 
2. Enter values for distances in the Dist. A and Dist. B fields of the Edit Bar. Dist. A is the distance on the

first line clicked. Dist. B is the distance on the second line clicked. Return to the drawing area by 
clicking there or pressing <Ctrl>+<D>.

3. Do one of the following:

Click the first line, then the second line.

Right-click in the drawing area to open the local menu, then choose Multiline to 
chamfer all the corners of an multiline or polygon.



Line Length
Menu: Modify|Line Length Toolbar: Modify

Use the Line Length tool to to extend or shrink a line segment from either endpoint. If the line segment is 
part of a multiline or polygon, as you change the length of the line segment,it retains its relationship to 
other lines within a multiline or polygon. This means that lines connected to the line endpoint you are 
moving will also change angle and length so that they remain connected to the endpoint.

1. Activate the Line Length tool.
2. Click on a line segment at a position near the endpoint that you want to modify. The segment now 

extends from the endpoint furthest from the mouse to the mouse cursor.
3. You can now set the line length in one of three ways:

Enter an absolute length for the line in the Length field of the edit bar, then press <Enter>.
Enter the amount that you want to lengthen the line in the Delta L field of the edit bar (enter a 

negative value to shorten the line) then press <Enter>.
Drag the mouse to lengthen or shorten the line, then click when it is the length you want.



Shrink/Extend Line
Menu: Modify|Shrink/Extend Line Toolbar: Modify

Use the Shrink/Extend to Object editing tool to edit the length of a line so that it precisely meets another 
entity. You can either extend the line, increasing its length until it meets the other entity; or you can shrink 
the line, decreasing its length until it just meets the other entity. To use this tool:

1. Activate the Shrink/Extend to Object tool.
2. Click on the line or double line that you want to shrink or extend.
3. Click on the entity to which you want to shrink or extend the line. TotalCAD will adjust the length of the

line or double line until it precisely meets the second entity.



Arc Complement
Menu: Modify|Arc Complement Toolbar: Modify

Use the Complement tool to reverse the starting and ending angles of an arc. If, for example, the arc is 
drawn from 0 degrees to 90 degrees, the complement of the arc will be drawn from 90 degrees to 0 
degrees.
To change an arc to its complement, first choose the Arc Complement tool, and then click on the arc that 
you want to modify.



Fillet
Menu: Modify|Fillet Toolbar: Modify

Use the Fillet tool to connect two lines, either single or double lines, with a smoothly fitted arc. The result 
is a rounded corner. The Multiline option of this tool allows you to fillet all of the corners of a multiline or 
polygon simultaneously.
TotalCAD inserts an arc of a specified radius between two intersecting lines, making the arc tangent to 
both lines. The start and end angles for the arc are determined by the points at which the arc is tangent to
the two lines. TotalCAD then trims or extends the lines to form the smooth corner.

1. Activate the Modify|Fillet tool.
2. Enter the radius for the filleted arc in the Radius text box on the edit bar and press <Enter>. (If the 

edit bar is not visible, diplay it using View|Toolbars.)
3. Do one of the following:

Click the first line, then the second line.

Right-click in the drawing area to open the local menu, then choose Multiline to fillet all the 
corners of an multiline or polygon.

Note 



If the radius specified is too large for the arc to fit between the two lines, or if you specify a radius of zero, 
TotalCAD will be unable to perform the fillet, and will display an error message. 



T-Meet 2 Double Lines
Menu: Modify|Length Toolbar: Modify

Use the T-Meet 2 Double Lines tool to form a clean T intersection of two double lines. The first line clicked
will extend or shrink to form the stem of the T.

1. Click on the line that will form the stem of the T.
2. Click on the line that will form the top of the T.



Intersect 2 Double Lines
Menu: Modify|Length Toolbar: Modify

Use the Intersect 2 Double Lines tool to clean up the intersection of two double lines. 

1. Activate the Intersect 2 Double Lines function.
2. Click on the first, then the second of two intersecting double lines.



Modes Menu and Tools
Snap Tools 
Set the current snap mode.
Coordinate System 
Set the current coordinate system.



Snap Tools

Menu: Modes|Snaps Toolbar: Snap

Combining Snap Modes 
No Snap 
Turn off all snap modes; point is defined at the location of the mouse click.
Snap to Vertex 
Snap to the nearest end of a line segment, endpoint of an arc, or corner of a polygon or multiline.
Snap to Near Point 
Snap to the nearest point on any entity.
Snap to Midpoint 
Snap to the midpoint of a line segment.
Snap to Arc Center 
Snap to the center of an arc or circle.
Snap to Quadrant Point 
Snap to the nearest quadrant point (at 0, 90, 180, or 270 degrees) on the circumference of a circle or arc.
Snap to Intersection 
Snap to the nearest intersection of two line segments.
Snap to Grid 
Snap to the nearest grid point or intersection of grid lines.
Ortho 
Constrain the angles of lines; the default settings constrain them to 0, 90, 180, or 270 degrees. (You can 
change these settings in the Angle property sheet.)
Magnetic Point 
Increase visual feedback; the rubber band line you are currently drawing will gravitate toward the snap 
point.



Combining Snap Modes
Some snap modes can be combined with one another, and some are mutually exclusive. No Snap turns 
off all other snap modes. Near Point snap (which snaps to the nearest point on any object) also turns off 
all other snap modes. (Ortho and Magnetic point can stay on no matter which snap modes are active.)
The remaining snap modes all snap to a particular    node (nodes are key points that define the object 
geometrically), and they are not mutually exclusive. You can, for example, have Snap to Grid and Snap to
Vertex on simultaneously. If you then click the mouse while a grid point and a line segment are both within
the snap aperture, your point will snap to either an endpoint of the line segment, or to the grid point, 
whichever is closest to the mouse cursor.

Note 



The snap modes that can be used at the same time are all in the same section of the Modes|Snaps 
submenu.



No Snap
Menu: Modes|Snap|No Snap Toolbar: Snap

Activating No Snap will turn off all snap modes except Ortho. With snap modes turned off, you define 
points by simply clicking at the point that you want to define in the drawing area, or by entering the point´s
coordinates on the status bar.

Note 
See Also 



If Ortho mode is on, the second point of a line will snap to a point to constrain the angle of the line, even if
No Snap mode is active.



Ortho 



Snap to Vertex
Menu: Modes|Vertex Toolbar: Snap

When Snap to Vertex mode is active, the point you are defining will snap to the nearest vertex on an 
entity within the snap aperture. A vertex in TotalCAD can be:

The endpoint of any line segment (either a simple line or a segment of a multiline).
A corner of a polygon.
The endpoint of an arc.

 Note



When snapping to a double line, your point will be defined at the endpoint of either of the single line 
segments that comprise the double line, not to the double line´s reference point.



Snap to Nearest on Graphic
Menu: Modes|Snap|Nearest On Graphic Toolbar: Snap

When Snap to Near Point mode is active, a point will be defined at the nearest point on an object within 
the snap aperture.



Snap to Midpoint
Menu: Modes|Snap|Middle Point Toolbar: Snap

When Snap to Midpoint mode is active, the point you are defining will snap to the midpoint of a line 
segment. A line segment can be any part of an entity, such as one of the lines in a double line, or a 
segment of a multiline or polygon.



Snap to Arc Center
Menu: Modes|Snaps|Arc Center Toolbar: Snap

When Snap to Arc Center is active, the point you are defining will snap to the center of an arc or circle 
that you indicate. To indicate the arc or circle, click on or near its perimeter.



Snap to Quadrant Point
Menu: Modes|Snaps|Quadrant Point Toolbar: Snap

When Snap to Quadrant Point is active, the point you are defining will snap to the nearest quadrant point. 
Quadrant points are at 0 degrees, 90 degrees, 180 degrees, and 270 degrees on the circumference of an 
arc or circle.



Snap to Intersection
Menu: Modes|Snaps|Intersection Toolbar: Snap

When Snap to Intersection is active, the point you are defining snaps to the intersection of two lines. Both 
lines must be located within the snap aperture; but the intersection need not be located within the snap 
aperture.



Snap to Grid
Menu: Modes|Snaps|Grid Toolbar: Snap

When Snap to Grid is active, the point you are defining snaps to the nearest grid point, or to the nearest 
intersection of grid lines, if the grid is being displayed in lines rather than points or crosses.

See Also 



Grid Property Sheet



Ortho
Menu: Modes|Snaps|Ortho Toolbar: Snap

Ortho mode constrains the angle of the entity you are drawing. By default, ortho mode will constrain the 
angle of the entity so that it will be parallel to either the X or Y axis of the drawing. You can change these 
default settings in the Angle property sheet.

See Also 



Angle Property Sheet 



Magnetic Point
Menu: Modes|Snaps|Show Magnetic Point Toolbar: Snap

Magnetic Point provides visual feedback about the location of snap points. When this mode is active, as 
you move the mouse cursor within a critical distance from the snap point, the rubber band line will be 
attracted to the snap point, showing you its exact location. Unless speed is a consideration on your 
computer, or unless you are working on a very large drawing, it is probably useful to have this mode on all
the time.

See Also 



Snap Aperture 



Coordinate System
Menu: Modes|Coord System Toolbar: Snap

The coordinate system menu commands enable you to change between absolute, relative, and polar 
coordinates, and to relocate the origin of the relative and polar coordinate systems.:

Coordinates: Absolute 
Change to absolute Cartesian coordinates, in which you define points by their distance from a fixed 
(absolute) point of origin.
Coordinates: Relative 
Change to the relative coordinate system, in which you define points by their X and Y distance from the 
Relative Origin point.
Coordinates: Polar 
Change to the polar coordinate system, in which you define points by their distance and angle from the 
Relative Origin point.
Relocate Origin 
Change the position of the Relative Origin point.

See Also 



Coordinate Systems 



Coordinates: Absolute
Menu: Modes|Coord System|Absolute Toolbar: Snap

Use the absolute coordinate system to work in absolute Cartesian coordinates. When working in absolute 
coordinates, you define points by their X and Y distances from the Absolute Origin. This fixed point, 
absolute (0,0) is located by default at the lower-left corner of the drawing page (although the page can be 
moved using the Page Setup dialog).
For example, to draw a horizontal line two units long starting at (2,2), you would define the line´s second 
point at (4,2).

See Also 



Coordinate Systems



Coordinates: Relative
Menu: Modes|Coord System|Relative Toolbar: Snap

Use the relative coordinate system to work in relative Cartesian coordinates. When you work in relative 
coordinates, you define the location of points relative to the Relative Origin (relative (0,0)). To define a 
point relative to the current position, you can enter X and Y displacement values in the Coordinate Fields. 
You can enter either positive or negative values. The displacement values specify the distance of the new 
point from the Relative Origin.

Note 
See Also 



The Relative Origin moves whenever you define a new point. In most cases, the Relative Origin will be 
the last point you defined. If you are drawing a circle or arc, however, the Relative Origin will be at the 
center of the circle or arc.



Coordinate Systems, Relocate Origin, Program Setup Dialog 



Coordinates: Polar
Menu: Modes|Coord System|Polar Toolbar: Snap

Use the polar coordinate system when you want to define points by their distance and angle from the 
Relative Origin Point. When you start a new drawing, this point is located at the same position as the 
Absolute Origin Point, at absolute (0,0). You can move the Relative Origin Point using the Relocate Origin
command.
Let´s say, for example, that you have defined the first point of a line in any coordinate system, and you 
want to draw a line exactly 3.5 units long at a 45 degree angle from the first point. You can accomplish 
this by following these steps:

1. If you are in another coordinate system, switch to polar coordinates.
2. Type 3.5 into the length text box on the status bar.
3. Type 45 into the angle text box on the status bar, then press <Enter>.

See Also 



Coordinate Systems 



Relocate Origin
Menu: Modes|Coord System|Relocate Origin Toolbar: Snap

Use the Relocate Origin command to manually relocate the Relative Origin point. When you start a new 
drawing, this point is located at the lower-left corner of the page, and appears as a red dot. You can 
relocate the point using any coordinate system; that is, you can specify its position in absolute, polar, or 
relative coordinates. To relocate the point of origin:

1. Choose Relocate Origin from the menu.
2. Define a point for the new origin by clicking the mouse in the drawing space or entering values in the 

status bar (the type of values you enter in the status bar depend on the currently active coordinate 
system).

See Also 



Coordinate Systems



Tools Menu and Dialogs
The following table summarizes the commands accessible from the Tools menu. Only the major menu 
items are shown. The indented items on the menu are shortcuts that go directly to individual property 
sheets in the Program Setup and Drawing Setup dialogs. These property sheets will be described in detail
in the following sections.

Program Setup Dialog 
Display the Program Setup dialog, in which you can set options that are saved when you exit TotalCAD.
Drawing Setup Dialog 
Display the Drawing Setup dialog, in which you can set options that are saved with your drawing.



Program Setup Dialog
Menu: Tools|Program Setup

The Program Setup dialog contains five property sheets for controlling TotalCAD program settings:

General Property Sheet 
Specify template, read-only file access, user information, snap aperture, zoom factor, save, and advanced
settings.
Desktop Property Sheet 
Display and hide user-interface controls,    control desktop colors and paper display.
Groups Property Sheet 
Set options for naming groups.
File Location Property Sheet 
Specify directories for autosave, backup, and template files.
Color Palette Property Sheet 
Add new colors to the palette, modify existing colors, and delete colors from the palette. 
You can access each of these property sheets directly from the Tools menu, which gives you the 
convenience of opening the Program Setup dialog with the correct property sheet in front using a single 
command. The options that you set in this dialog are saved when you exit TotalCAD, and will remain in 
effect the next time you start the program.



General Property Sheet
Menu: Tools|Program Setup

In the General Property sheet, you can set general program options and user information. The controls on
this property sheet enable you to:

Set the default template used when you start a new drawing, and specify whether TotalCAD will 
prompt you for a template when you start a new drawing.

Specify whether drawings are opened as read only files.
Read and update user information.
Set the zoom factor and snap aperture.

The General property sheet contains the following controls:
Default Template for New Files. If you do not specify a template when you start a new drawing, TotalCAD 
will use a default template. To change the default template, click the arrow on the right side of the drop-
down list and choose a template (or type a template name directly into the box).
Prompt for Template Name. Check this box if you want TotalCAD to prompt you for a template whenever 
you start a new drawing. If you want to use the default template without being prompted, clear this check 
box.
Open All Files as Read Only. There may be times when you want to look at drawing files without changing
them, or prevent them from being inadvertently changed by someone else. Check this box to prevent 
anyone using TotalCAD from changing existing files. To restore the ability to change files, clear the check 
box.
User Information. The User Information text fields contain the user and company name.
Snap Aperture. The snap aperture is a circular area around the mouse cursor. TotalCAD will detect and 
snap to a potential snap point only if it is within the snap aperture. (Which points qualify as potential snap 
points depends on the current snap mode.) You can set the radius of the snap aperture using the snap 
aperture control. 
Zoom Factor. The zoom factor setting controls how much you zoom in or out of the drawing when you use
the Zoom In (<Gray +>) or Zoom Out (<Gray ->) command. The default zoom step setting is 2, which is a 
factor, meaning that if you zoom in one step, objects will be twice as big; if you zoom out one step, objects
will be half as big, and the area of the drawing shown in the view will double. You can set the zoom step 
to any number between 1.01 and 2000.

Save Options 
Advanced Settings 

Tip 
See Also 



You can view the Snap Aperture as you work by choosing View|Aperture.



Save As Dialog, Open Dialog, New, Snap Aperture, Snap Modes, Snap Tools, View Crosshairs, Zoom In, 
Zoom Out, Zoom Commands 



Save Options
The General property sheet includes several controls that allow you to control aspects of how TotalCAD 
saves drawing files.
Prompt for summary information. If this box is checked, TotalCAD will display the Summary Information 
dialog, in which you can record information about your drawing, the first time that you save any drawing to
disk, and whenever you use Save As to save a new copy of the file.
Make backup copies. If this box is checked, TotalCAD will automatically make backup copies of your 
drawings whenever you save them. You can choose either the On First Save or On Every Save option 
button to determine how often TotalCAD saves your backup files. Backup files share the same file name 
as the drawing file, but have the file extension .BAK instead of .TCW. By default, backup files are saved in
the same directory as your primary drawing files. You can specify another directory in the File Location 
property sheet of this dialog.
Save drawings every. If this box is checked, TotalCAD will make autosave copies (.ASV files) of your 
document automatically at regular intervals. You can set the duration of the intervals in minutes using the 
Minutes control just below the check box.
Save desktop on exit. If this box is checked, TotalCAD will save the desktop settings when you exit the 
program. This means that TotalCAD will "remember" which toolbars and other controls you have 
displayed, as well as their positions on the desktop, and will display them exactly the same way the next 
time you start the program.

See Also 



Save, Save All, Save As Dialog, Desktop Property Sheet 



Advanced Settings
Fixed Relative Origin. Check this box if you want to fix the Relative Origin in place while you are in relative
or polar coordinates. You will have to relocate the Relative Origin manually using the Modes|Relocate 
Origin command.

See Also 



Coordinate Systems



Desktop Property Sheet
Menu: Tools|Desktop

The Desktop property sheet contains controls that let you:

Display and hide toolbars and other interface controls.
Display and hide the paper margins and background.
Set the color of the paper and background.
Set the zoom factor.

The Desktop property sheet contains the following controls:
Toolbar Controls 
Desktop Controls 
Paper Margins and Background 
Desktop Colors 

Note 
See Also 



Many of the functions available on the Views property sheet are also available from the View menu.



View Toolbars, View Grid, View Crosshairs, View Rulers, View Edit Bar, View Symbol Library, View 
Selection Info, Zoom In, Zoom Out, Zoom Commands 



Toolbar Controls
Toolbars. The Toolbars scrolling list displays the names of all the toolbars available in TotalCAD. Toolbars 
that are currently displayed are checked. To display a hidden toolbar, scroll through the list and click on 
the check box next to the name of the toolbar, displaying the check. To hide a currently displayed toolbar, 
click on the box, removing the check.
Color Buttons. Check this box for color buttons, clear it for grayscale buttons.
Large Buttons. Check this box for large buttons, clear it for standard size buttons.
Show Tooltips. Check this box to display tooltips (the yellow boxes that appear under the button if you 
hold the mouse cursor over them); clear the box to suppress display of tooltips.

Note 



This function is also available in the View Toolbars dialog.



Desktop Controls
The Views property sheet contains a number of check boxes that control the display a variety of user 
interface controls and palettes, specifically:

Edit Bar
Status Bar
Scroll Bars
Rulers

Checking a box displays the corresponding control; clearing the box hides the control.

Tip 



It´s a good idea to switch off controls that you don´t use, because this increases the size of your drawing 
area.



Paper Margins and Background
The Paper Display control group lets you display or hide the paper margins, and set whether the 
background behind the paper is colored or white:

Margins. Check this box box to display page margins; clear the box to hide page margins.
Background. Check this box to display a background behind the paper; clear the Background 

check box to display a white background.
Tip 



You can switch off the paper until you´re ready to print, then use the Fit feature of the Page Setup Dialog 
to place your drawing on the page.



Desktop Colors
The Desktop Color control group contain buttons for customizing the color of the paper, background, and 
floating palettes. Click in the drop down box and Select Paper, Background, or Floater. Click the Modify 
button to change the color using the Color Picker.

See Also 



Using the Color Picker 



Groups Property Sheet
Menu: Tools|Groups

The Groups property sheet lets you control whether and how TotalCAD generates names for groups , and
set whether TotalCAD prompts for group names.
Groups Options 
Automatic Group Numbering 

Tip 
See Also 



The name of a group is displayed on the General property sheet of the Properties dialog. To view this 
dialog, you can simply double-click on a group.



Create Group, Properties 



Groups Options
The following controls let you determine how TotalCAD handles the naming of groups:

Generate group names. If this option is checked, TotalCAD automatically generates a name 
whenever you create a group.

Group name prefix. If the Generate Group Names option is on, you can type a string (a series of 
characters) into the Group Name Prefix text box, and TotalCAD will use this string to automatically 
generate group names. All the characters that you type into the box are used literally, except the ´@´ 
character, which is a placeholder for a group number that TotalCAD generates automatically. You can type
the ´@´ character in the name at the place where you want the automatic number to appear. For an 
explanation of how this works, see Automatic Group Numbering.

Prompt for name. Check this option if you want TotalCAD to prompt you for a name every time 
you create a new group.

Note 
Tip 
See Also 



If you turn off both the Prompt    for Name and Generate Group Names options, TotalCAD will not name 
groups.



You can subsequently name or rename a group by editing its properties. To do this:

1. Select the group that you want to rename.
2. Double-click on the group to bring up the Properties dialog.
3. Type a name for the group into the Attribute text field, then press <Enter> to close the dialog.



Create Group, Explode, Properties 



Automatic Group Numbering
When TotalCAD creates a group name, it automatically gives the group a number, which increases by 1 
whenever you add a new group to the drawing. This ensures that all groups have unique names. By 
default, the names that TotalCAD generates are "Group 1", "Group 2", and so forth.
You can change the default that TotalCAD uses for automatically naming groups in the Group Name 
Prefix text box. The names that you type in this text box have two parts: the name itself (any series of 
characters), and the ´@´ character, which is a placeholder for the automatic number. You can place the 
´@´ character anywhere in the name, to specify where TotalCAD will place the automatic number.
For example, if you type "Part @" in the Group Name Prefix text box, then create the first group in a 
drawing, the group will automatically be named "Part 1", and the next group you create will be named 
"Part 2". If you type "#@ gear" into the Group Name Prefix text box, then create the first group in a 
drawing, the group will be named "#1 gear", and the next group you create will be named "#2 gear".

Note 
See Also 



The first ´@´ that you include in the name is a placeholder for the automatic number. Any ´@´ characters 
that occur after the first one will be part of the literal name.



Create Group, Groups Options



File Location Property Sheet
Menu: Tools|File Location

The File Location property sheet allows you to specify the directories where TotalCAD places these 
different types of program files:
Autosave (.ASV). These are program files that TotalCAD saves automatically, if this option is turned on in 
the Save property sheet. These will allow you to restore work that would otherwise be lost due to a 
system crash.
Backup (.BAK). These are copies of drawing files that TotalCAD saves, if you check the Make Backup 
Copies option in the Save property sheet.
Templates (.TCT). Files in which you save settings as well as symbol libraries that you can start with as 
the basis of a new drawing.

To specify a directory in which to place a type of file:

1. In the list box, select the file type for which you want to specify a directory.
2. Click the modify button. TotalCAD will display a standard Windows Open dialog.
3. Use the standard Windows dialog to navigate to the drive and directory where you want to place the 

files. Click Open (or OK if you are using Windows 3.1) to accept the directory.

 Tip 



If you have two disk drives (or access to a network drive), if is wise to have your backup files 
automatically saved to a second drive. If the drive that contains your drawing files is damaged, you can 
recover your backup files from the second drive.



Color Palette Property Sheet
Menu: Tools|Colors

The Color Palette dialog displays the all the colors that are currently available. These colors and their 
names are displayed in a scrolling list, and also in a palette control to the right of the scrolling list. The 
Color Palette dialog lets you add new colors to the palette, modify existing colors, and delete colors from 
the list.
Adding a New Color 
Modifying an Existing Color 
Deleting a Color 
Picking Colors with the Mouse 
Setting RGB Values 
Setting Hue, Saturation, and Value 



Adding a New Color
To add a new color:

1. Type a name for the color in the Color text box.
2. Click the New button, which displays the Color Picker dialog.
3. Use the Color Picker dialog to define a new color, then click the OK button.

The new color that you defined will appear in the scrolling list and palette controls. This color will now be 
available for formatting the pen and brush colors of objects.

See Also 



Using the Color Picker 



Modifying an Existing Color
To modify an existing color:

1. Select the color that you want to modify in the scrolling list or in the palette control.
2. Click the Modify button, which displays the Color Picker dialog.
3. Use the Color Picker dialog to redefine the color, then click the OK button.

Notice that the color is now changed in the scrolling list and palette controls. The modified color will now 
be available for formatting the pen and brush colors of objects.

See Also 



Using the Color Picker 



Deleting a Color
To delete a color that you no longer need to use in a drawing:

1. Select the color in the scrolling list or in the palette control.
2. Click the Delete button.

Note 



Objects that have already been colored in a color that you delete will still have the deleted color.



Using the Color Picker
The color picker lets you specify colors that you can add to your drawing´s color palette, or use to replace 
an existing color in the palette. The dialog contains a color wheel, which displays a spectrum of available 
colors, and a scrollbar with which you can control the overall brightness of the colors on the wheel. It also 
contains controls that let you define a color by directly entering its RGB (Red, Green, Blue) values, or by 
specifing its Hue, Saturation, and Value, which correspond to positions on the color wheel and scrollbar.
A lower color display box to the left of the color wheel gives you visual feedback about the color you have 
chosen. If you are modifying an existing color, the original color will be displayed in the upper color display
box.



Picking Colors with the Mouse
To pick a color with the mouse:

1. Set the overall brightness of the color wheel using the scroll bar to the right of the wheel.
2. Click at the position on the wheel that is the color and shade you want.

An example of the color you have picked will appear in the color display box to the left of the color wheel.



Setting RGB Values
Screen colors can be defined by a combination of Red, Green, and Blue (RGB) values. Each of these 
values can be set to an integer from 0 to 255. For example, an RGB setting of (0,0,0) is black; an RGB 
setting of (255,255,255) is white. A setting of (255,0,0) is "pure" red, and a setting of (0,255,255) is Cyan.
To define a color by its RGB values, enter the values in the R, G, and B controls on the dialog. Notice that
the color in the lower color display box changes to correspond to the values you have entered, and the 
position of the color picker on the color wheel changes as well.



Setting Hue, Saturation, and Value
Hue and Saturation settings correspond to physical positions on the color wheel. Hue represents an 
angular position on the wheel measure in degrees (corresponding to the color spectrum), and can have a 
value from 0 to 360. Saturation represents a radial position on the wheel (corresponding to the amount of 
"grayness" in the color), and can have values from 0 to 255. Value controls the overall brightness on the 
color wheel, so changing the value in this control is the same as using the scroll bar to the right of the 
color wheel.



Drawing Setup Dialog
Menu: Tools|Drawing Setup

The Drawing Setup dialog includes five property sheets containing settings that are saved in a drawing or 
template file.
Grid Property Sheet 
Choose the grid type and other grid options.
Symbol Libraries Property Sheet 
View and maintain symbol libaries in current drawing or template.
Units and Scale Property Sheet 
Set the unit of measure, the drawing scale, and related options.
Angle Property Sheet
Choose direction, units, and base angle for angular measurements.
Layers Property Sheet 
Create new layers, modify existing layers, and delete layers.



Grid Property Sheet
Menu: Tools|Grid

The grid is a matrix, displayed as a pattern of dots, crosses, or lines, that divides your drawing 
geometrically into Cartesian or polar coordinate locations. 
The Grid property sheet allows you to customize the grid. The following topics describe the controls of the
Grid property sheet.
Spacing 
Divisions
Frequency
Colors 
Show Grid Checkbox 



Grid Spacing
The spacing of the grid determines how far apart the grids or lines of the grid are spaced from one 
another. For example, if spacing is set to one foot, points on the grid will be spaced a foot apart. Grid 
spacing is set in either World or Paper units, whichever is currently being used.

Note 



Grid spacing applies to every grid point, regardless of whether it is a minor or major grid point, and 
without regard to the frequency of the grid.



Grid Frequency
The Frequency settings lets you alternate visible grid lines with invisible grid lines. For example, if you set 
the frequency    2, then every other grid line will be displayed. If you set frequency to 4, then every fourth 
grid line will be displayed. You will still be able to snap to the invisible grid lines.

Warning 



Don´t confuse this with whether the grid itself is visible. If you make the grid invisible using View|Grid, 
then the whole grid will be invisible. 



Divisions
Divisions determines the number of minor grid divisions between major grid divisions. You can set the 
number of divisions between each major grid point using the spin button control near the option button.



Color
Click the buttons in the Color group to set choose a new color for the major and minor grid. Click the 
Major or Minor button, then choose a color using the Color Picker.

See Also 



Using the Color Picker



Show Grid Checkbox
The Grid property sheet also contains these controls:
Hide grid when finer than... You can type a value in this box to control how fine a grid can be drawn on the
screen. When the grid becomes finer than this value, it will not be drawn. Note that this value applies to 
distances on your computer screen, which are not related to World or Paper units.
Show grid. Check this box to display the grid. This is the same as choosing View|Grid from the menu.



Symbol Libraries Property Sheet
Menu: Tools|Symbol Libraries

TotalCAD 1.0 symbol libraries are actually just Windows folders that contain TotalCAD drawings. This 
dialog associates descriptive names with folders that you want to use as symbol libraries. Once you 
create names for the symbol libraries in your drawing, you can easily switch between the named symbol 
libraries using the Symbol Library palette. These libraries will be saved with your drawing, or in a template
if you save your drawing as a template.
Adding a New Symbol Library 
Deleting a Symbol Library Name 
Changing the Symbol Library Association 

See Also 



View Symbol Library 



Adding a New Symbol Library
The Add button lets you associate a descriptive name with a symbol libary.

1. Type a name for the library in the Name text box.
2. Click the Add button. TotalCAD will display the standard Windows Open dialog. Use the dialog to 

choose the folder containing the library, then click OK to return to the Drawing Setup dialog.

When you select a library, its name, as well as its file name and path, appear in the property sheet´s list 
box.



Deleting a Symbol Library Name
To delete a symbol library´s descriptive name from the list, select its name in the list box, then click the 
Delete button. 

Note



Deleting a library name removes the library name from your drawing, but has no effect on the library´s 
folder or the drawing file contained in the folder.



Changing the Symbol Library Association
To associate a descriptive name with a different symbol library:

1. Select the symbol library name that you want to change by clicking on it in the Name list box.
2. Click the Modify button. TotalCAD will display the standard Open dialog. Use the dialog to navigate to 

directory with which to associate the symbol library name, then click OK to return to the Drawing 
Options dialog.



Units and Scale Property Sheet
Menu: Tools|Units and Scale

The Units and Size property sheet contains options for setting the drawing scale and for controlling the 
display of linear units.
The following sections describe the controls available on this property sheet.

Measuring System 
Scale 
Units in Work Space 
Use Paper Space Coordinates 

Tip 



TotalCAD´s built-in templates and wizards can help you set up your drawing space when you start a new 
drawing. This property sheet is for cases when you want to set up your units and scale manually.



Measuring System
The Measuring System control group contains two general settings, English and Metric. Choosing either 
of these settings will select different sets of options to choose from in the other controls of this property 
sheet. 



Scale
Scale is the ratio of measurements on the page (Paper units) to measurements in the object being 
modelled (World units). TotalCAD lets you set the drawing scale using one of three standard systems: 
Architectural, Metric, and Absolute. If Metric is selected in the Measuring System group, then Absolute will
be the only choice available. The following table shows some sample drawing scales expressed in each 
of these systems:

System Example
Architectural 3/16´´ = 1´-0´´
Engineering 1"= 200´
Absolute 1:500

Use the Type drop down box to choose a system, then use the Scale box to choose a scale, or type in a 
custom scale.



Units in Work Space
Use the controls in this group to specify a unit of measure for your drawing:
World Units. Click in this drop-down list to choose a unit of measure. The choices that appear in the list 
will depend on whether English or Metric is selected in the Measuring System group.
Show All Units. Check this box if you want the World Units drop-down list to display all available units, 
regardless of whether English or Metric is selected in the Measuring System group.
Format. Click in this box to choose a format for the display of numbers. The choices available in this box 
will be limited to Decimal and Scientific if Metric is chosen in the Measuring System group. The following 
table shows examples of the available number formats:

Format Example
Decimal 3.25
Scientific 1E+01 mm
Fractional 3 3/16
Architectural (Feet in Fractional) 1´-5 11/16"
Engineering (Feet in Decimal) 1"= 200´

Precision. Use this spin control to specify the precision of decimal numbers (the number of places to the 
right of the decimal point that TotalCAD displays). You can either click on the arrows, or type a number 
directly into the box.



Use Paper Space Coordinates
Check the Use Paper Space Coordinates box if you want the Ruler, Grid, and the coordinate system to be
in Paper, rather than World, units. This is useful if you want to precisely arrange your drawing on a page, 
or if you want to precisely place or scale an element of your drawing, such as text, in Paper space.

Tip 



Checking and unchecking this box is exactly the same as clicking the Paper/World button in the upper-left
corner of the Ruler.



Angle Property Sheet
Menu: Tools|Angle

The Angle property sheet gives you precise control over the measurement and display of angles, as well 
as control over the Ortho angle. You can change the system and direction of measurement, the base 
angle, and the precision of measurement.
Angular System 
Direction 
Ortho Angle 



Angular System
Use the list box to choose a system appropriate to your drawing. You can choose to display angular 
measurements in degrees, degrees minutes and seconds, grads, radians, or the surveyor system. In 
addition, you have the following two options:
Base Angle. Type a value into this text box to set the position of the base angle. Setting the base angle to 
90 degrees, for example, would cause TotalCAD to start measuring angles from the top quadrant point of 
a circle or arc, rather than from the right quadrant point.
Precision. Use this control to set the precision of the diplay of decimal numbers. If you set Precision to 2, 
for example, measurements will be displayed to an accuracy of two digits to the right of the decimal point.



Direction
Use these option buttons to choose whether to measure angular distances in a clockwise or 
counterclockwise direction.



Ortho Angle
Use these controls to customize the the Ortho angle. Ortho constrains the angles of lines during drawing 
and editing operations.
Base Angle. Type a value into this text box to set the position of the ortho base angle, which is the angle 
from which the ortho angle is measured. Changing this angle can be helpful if you want the ortho angle to 
be measured in relation to an object that is not oriented orthogonally relative to the drawing space.
Step Angle. The step angle determines the angle to which Ortho constrains lines. If you set the step angle
to 15, for example, the line will be constrained to angles 15 degrees apart. TotalCAD´s default sets the 
step angle to 90 degrees.



Layers Property Sheet
Menu: Tools|Layers

The Layers property sheet allows you to create new layers, set the current drawing layer, set the 
properties of layers, and delete layers.
Layers are virtual levels in a drawing, analogous to acetate sheets (overlays) in traditional drafting. Layers
give you the advantage of sorting objects in your drawing by the type of object they are modelling, by 
order of creation, or by any principal that suits the way you work. You can then place each category of 
object on a separate layer of the drawing, so that you can work on one layer of objects at a time.
Layers can be visible or not visible, editable or not editable. If you want to view only a subset of the 
objects in your drawing, set the layers you want to see as visible, and set all other layers to invisible. 
Setting layers to non-editable makes it possible to protect objects on those layers from unintended 
change while someone is working on another layer of the drawing.
Layers can have their own default color and line styles. If the color and line-style properties of objects on 
a layer are set to By Layer, they will have the color and line style assigned to the layer.
Creating a New Layer 
Setting the Current Drawing Layer 
Setting Layer Properties 
Deleting a Layer 

Note 
See Also 



If you create a group composed of objects on different layers of the drawing, the group will reside on the 
current layer (the layer that is current at the time the group is created). If you subsequently explode the 
group, each of the constituent objects will be on its original layer.



Format Property Sheet 



Creating a New Layer
To create a new layer, type a name for the layer in the Name text box, then click the New button. The new
layer name will appear in the Layers dialog list box.



Setting the Current Drawing Layer
The current drawing layer is the layer on which any new objects that you create or insert will reside. To set
the current drawing layer, select the name of the layer from the Layers dialog list box, then click the OK.



Setting Layer Properties
You can set the properties of a layer using the controls in the Properties area of the Layers dialog. Any 
changes you make apply to the layer that is currently selected in the Layers dialog list box.
Visible. Check this box to make the layer visible and uncheck it to make the layer invisible.
Editable. If this box is checked you can draw, insert, and edit objects on the layer. If it is not checked, then
you can view the layer, but you can´t change it.
Color. Use this pull-down box to select a color for the layer. If objects on the layer have their pen or brush 
color property set to By Layer, then the pen or brush of the objects will have the color specified here.
Line Style. Use this pull-down box to select a line style for the layer. If objects on the layer have their line 
style property set to By Layer, then the objects will have the line style specified here.
Order. Use this text box to assign an order number to the layer selected in the Layers dialog list box. 
Order numbers determine the order in which layers are drawn (which corresponds to the order in the 
Layers list box). Objects drawn on layers with higher order numbers will overlap objects drawn on layers 
with lower order numbers. The order numbers of layers are all set to 0 initially. Layers that have the same 
order number are sorted in alphanumeric order.
After you have made changes to the properties of the selected layer, click the Modify button to apply the 
changes.

Note 
See Also 



The Bring to Front and Send to Back commands (on the Format menu) affect the redraw order of objects 
within a single layer, or across layers if the layers have the same order number. An object on a layer with 
a higher order number will always overlap an object at the front of a layer with a lower order number.



Bring to Front, Format Property Sheet, Send to Back 



Deleting a Layer
To delete a layer, you must first clear any objects on the layer. Once the layer is cleared of objects, you 
can delete it in the Layers dialog by selecting its name in the list box and clicking the Delete button.



Windows Menu
Tile 
Arrange windows so that they are equal-size, side-by-side, with no overlap.
Cascade 
Arrange windows so that they overlap with title bars visible.
Arrange Icons 
Line up minimized windows along bottom at bottom 
Close All 
Close all open windows.
Changing the Active Window 
Lower part of menu lists open drawings; choosing a drawing makes it the active window.



Tile
Menu: Window|Tile

Use the Tile command to arrange all the open drawing windows into a mosaic. The windows are resized 
so they all the same size and fit entirely within the application window.

Tip 



This is a convenient arrangement when you want to compare the contents of two documents or drag and 
drop objects between documents.



Cascade
Menu: Window|Cascade

Use the Cascade command to resize and arrange all the drawing windows so they overlap with their title 
bars showing. Because you can see a portion of each window, you can easily activate any window by 
clicking it. Only the topmost window is completely visible.



Arrange Icons
Menu: Window|Arrange Icons

When you minimize a drawing window, Windows shrinks it to an icon. When there is not an open drawing 
window, you can see any minimized drawings. Use Arrange Icons to line up these iconized windows along
the bottom of the application window.

Note 



The general shape and appearance of the icon will vary, depending on whether you are using Windows 
95 or Windows 3.1.



Close All
Menu: Window|Close All

Use Close All to close every open drawing window.

Note 



TotalCAD will warn you if an open drawing has unsaved changes. Click the Yes button in the warning 
dialog to save the changes; click the No button to discard the changes. Click Cancel return to TotalCAD 
without closing the drawing windows.



Changing the Active Window
TotalCAD lists all of the open drawings in the lower half of the Windows menu. The currently active 
drawing will have a check mark. When you choose a drawing from the menu, TotalCAD makes it the 
active window. This is the same as clicking in window.



The zoom percentage box shows how far in or out of your drawing the current view is zoomed. To zoom 
to 100%, choose View|Zoom|Printed Size.






